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About This Document

Overview

This document describes the SmartLogger1000 (SmartLogger) in terms of installation,
electrical connections, system operation and maintenance, and troubleshooting measures. Get
familiar with the functions and features of the SmartLogger, and read safety precautions
before installing and operating the SmartLogger.

You can print the document. Store the paper copies properly for future use. You can also
download the latest documents from http://support.huawei.com/carrier/.

Intended Audience

This document is intended for photovoltaic (PV) plant operators and qualified electrical
technical personnel.

Symbol Conventions

The symbols that may be found in this document are defined as follows:

Symbol Description

Indicates an imminently hazardous situation which, if not
A DANGER avoided, will result in death or serious injury.

Indicates a potentially hazardous situation which, if not
A WARNING avoided, could result in death or serious injury.

Indicates a potentially hazardous situation which, if not
A CAUTION avoided, may result in minor or moderate injury.

Indicates a potentially hazardous situation which, if not
avoided, could result in equipment damage, data loss,
A NOTICE e y

performance deterioration, or unanticipated results.

NOTICE is used to address practices not related to personal
injury.
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Symbol Description
L[] noTE Calls attention to important information, best practices and
tips.
NOTE is used to address information not related to personal
injury, equipment damage, and environment deterioration.

Change History

Changes between document issues are cumulative. The latest document issue contains all the
changes made in earlier issues.

Issue 10 (2017-08-30)
Added 4.4.2 Connecting the SUN2000L to the SmartLogger.
Added 4.5.3 Connecting the SmartLogger to a Split EMI.
Updated the LCD screen snapshots in 6 User Interface.
Added 6.2.23 Setting the CO2 Emission Reduction Coefficient.
Updated the WebUI pages in 7 WebUI.
Updated 7.8.3.2 Setting Running Parameters (Advanced User).
Updated 7.8.3.3 Setting Running Parameters (Special User).
Added 7.10.5 Alarm Output.
Added 7.11.7 Managing the License.

Issue 09 (2016-08-15)
Added 3.6 Installing the RS485 signal SPD .
Added 4.2 Connecting the PE Cable for the RS485 Signal SPD.
Added 4.3 Connecting the RS485 Signal SPD.
Updated 4.4.1 Connecting the SmartLogger to the SUN2000.
Updated 4.5.2 Connecting the SmartLogger to an EMI That Supports Standard Modbus-RTU.
Updated 4.8 Connecting an Ethernet Network Cable.
Added 6.2.4 Sending a Reset Command to the Inverter.
Added 6.2.34 Resetting the System.
Added 7.8.3.4 Setting a Tracking System.
Added 7.8.3.5 Setting the LVRT Characteristic Curve.

Issue 08 (2015-08-20)
Added 6.2.30 Exporting All Files.
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Added 6.2.31 Importing All Files.
Added 7.10.2.6 Setting Modbus TCP Parameters.

Issue 07 (2015-01-20)
Added 4.9 Connecting to a PID.
Added PLC information query and parameter settings.
Added PID information query and parameter settings.
Added 7.11.6 Site Test.
Updated 7.11.8 Device Management.

Issue 06 (2014-09-20)
Added 7.8.6 Power Meter.
Added 7.10.2.7 Setting IEC103 Parameters.

Issue 05 (2014-05-20)
Added 4.6 Connecting the SmartLogger to a Power Meter.
Added 6.2.6 Querying Master SmartLogger Information.
Added 6.2.7 Querying Slave SmartLogger Information.
Added 6.2.8 Querying Information About the Modbus Power Meter.
Added 6.2.21 Setting SmartLogger Contrast.
Added 7.6 WebUI Layout.
Added 7.8.2 SmartLogger.
Added 7.10.2.4 Setting Power Meter Parameters.
Added 9.3 Alarms.

Issue 04 (2013-12-01)

This is the fourth official release.

Added Server+Client mode as a NetEco parameter in 6.2.25 Setting Communications
Parameters.

Added address assignments in 6.2.32 Managing Devices.
Added the setting of USB parameters in 7.10.4.2 Setting USB Parameters.
Updated parts of the web user interface (WebUI).

Issue 03 (2013-09-10)

This issue is the third official release.

Compared with the second official release, this document updates some operations and figures
for the LCD and WebUI.
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Issue 02 (2013-06-06)

This issue is the second official release.

Issue 01 (2013-04-25)

This issue is the first official release.

Compared with the original draft, this document updates some operations and figures for the
LCD and WebUI.
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Safety Precautions

Read the safety precautions carefully. Otherwise, human injury and equipment damage may
occur.

1.1 Precautions

This topic describes the precautions for installing and operating the SmartLogger.

Personnel Requirements

®  Only qualified and trained electrical technicians are allowed to install and operate the
SmartLogger.

®  Operation personnel should understand the composition and working principles of the
PV grid-tied power generating system and local regulations.

/\ orice

Read this document thoroughly before operations. Huawei shall not be liable for any
consequence caused by violation of the storage, transportation, installation, and operation
regulations specified in this document.

Identification Protection

®  The signs on the SmartLogger shell specify important information about secure
operations. Do not damage the signs.

®  The nameplate attached to the bottom of the SmartLogger lists the SmartLogger
parameters. Do not damage the nameplate.

Installation
e  Before installing the SmartLogger, ensure that it is not connected or energized.
e Install the SmartLogger in well-ventilated environments to ensure system performance.
®  Ensure that the heat dissipation holes of the SmartLogger are not blocked.
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 1
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® Do not move the components inside the shelf except for the wiring terminals at the
bottom.

Operation

/\ rorice

Strictly comply with the safety precautions in this document and associated documents to
operate the SmartLogger.

When operating the SmartLogger, follow local laws and regulations.

Maintenance and Replacement

® A faulty SmartLogger requires overall maintenance. Contact the dealer if any fault
occurs in the SmartLogger shelf.

e  Maintain the SmartLogger after you get familiar with this document and tools and testing
equipment are available.

®  When maintaining the SmartLogger, wear ESD gloves and comply with ESD
precautions.

1.2 Symbols

The following table describes all symbols on the SmartLogger.

Symbol Name Meaning

the Conformite Europeenne
(CE) certification
standards.

c € CE certification label This product complies with

VCCI certification label This product complies with
Voluntary Control Council

V@ l for Interference by

Information Technology

Equipment (VCCI)
certification standards.

Environmentally friendly This product does not

during a specified period.

EU waste electrical and Do not dispose of the
electronic equipment SmartLogger as household
(WEEE) label garbage. For details about
how to deal with the
undesirable SmartLogger,
refer to 10 Disposing of the
SmartLogger.

‘50’ use period (EFUP) label pollute the environment
[
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2 Overview

This topic describes the SmartLogger in terms of functions, networking applications, product
features, appearance, and the monitoring panel.

2.1 Product Introduction

This section describes the SmartLogger in terms of functions, networking applications, and
product features.

Functions

The SmartLogger is dedicated for monitoring and managing the PV power generating system.
It converges all ports, converts protocols, collects and stores data, and centrally monitors and
maintains the PV power generating system.

Networking
The SmartLogger applies to a PV system.

® |t can monitor Huawei inverters, PID, and other devices.

® |t supports third-party devices such as inverters, environment monitoring instruments,
box-type transformers, and smart meters that use the standard Modbus protocol or
provide RS485 ports.

® |t can simultaneously connect to the Huawei and third-party network management
systems by using the Modbus-TCP and IEC104 protocols.

® |t can connect to a multi-functional power meter over DLT645.

The SmartLogger networking is shown in Figure 2-1.
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Figure 2-1 SmartLogger networking

Third-Party Huawei Power
Power Station Ew:ggfd Station NMS
NMS NetEco
= —_— =
22 " == 22 "

_—
‘ ] Dry contact Y

Power grid

scheduling receiver

SmartLogger1000
y | Y =0
? RS485 | E
. =

Meter

— ll / — -

o — ¢ —C0—fT

PVarray  combiner Pawer

Box DC PDF Inverter Inverter AC PDF Transformer  grid

ILOTNC0002

Features
The SmartLogger has the following features:
®  Central monitoring

- Centrally monitors a maximum of 80 devices.

- Allows users to view information about the power station, devices, products, and
alarms, set parameters, and maintain devices on the liquid crystal display (LCD).

- Allows users to monitor and manage the PV power generating system on the
embedded WebUI, for example, viewing real-time information about the power
station, devices, and faults, and setting device parameters in remote mode.

®  Graphical data

- Displays energy yields and real-time monitoring information on the LCD in
graphics and texts.

- Displays energy yields, real-time monitoring information, and performance data of
the power station and devices on the embedded WebUI in tables and curves.

e  Convenient maintenance

- Allows users to upgrade the firmware of the SmartLogger and inverters and export
data by using a USB flash drive.

- Allows users to upgrade the firmware of the SmartLogger or inverters and export
logs over the embedded WebUI.

®  Grid dispatching
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 4
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Supports power grid dispatching: active power reduction and reactive power
compensation.

® Intelligent management

- Automatically scans and identifies Huawei inverters and supports protocol
conversion for third-party devices

- Supports access from third-party devices that use the standard Modbus-RTU
protocol.

- Automatically assigns RS485 addresses to the connected inverters and allows for
adjusting RS485 addresses based on device sequence numbers to facilitate remote
configuration and maintenance.

- Supports remote setting of inverter parameters and synchronizes the parameters of
one inverter to other inverters in batches.

L4 Remote maintenance

- Supports connection to Huawei NetEco and a third-party network management
system (NMS) simultaneously using Modbus-TCP and IEC104 to remotely manage
all devices.

- Allows users to access a third-party NMS over the File Transfer Protocol (FTP).
- Sends energy yield and fault information to users by emails.

2.2 Appearance

This topic describes the SmartLogger in terms of its appearance and specifications.

Front View of the Shell

Figure 2-2 Front view of the SmartLogger
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The LCD on the SmartLogger monitoring panel displays information about the power site, devices,
alarms, and products. This topic describes how to set parameters and maintain devices over the
monitoring panel.

Side View of the shell

Figure 2-3 Side view of the SmartLogger
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1. SD card slot 2. USB port
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Rear View of the Shell

Figure 2-4 Rear view of the SmartLogger
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1. Mounting hole 2. Rail snap 3. Heat dissipation hole

Bottom of the Shell

Figure 2-5 Bottom view of the SmartLogger
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The following table describes functions of each port of the SmartLogger, as shown in Table
2-1.

Table 2-1 Port description

Port (Silk Screen) Function Description

POWER Power supply 12V DC

FE Fast Ethernet Connects to a local area
network (LAN) switch,
router, power over Ethernet
(POE) or PC.

RS232 RS232 Connects to an external
RS232 device.
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Port (Silk Screen) Function Description

Al Analog input 4-20 mA and 0-20 mA
current input (active),
reserved.

]| Digital input Connects to a dry contact
input.

DO Digital output Relay output

S0.In Connects to a pulse output Reserved

power meter

CAN CAN Reserved

COM1-COM3 RS485 Supports three RS485 ports
that can connect to devices
such as the inverter and
environmental monitoring
instrument (EMI).

2.3 Monitoring Panel

This topic describes the monitoring panel, including an LCD, indicators, buttons, and the

default page.

Monitoring panel

The monitoring panel provides one LCD, three indicators, and four buttons, as shown in

Figure 2-6.
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Figure 2-6 Monitoring panel
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1. Indicator 2.LCD 3. Button
Indicators
There are three indicators on the monitoring panel. They are Power indicator, Run indicator,
and Alarm indicator from left to right.
Table 2-2 describes the indicators.
Table 2-2 Indicator description
Indicator Status Meaning
Power indicator Steady green The power supply is normal.
(g ﬂ j) Off There is no power supply.
Run indicator Blinking green (on for 1s | The SmartLogger is working.
— and then off for 1s)
s
Off The SmartLogger stops working.
Alarm indicator Steady red The inverter connected to the
SmartLogger generates a major
alarm. For details about the
alarm, see 6.2.18 Querying
Alarm Records.
Blinking red (on for 0.5s The inverter connected to the
and then off for 0.5s) SmartLogger generates a minor
alarm. For details about the
alarm, see 6.2.18 Querying
Alarm Records.
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 9
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Indicator

Status Meaning

Blinking red (on for 1s and | The inverter connected to the
then off for 4s) SmartLogger generates a
warning. For details about the
warning, see 6.2.18 Querying
Alarm Records.

Off The inverter connected to the
SmartLogger is working
normally.

LCD

The LCD displays data in graphics and text, including the information about the site, devices,
alarms and products. Users can also set parameters and maintain devices on the LCD.

If you do not press any button within 90s on a non-default page, the LCD returns to the
default page automatically, as shown in Figure 2-7.

Figure 2-7 Default page

[ 2017-08-10 16:32:24 «— 1
1 kWh
—2
o 54,00 _08.00 12,00 _16.00 20,00 h
E-Daily: 24. 0dkih
Eeduced COZ: 240, 40kg J 3
Active powers 0. D0W
M0 Mo Dio 4
1. Date and Allows you to view the date and time.
time
2. Energy Allows you to view the total energy production in each hour by all the
production inverters connected to the SmartLogger.
histogram
3. Energy ¢ Allows you to view the total energy production from 0:00 to the current
production time by all the inverters connected to the SmartLogger.
data ¢ Allows you to view the emission reduction of CO; corresponding to the
energy yield of the current day.
e Allows you to view the total output power by all the online inverters
connected to the SmartLogger at the present.
4. Status Allows you to view the number of the major alarms, minor alarms, and
information warnings of all the inverters connected to the SmartLogger. When remote
grid dispatching is enabled, you can view the current status of grid
dispatching.
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Buttons

There are four buttons on monitoring panel. They are the Return button, Cursor Up button,
Cursor Down button, and Confirm button from left to right.

Table 2-3 describes the button functions.

Table 2-3 Button description

Buttons Name Functions

ESC Return Allows you to return to the last page or end an
button operation.

A Cursor Allows you to go to the upper-level menu or set
Down parameters.
button

v Cursor Up | Allows you to go to the lower-level menu or set
button parameters.

J Confirm Allows you to go to the menu or confirm the value.
button

[l noTE

The backlight lasts 120s after you press any button.

2.4 Typical Cable Connection Scenarios

Overview

®  The cable from the busbar to the knife switch needs to be prepared by yourself.
Recommended cable: three-core multi-wire (L1, L2, and L3) cable with the operating
voltage to the ground not less than 600 V and the cross sectional area of a single core
wire being 4 mm?.

®  The cable from the knife switch to the miniature circuit breaker (MCB) needs to be
prepared by yourself. Recommended cable: three-core multi-wire (L1, L2, and L3) cable

with the operating voltage to the ground not less than 600 V and the cross sectional area
of a single core wire being 4 mm?.

e |f the SmartLogger communicates with the inverter over PLC, a PLC CCO module needs
to be connected. If they communicate over RS485, no PLC CCO module is required.

Issue 10 (2017-08-30) Huawei Proprietary and Confidential 11
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Optical Fiber+RS485/PLC Scenario
Figure 2-8 Cable connections in the optical fiber+RS485/PLC scenario
SmartLogger1000
m Ring network switch
Socket EI I =
I— == pLc cco
Signal SPD J ATB
igna § A
MCB :
] | l
Ground bar §
Knife switch
1o
RS485input  PE  Busbar A/B/C Optical communications
cable input
Communications cable s Power cable s Ground cable —————o AC power cable c—
1LO1110003
Table 2-4 lists the components required in this scenario.
Table 2-4 Required components
Component Model or Specifications | Component Quantity
Source
SmartLogger SmartLogger1000 Can be purchased | 1 PCS
from Huawei
RS485 signal SPD | PowerSA-5KA-15V Can be purchased | 2 PCS
from Huawei
PLC CCO PLC CCOO01A Can be purchased | 1 PCS
from Huawei
Ring network LAN | AR531 or a ring-network To be supplied by | 1 PCS
switch LAN switch of a local type | the customer
Optical module FTLF1323P1BTR-HW or | To be supplied by | 2 PCS
an optical module of a the customer
local model
ATB CT-GZF2PJ-8, To be supplied by | 1 PCS
CT-GPH-A-8, oran ATB | the customer
of a local model
MCB Rated voltage > 500 V; To be supplied by | 1 PCS
rated current > 6 A the customer
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 12
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Component Model or Specifications | Component Quantity
Source

Knife Fuse Rated voltage: > 500 V; To be supplied by | 3PCS
switch rated current: 6 A the customer

Knife Rated voltage: > 500 V; To be supplied by | 1 PCS

switch rated current: > 6 A; the customer

box number of phases: three
Socket Matching with the power To be supplied by | 1 PCS

adapter the customer

LTE+RS485/PLC Scenario

Figure 2-9 Cable connections in the LTE+RS485/PLC scenario
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Table 2-5 lists the components required in this scenario.

Table 2-5 Required components

Component Model or Specifications | Component | Quantity
Source
SmartLogger SmartLogger1000 Can be 1PCS
purchased
from Huawei
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Component Model or Specifications | Component | Quantity
Source
POE module POE35-54A or Can be 1PCS
POES85-56A purchased
from Huawei
PLC CCO PLC CCOO01A Can be 1PCS
purchased
from Huawei
RS485 signal SPD PowerSA-5KA-15V Can be 2PCS
purchased
from Huawei
POE SPD POE-2 Can be 1PCS
purchased
from Huawei
CPE EG860V2-C71 Can be 1PCS
purchased
from Huawei
MCB Rated voltage: > 500 V; To be supplied | 1 PCS
rated current: > 6 A by the
customer
Knife Fuse Rated voltage: > 500 V; To be supplied | 3PCS
switch rated current: 6 A by the
customer
Knife Rated voltage: > 500 V; To be supplied | 1 PCS
switch box | rated current: > 6 A; by the
number of phases: three customer
Socket Matching with the power | To be supplied | 1 PCS
adapter by the
customer
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 14
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Installation

This topic describes how to install the SmartLogger.

Context

Install the SmartLogger in an appropriate position and surface.

A DANGER

e Do not store the SmartLogger in areas with flammable or explosive materials.

e Do not install the SmartLogger on flammable building materials.

3.1 Installation Process

This topic describes the SmartLogger installation process.

The SmartLogger installation process is shown in Figure 3-1.
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Figure 3-1 Installation flowchart
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Table 3-1 describes the installation process.

Table 3-1 Description of the installation process

Step Operation Description
1 Checking Before Before unpacking, check that the outer packing
Installation materials are intact. After unpacking, check that
deliverables are complete and intact.
2 Preparing Tools Prepare tools required for installation and electrical
connections.
3 Determine the installation | Before installing the SmartLogger, determine an
position. appropriate position to ensure that the
SmartLogger works properly.
4 Installing the SmartLogger | The SmartLogger can be installed on a desk, a wall
or along a guide rail.
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3.2 Checking Before Installation

Checking Outer Packing Materials

Check the outer packing materials for damage before unpack the SmartLogger, such as holes
and cracks. If any damage is found, do not unpack the SmartLogger and contact the dealer as
soon as possible.

Checking Deliverables

After unpacking the SmartLogger, check whether deliverables are intact and complete. If any
damage is found or any component is missing, contact the dealer.

Figure 3-2 shows the components and mechanical parts that should be delivered.

Figure 3-2 Deliverables

ILOTWC0006

No. Quantity Description
1 1 SmartLogger
2 1 Adapter (adapter type depends on the country specified

in the order)

3 1 Network cable (2.2 meters long)

4 8 Terminal block

5 2 Expansion tube

6 2 Screws (used to secure the SmartLogger to the wall)
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 17
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No. Quantity Description
7 1 Auxiliary documents
3.3 Preparing Tools
Prepare tools required for installation and electrical connections.

Tool Model Function

Hammer drill D6 drill bit Drills holes in the wall when
the SmartLogger is
wall-mounted.

Diagonal pliers

- Cuts and tighten cable ties.

Wire stripper

- Peels cable jackets.

Rubber mallet

- Hammers expansion bolts into
holes.

Guarded blade utility knife

- Removes package.
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Tool

Model

Function

Cable cutter

|

Cuts cables.

Vacuum cleaner

Cleans up dust after holes are
drilled.

Marker

]

Diameter: < 10 mm

Marks signs.

Measuring tape

Measures distance

Plumb line

Ensures that the screws are
perpendicular to the wall.

Safety goggles

Protect an operator's eyes
during hole drilling.
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Tool Model Function

Anti-dust respirator - Protects an operator from dust

e inhalation during hole drilling.

3.4 Determining the Installation Position

Before installing the SmartLogger, determine an appropriate position to ensure that the
SmartLogger works properly.

Comply with the following requirements when determining the installation position for the
SmartLogger:

Do not install the SmartLogger outdoors because it is protected to 1P20.
Install the SmartLogger in a dry environment to protect it against water.

Keep the product in an ambient temperature range of —-40<C to +60<C and away from
direct sunlight.

The communication distance for the RS485 port should be less than 1000 m and for the
Ethernet less than 100 m.

Install the SmartLogger at an appropriate height for the user's ease to view and operate
on the monitoring panel.

Do not place the SmartLogger upside down. Ensure that the heat dissipation holes are
facing upwards, preventing dust from entering the SmartLogger and reducing its service
life.

Choose appropriate installation method and position for the Smart Logger according to
its weight and size. For details, refer to 11 Technical Specifications.

If you install the SmartLogger on a wall or along a guide rail, the area for connecting
cables should be downwards.

The SmartLogger is at least 100 mm away from the neighboring objects on both sides,
the top side, and the bottom side respectively, as shown in Figure 3-3.
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Figure 3-3 Minimum installation clearance
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3.5 Installing the SmartLogger

The SmartLogger can be installed on a desk, on a wall, or along a guide rail.

3.5.1 Installing the SmartLogger on a Desk

This topic describes how to install the SmartLogger on a desk.

Context
A NOTICE
e Ensure that the desk on which the SmartLogger is installed is horizontal to prevent it from
falling down.
e Install the SmartLogger in places where cables cannot be easily touched to avoid signal
disruption.
Procedure

Step 1 Take the SmartLogger out from the package.
Step 2 Place the SmartLogger onto a horizontal desk.

——End
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3.5.2 Mounting the SmartLogger on a Wall

This topic describes how to mount the SmartLogger on a wall.

Context
A NOTICE
e Install the SmartLogger on a solid and smooth wall to ensure that it can be secured on the
wall.
e Before hanging the SmartLogger on the screws, secure the expansion tubes and screws
into the wall.
Procedure

Step 1 Install the expansion tubes and screws.

/\ orice

If you need to use a ladder to install the SmartLogger on a high position, keep balance to
protect yourself from falling down.

1. Use a plumb line to ensure that the line between the centric points of the two holes is
vertical to the ground. Use a marker to mark out the holes, as shown in Figure 3-4.

Figure 3-4 Hole positions and dimensions
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2. Drill holes using a hammer drill and install expansion tubes and screws, as shown in
Figure 3-5.

Figure 3-5 Drilling a hole and installing an expansion tubes and screws
24-25 mm

6 b 5.8 mm
e EC)

ILO1HO0001

Table 3-2 describes the operations shown in Figure 3-5.

Table 3-2 Drilling a hole and installing an expansion tubes and screws

Step Operation

1 Put a hammer drill with a @6 drill bit on a marked hole position perpendicularly
against the wall and drill holes with a depth of 24 mm to 25 mm.
NOTICE

e To prevent dust inhalation or contact with eyes, wear safety goggles and an anti-dust
respirator when drilling holes.

e Wipe away any dust in or around the holes and measure the hole distance. If the holes
are inaccurately positioned, drill holes again.

2 Vertically insert an expansion tube into a hole, and knock it completely into the
hole by using a rubber mallet.

3 Insert the screws into the expansion tube until the screw heads are 7.5 mm to 8
mm away from the wall.

Step 2 Hang the SmartLogger onto the secured screws by the mounting holes on the rear of the
SmartLogger.

/\ orice

Ensure that the area for connecting cables in the SmartLogger is downwards for the ease of
electrical connections and maintenance.

--End

3.5.3 Mounting the SmartLogger Along a Guide Rail

This topic describes how to mount the SmartLogger along a guide rail.
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Context
The guide rails are not delivered together with the SmartLogger. If you need to mount the
SmartLogger along a guide rail, prepare a 35 mm wide guide rail.
A NOTICE
e Choose a guide rail with appropriate lengths to ensure that the SmartLogger can be
secured along it.
e Secure the guide rail before mounting the SmartLogger.
Procedure
Step 1 Hold both sides of the SmartLogger, keep it parallel with the guide rail, and then tilt it slightly
to insert its upper hooks into the guide rail, as shown in Figure 3-6.
Figure 3-6 Mounting the SmartLogger Along a guide rail (1)
ILO1HCO0002
Step 2 Hold the two lower corners of the SmartLogger, pull it downwards appropriately, and then
push it towards the guide rail. When you hear a click sound, the SmartLogger is successfully
mounted along the guide rail, as shown in Figure 3-7.
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Figure 3-7 Mounting the SmartLogger along a guide rail (2)
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3.6 Installing the RS485 signal SPD

Context

e |f the SmartLogger needs to be connected to outdoor equipment through the COM port,

it is recommended that an RS485 signal SPD be installed.

e  Each SmartLogger can be configured with a maximum of two RS485 signal SPDs.

®  The RS485 signal SPD can be mounted on guide rail. No guide rail is delivered with an

RS485 signal SPD. If you need to install an RS485 signal SPD on a guide rail, prepare a
standard 35 mm wide guide rail with a length no less than 80 mm.

A NOTICE

e Secure the guide rail before mounting the RS485 signal SPD.

e If the SmartLogger is installed on a guide rail, the RS485 signal SPD can share the guide
rail with the SmartLogger. In this case, the recommended guide rail length is 400 mm or
greater.

Procedure

Step1 Secure the RS485 signal SPD to the guide rail, as shown in Figure 3-8.
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Figure 3-8 Securing the RS485 signal SPD to the guide rail

ILO2ZHCD009

—End
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Electrical Connections

This topic describes how to connect the SmartLogger to the inverters, environmental
monitoring instrument, and PCs.

Context

/\ orice

o Ensure that all cables are connected and secured.

e Do not connect a power adapter to the SmartLogger before the cable connections are
complete because the SmartLogger has no startup button.

4.1 Connection Description

Port Description
For the bottom view of the SmartLogger and port description, see Bottom of the Shell in 2.2
Appearance.

Device Connection Description

Figure 4-1 shows the recommended method for connecting the SmartLogger to multiple
devices through the COM ports. For details, see 4.3 Connecting the RS485 Signal SPD-4.9
Connecting to a PID.
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Figure 4-1 Connecting the SmartLogger to multiple devices through the COM ports
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4.2 Connecting the PE Cable for the RS485 Signal SPD

Prerequisites

The ground cable is available. Outdoor copper-core cables with a cross sectional area of 4
mm? or 12 AWG are recommended.

Procedure

Step1 Remove 8 mm of the insulation layer from the ground cable using the wire stripper.

Step 2 Insert the bare cable cores into port 3 of the RS485 signal SPD, as shown by (1) in Figure 4-2.

Figure 4-2 Connecting the PE cable for the RS485 signal SPD

ILO2IC1001
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Step 3 Use a flat-head screwdriver to tighten the screws on port 3, as shown by (2) in Figure 4-2.

/\ norice

Connect the other end of the PE cable to the ground bar.

-—End

4.3 Connecting the RS485 Signal SPD

Prerequisites

The communications cable is prepared. The DJYP2VP2-22 2x2x1 network cable or a
communications cable with a cross sectional area of 1 mm? and outer diameter of 14—-18 mm
is recommended.

Context
(L] noTE
The way of connecting two RS485 signal SPDs is the same as the way of connecting one RS485 signal
SPD.
One RS485 signal SPD provides two RS485 surge protection ports, as shown in Figure 4-3.
Figure 4-3 Ports on an RS485 signal SPD
[2 4 6]
5)%)%)
8 12
222
O
22
7 11
B1%1%)
[1 3 5]
1S02W00003
Table 4-1 describes the surge protection ports.
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Table 4-1 Port description
RS485 Surge | Protection Function Surge | Function
Protection Port Port
Port
RS485 surge 2 RS485A, for RS485 | 1 RS485A, for RS485
protection port positive differential positive differential
1 signaling signaling
6 RS485B, for RS485 | 5 RS485B, for RS485
negative differential negative differential
signaling signaling
RS485 surge 8 RS485A, for RS485 | 7 RS485A, for RS485
protection port positive differential positive differential
2 signaling signaling
12 RS485B, for RS485 | 11 RS485B, for RS485
negative differential negative differential
signaling signaling
(L NnoTE

e Protection ports are connected to COM ports on the SmartLogger. Port 4 is not connected.

e Surge ports are connected to RS485 ports of other devices. Port 3 is the ground port.

e Protection ports and surge ports must not be reversely connected.

e One RS485 signal SPD can protect two COM ports.

e Protection ports 2 and 6 and surge ports 1 and 5 form an RS485 signal SPD port for protecting one
COM port. Protection ports 8 and 12 and surge ports 7 and 11 form another RS485 signal SPD port
for protecting one more COM port.

Procedure

Step1 Remove an appropriate length of steel armor and insulation layer from the cable using a wire

stripper, as shown in Figure 4-4.

IS01ZC0036

Figure 4-4 Stripping an RS485 communications cable (unit: mm)

Step 2 Remove the terminal block from the SmartLogger COM port, as shown in Figure 4-5.
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Figure 4-5 Connecting the terminal block (1)

I1L01110005

Step 3 Connect the cable to the SmartLogger terminal block, as shown in Figure 4-6.

Figure 4-6 Connecting the terminal block (2)

1

WE:
L

IL011C3002

(1) Wiring terminal (2) White contact plate

1. Press the white contact plate of the corresponding wiring terminal to flip the metal spring
inside the wiring terminal.

2. Insert the uninsulated part of the core wire into the wiring terminal.
3. Release the white contact plate to fasten the core wire.

Step 4 Insert the terminal block into the SmartLogger COM port.

Step 5 Insert the bare cable cores at the other end of the cable into a protection port of the RS485
signal SPD, as shown by (1) in Figure 4-7.
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Figure 4-7 Wiring diagram for the RS485 signal SPD
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Verify that the COM+ port on the SmartLogger is connected to protection port 2 or 8 on the
RS485 signal SPD, and that the COM- port on the SmartLogger is connected to protection
port 6 or 12 on the RS485 signal SPD.

Step 6 Use a flat-head screwdriver to tighten the screws on the protection ports, as shown by (2) in
Figure 4-7.

-—End

Follow-up Procedure

Disconnection can be performed in reverse order.

4.4 Connecting the SmartLogger to Inverters

This topic describes how to connect the SmartLogger to inverters.

4.4.1 Connecting the SmartLogger to the SUN2000

This topic describes how to connect the SmartLogger to the SUN2000 using an RS485
communications cable.

Context
The SmartLogger provides three COM ports for RS485 communication, as shown in Figure
4-8.
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Figure 4-8 COM ports on the SmartLogger
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bes the COM ports.

Table 4-2 COM port description
Port Identifier | Function
NC Reserved
NC Reserved
COML1 port
- RS485B, for RS485 negative differential signaling
+ RS485A, for RS485 positive differential signaling
- RS485B, for RS485 negative differential signaling
COM2 port
+ RS485A, for RS485 positive differential signaling
- RS485B, for RS485 negative differential signaling
COM3 port
+ RS485A, for RS485 positive differential signaling

The RS485 terminal block or RJ45 port on the SUN2000 is used for RS485 communication.
There are two types of RS485 terminal blocks (1 and 2) located in different models of
SUNZ2000s. All the SUN2000s have RJ45 ports. You are advised to use terminal blocks for

connection.

®  Terminal block connection

- Term

Figure 4-9 shows the position of the terminal block in the

inal block 1

SUN2000-50KTL/50KTL-C1. Table 4-3 describes the functions of the terminal
block.
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Figure 4-9 Position of the terminal block in the SUN2000

1503wW00003

Table 4-3 Functions of the RS485 terminal block

No. Port Definition | Function

1 RS485A IN RS485A, for RS485 positive differential signaling
2 RS485A OUT RS485A, for RS485 positive differential signaling
3 RS485B IN RS485B, for RS485 negative differential signaling
4 RS485B OUT RS485B, for RS485 negative differential signaling

Terminal block 2

Figure 4-10 shows the position of the terminal block in the
SUNZ2000-33KTL/40KTL. Figure 4-11 describes the functions of the terminal

block.
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Figure 4-10 Position of the terminal block in the SUN2000

1S011C0025

Figure 4-11 Terminal block
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Table 4-4 Functions of the RS485 terminal block

No. Port Definition | Function

5 RS485A IN RS485A, for RS485 positive differential signaling
6 RS485A OUT RS485A, for RS485 positive differential signaling
7 RS485B IN RS485B, for RS485 negative differential signaling
8 RS485B OUT RS485B, for RS485 negative differential signaling

®  RJ45 network port connection
The RJ45 port needs to be connected using an RJ45 connector, as shown in Figure 4-12.
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Figure 4-12 RS485 crystal plug of the SUN2000 (side view without the fastener)
1 8

Il

15S01Z2C0011

Table 4-5 lists the wire colors and functions.

Table 4-5 Cable colors and functions

Category Color Function

1 White and orange | RS485A, for RS485 positive differential signaling
2 Orange RS485B, for RS485 negative differential signaling
3 White and green N/A

4 Blue RS485A, for RS485 positive differential signaling
5 White and blue RS485B, for RS485 negative differential signaling
6 Green N/A

7 White and brown | N/A

8 Brown N/A

Figure 4-13 shows how to connect the SmartLogger to the SUN2000 through an RS485 signal
SPD. This section describes how to connect the SUN2000-33KTL/40KTL to the
SmartLogger through a terminal block.
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Figure 4-13 Connecting the SmartLogger to the SUN2000
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Procedure

Step 1 Prepare a cable with an appropriate length, strip a proper part of the insulation layer from one
end, and connect the end to the SUN2000 terminal block.

® The DJYP2VP2-22 2x2x1 network cable or a communications cable with a cross
sectional area of 1 mm?2 and outer diameter of 14—-18 mm is recommended.
®  For details about how to strip and connect the cable, see the SUN2000 user manual.

Step 2 Strip an appropriate length from the other end of the cable using a wire stripper, as shown in
Figure 4-14.

Figure 4-14 Stripping an RS485 communications cable (unit: mm)

—— 1
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1S01ZC0036

Step 3 Insert the bare core wires into the surge port of the RS485 signal SPD, as shown by (1) in
Figure 4-15.
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Figure 4-15 Connecting the surge port of the RS485 signal SPD

7
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o The RS485 IN and RS485 OUT ports on the SUN2000 can both connect to the
SmartLogger. This document uses the RS485 OUT port as an example to describe the
connection between the SUN2000 and the SmartLogger.

e \erify that the RS485A (OUT) port on the SUN2000 connects to surge port 1 or 7 on the
RS485 signal SPD, and that the RS485B (OUT) port on the SUN2000 connects to surge
port 5 or 11 on the RS485 signal SPD.

e After connecting cables, wrap the part without an insulation layer using PVC insulation
tape.

Step 4 Use a flat-head screwdriver to tighten the screws on the surge ports, as shown by (2) in Figure
4-15.

Step 5 Set Baud Rate to the same value for the SUN2000 and SmartLogger.

®  SmartLogger communications parameters can be set on the LCD or WebUI. For details,
see 6.2.25 Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

®  For details about the communications parameter configurations for the SUN2000, see
SUN2000 APP User Manual.

-—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the SUN2000.

4.4.2 Connecting the SUN2000L to the SmartLogger

Context
The SmartLogger provides three COM ports for RS485 communication, as shown in Figure
4-16.
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Figure 4-16 COM ports on the SmartLogger
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Table 4-6 describes the COM ports.

Table 4-6 COM port description

Port Identifier | Function
NC Reserved
NC Reserved
COML1 port
- RS485B, for RS485 negative differential signaling
+ RS485A, for RS485 positive differential signaling
- RS485B, for RS485 negative differential signaling
COM2 port
+ RS485A, for RS485 positive differential signaling
- RS485B, for RS485 negative differential signaling
COM3 port
+ RS485A, for RS485 positive differential signaling

SUN2000L-4.125KTL-JP/4.95KTL-JP connects to the SmartLogger through the bottom

COM port.

Figure 4-17 COM port on the SUN2000L
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Table 4-7 describes the COM ports.
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Table 4-7 COM port pin definitions
No. Label Definition
1 485B1 RS485B, RS485 differential signal—
2 485A1 RS485A, RS485 differential signal+
3 485B2 RS485B, RS485 differential signal—
4 485A2 RS485A, RS485 differential signal+
5 N/A N/A
6 N/A N/A
7 N/A N/A
8 PE Port for grounding the shield layer
Figure 4-18 shows how the SmartLogger connects to the SUN2000L through an RS485 signal
SPD.
Figure 4-18 Connection between the SmartLogger and the SUN2000L
RS485 Signal SPD
feHBll - HEGE
el - [0
ILO1IC3001
Procedure

Step1 Prepare a cable with an appropriate length, strip an appropriate length from one end, and

connect the end to the SUN2000L terminal block.

Select a two-core outdoor shielded RS485 communications cable with a cross-sectional
area of 0.25-1 mm? (0.9 mm? recommended).

For details about how to strip and connect the cable, see the SUN2000L-(4.125KTL,

4.95KTL)-JP User Manual.

Step 2 Strip an appropriate length from the other end of the cable using a wire stripper, as shown in
Figure 4-19.
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Figure 4-19 Stripping an RS485 communications cable (unit: mm)

IS01ZC0036

Step 3 Insert the bare core wires into the surge port of the RS485 signal SPD, as shown by (1) in
Figure 4-20.

Figure 4-20 Connecting cables to the surge port of the RS485 signal SPD

7

1L02IC1002
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e \erify that the 485A1 or 485A2 port on the SUN2000L connects to surge port 1 or 7 on
the RS485 signal SPD, and that the 485B1 or 485B2 port on the SUN2000L connects to
surge port 5 or 11 on the RS485 signal SPD.

e After connecting cables, wrap the part without an insulation layer using PVC insulation
tape.

Step 4 Use a flat-head screwdriver to tighten the screws on the surge ports, as shown by (2) in Figure
4-15.

Step 5 Set Baud rate to the same value for the SUN2000L and SmartLogger.

SmartLogger communications parameters can be set on the LCD or WebUI. For details, see
6.2.25 Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

——End

Follow-up Procedure

Disconnection can be performed in reverse order.

4.4.3 Connecting Multiple Inverters to the SmartLogger

This topic describes how to connect the SmartLogger to multiple inverters.
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The SmartLogger can connect to multiple inverters through a daisy chain, as shown in Figure

4-21.

Figure 4-21 Connecting Multiple Inverters to the SmartLogger
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e A maximum of 80 devices can be connected to one SmartLogger. You are advised to connect fewer

than 30 devices to each RS485 route.
If an EMI is to be connected, connect it at the end of the chain. Set the address for the EMI to 1.

The addresses for all devices in the daisy chain should be within the searching scope set in the
SmartLogger and they must differ from each other. Otherwise, the communications would fail
between the device and the SmartLogger.

If the firmware version of the SUN2000 is V100R001C00SPCO010 or later, or
V100R001C81SPC105 or later, you can perform Auto Assign Address on the SmartLogger. If
detecting that an RS485 address is repeatedly used, the SmartLogger automatically allocates another
address and hence no local operation is required.

Baud rate of all the devices in one daisy chain should stay consistent with those of the
SmartLogger.

4.5 Connecting to an EMI

4.5.1 Connection Description

There are two types of EMI. One is the standard EMI that supports the Modbus-RTU protocol,
and it can directly connect to the SmartLogger. The other is the EMI that is composed of

SEensors,

whose signals need to be converted into RS485 signals (Modbus-RTU) over an extra

analog-to-digital converter before the sensors are connected to the SmartLogger.
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4.5.2 Connecting the SmartLogger to an EMI That Supports
Standard Modbus-RTU

Context

The SmartLogger can connect to an EMI that supports the standard Modbus-RTU protocol.
One SmartLogger can connect to and manage only one EMI.

Devices from different vendors may support different protocols. To normally obtain
information from the connected EMI, correctly configure the protocol on the SmartLogger
WebUI based on the document delivered by the vendor.

For the definition of the RS485 communications cable for the EMI, see the instructions
delivered with the EMI.

There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-22 shows how to connect the SmartLogger to the EMI.

Figure 4-22 Connecting the SmartLogger to the EMI
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Procedure
Step1 Connect one end of the cable delivered with the EMI to the RS485 port of the EMI.

Step 2 Connect the other end of the cable to a Surge port of the RS485 signal SPD. For details, see
Step 2-Step 4 in Procedure in 4.4.1 Connecting the SmartLogger to the SUN2000.
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Verify that the RS485+ port on the EMI is connected to Surge port 1 or 7 on the RS485 signal
SPD, and that the RS485- port on the EMI is connected to Surge port 5 or 11 on the RS485
signal SPD.

[ noTE

e The EMI cannot be detected automatically. You need to add this device manually on the LCD or
WebUI. For details about this operation, see 6.2.32 Managing Devices or 7.11.8.1 Connecting
Devices.

e After the EMI is connected, log in to the embedded WebUI and set relevant parameters for the EMI.
For details, see 7.10.2.3 Setting EMI Parameters. Select the specific model of EMI.

e When the SmartLogger is connected to an EMI and multiple inverters at the same time, connect the
EMI to the end of the daisy chain. For details, see 4.4.3 Connecting Multiple Inverters to the
SmartLogger.

-—End

Follow-up Procedure

Take the reverse steps to disconnect the SmartLogger from the EMI.

4.5.3 Connecting the SmartLogger to a Split EMI

The EMI used in Europe and Southeast Asia is composed of sensors, whose signals need to be
converted into RS485 signals (Modbus-RTU) over an extra analog-to-digital converter before
the sensors are connected to the SmartLogger.

The analog-to-digital converter should provide an RS485 port and support the standard
Modbus-RTU protocol. This section describes the connection between the SmartLogger and a
split EMI through the ADAMA4117 that functions as an analog-to-digital converter.

There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-23 shows how to connect the SmartLogger to a split EMI through an RS485 signal
SPD and analog-to-digital converter.
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Figure 4-23 Connecting the SmartLogger to a split EMI (1)
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Step 1 Prepare a cable with an appropriate length, strip a proper part of the insulation layer from one
end, and connect the end to the port on the analog-to-digital converter.

® The DJYP2VP2-22 2x2x1 computer cable or a communications cable with a conductor
cross-sectional area of 1 mm? and outer diameter of 14-18 mm is recommended.
®  For detailed operations, see the document delivered with the analog-to-digital converter.

Step 2 Remove an appropriate length of the steel armor and wire insulation layer from the other end
of the cable using a wire stripper, as shown in Figure 4-24.

Figure 4-24 Stripping a cable (unit: mm)

—— I

8-10

IS01ZC0036

Step 3 Insert the bare core wires into the surge port of the RS485 signal SPD, as shown by (1) in
Figure 4-25.
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Figure 4-25 Connecting cables to the surge port of the RS485 signal SPD
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Verify that the RS485+ port on the analog-to-digital converter connects to surge port 1 or 7 on
the RS485 signal SPD, and that the RS485- port on the analog-to-digital converter connects
to surge port 5 or 11 on the RS485 signal SPD.

Step 4 Use a flat-head screwdriver to tighten the screws on the surge ports, as shown by (2) in Figure
4-25.

Step 5 Set Baud rate for the analog-to-digital converter to the same value as that for the
SmartLogger.

®  SmartLogger communications parameters can be set on the LCD or WebUI. For details,
see 6.2.25 Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

®  For details about the communications parameter configurations for the analog-to-digital
converter, see the delivered document.

Step 6 Connect each sensor to the analog-to-digital converter. For detailed operations, see the
documents delivered with the analog-to-digital converter or sensors.

[ noTE

e After connecting the cables, log in to the embedded WebUI and set relevant parameters. For details,
see 7.10.2.3 Setting EMI Parameters. The selected EMI model is Sensor(ADAM).

e The EMI cannot be detected automatically. You need to add this device manually on the LCD or
WebUI. For details about this operation, see 6.2.32 Managing Devices or 7.11.8.1 Connecting
Devices.

e [f the SmartLogger needs to connect to an EMI and multiple inverters, connect the EMI at the end of
the daisy chain, and verify that other devices connected to the port have different addresses from the
EMI. For the daisy chain connection, see 4.4.3 Connecting Multiple Inverters to the SmartLogger.

——End

4.6 Connecting the SmartLogger to a Power Meter

This topic describes how to connect the SmartLogger to a power meter.
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Context

Procedure

Step1

Step 2

The SmartLogger can be connected to a power meter that supports the standard Modbus-RTU
or DL/T645 protocol.

[ noTE

e The SmartLogger can be connected to and manage only one power meter that supports the
Modbus-RTU protocol.

e The SmartLogger can be connected to and manage multiple power meters that support the DL/T645
protocol.

The protocol points for Power Meters provided by different vendors are varied. Therefore, to
obtain information from a Power Meter, configure the protocol point on the WebUI of the
SmartLogger properly based on the document delivered by the vendor.

For details about the definition of the RS485 communications cables for the Power Meter, see
the operation manual delivered with the Power Meter.

There are three RS485 ports in the SmartLogger. For details about the port descriptions, see
Context in 4.4.1 Connecting the SmartLogger to the SUN2000.

Figure 4-26 shows how to connect the SmartLogger to the Power Meter.

Figure 4-26 Connecting the SmartLogger to a power meter

ILO1IC3012

[ noTE

A Power Meter is typically installed indoors, and can be connected to the COM port of the SmartLogger
without an RS485 signal SPD.

Connect one end of the cable delivered with the power meter to the RS485 port of the Power
Meter.

Connect the other end of the cable to the COM port of the SmartLogger. For details, see Step
1-Step 4 in Procedure in 4.3 Connecting the RS485 Signal SPD.
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Connect the RS485+ port of the Power Meter to the COM+ port of the SmartLogger and the
RS485- port of the Power Meter to the COM- port of the SmartLogger.

[ noTE

e After connecting the cable for a power meter that supports the Modbus-RTU protocol, log in to the
embedded WebUI and set relevant parameters for the Modbus power meter. For details, see 7.10.2.4
Setting Power Meter Parameters.

e Devices connected to a COM port of the SmartLogger must support the same protocol. After
connecting the cable, modify the COM port protocol on the LCD or WebUI. For details, see 6.2.25
Setting Communications Parameters or 7.10.2.2 Setting RS485 Parameters.

e The power meter cannot be detected automatically. You need to add this device manually on the
LCD or WebUI. For details about this operation, see 6.2.32 Managing Devices or 7.11.8.1
Connecting Devices.

—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the Power Meter.

4.7 Connecting to a PLC
This topic describes how to connect the SmartLogger to a PLC.
Context
The RS485 port of a PLC is an RJ45 port that should be connected to an RJ45 connector, as
shown in Figure 4-27.
Figure 4-27 PLC RS485 port connection (side view without the fastener)
1 8
L |
1IS01Z2C0011
Table 4-8 lists the cable colors and functions.
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Table 4-8 Cable colors and functions
No. Color Function
1 White and orange Reserved
2 Orange Reserved
3 White and green 12 Vin, power
4 Blue RS485A, and RS485 differential signal +
5 White and blue RS485B, and RS485 differential signal -
6 Green Reserved
7 White and brown Reserved
8 Brown N/A
There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.
Figure 4-28 shows how to connect the SmartLogger to the PLC.
Figure 4-28 Connecting the SmartLogger to the PLC
PLC
ILO1IC3014
Procedure

Step1 Choose a shielded network cable of appropriate length. Crimp an RJ45 connector at one end

and connect it to the RS485 port of the PLC.

Step 2 Connect the other end of the cable to the COM port of the SmartLogger. For details, see Step
2-Step 4 in Procedure in 4.3 Connecting the RS485 Signal SPD.
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e Connect the RS485+ port of the PLC to the COM?+ port of the SmartLogger and connect
the RS485- port of the PLC to the COM- port of the SmartLogger.

e The PLC cannot be detected automatically. You need to add this device manually on the
LCD or WebUI. For details about this operation, see 6.2.32 Managing Devices or 7.11.8.1
Connecting Devices.

e The Huawei PLC supports auto-negotiation of baud rate 9600 bps/115200 bps. If the PLC
networking is used, you are advised to set Baud rate to 115200 bps for the RS485 ports of
the SmartLogger to achieve better communication performance.

-—End

Follow-up Procedure

Take the reverse steps to disconnect the SmartLogger from the PLC.

4.8 Connecting an Ethernet Network Cable

Context
The SmartLogger can be connected to an Ethernet switch, router, or POE module. It can also
be connected to the Ethernet electrical port of a PC directly or through a hub. Select the
connection device based on the actual networking scenario.

Procedure

Step 1 Connect one end of the delivered network cable to the Ethernet electrical port of a device.
L] noTE
If the delivered cable is too short, pay attention to the following when preparing a cable:
e Select CAT 5E or a higher-class shielded network cable.
e It is suggested that the cable length is less than or equal to 100 meters.

Step 2 Connect the other end of the network cable to the FE port of the SmartLogger, as shown in
Figure 4-29.
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Figure 4-29 Connecting an Ethernet network cable
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A POE module can be connected only to the DATA port of the SmartLogger.

e The default IP address of the SmartLogger is 192.168.0.10, the default subnet mask is 255.255.255.0,
and the default gateway is 192.168.0.1.

e [f the SmartLogger is connected to a PC directly or through a hub, the IP addresses of the
SmartLogger and PC must be in the same network segment. For example, if the IP address of the
SmartLogger is 192.168.0.10, the IP address of the PC can be 192.168.0.11. The subnet mask and
the gateway of the PC should be consistent with those of the SmartLogger.

e If the SmartLogger connects to the PC through a network device (for example, a router), set the IP
addresses for the SmartLogger and network device to be in the same network segment. Correctly set
the gateway of the SmartLogger to ensure that the SmartLogger can normally communicate with the
network device.

e To enable communication between the SmartLogger and the NMS (such as the NetEco) on the PC,
set the NetEco parameters properly on the LCD or WebUI. For details, see 6.2.25 Setting
Communications Parameters or 7.10.2.5 Setting NetEco Parameters.

-—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the PC.

4.9 Connecting to a PID

This section describes how to connect the SmartLogger to a PID.

Context
There are three RS485 ports in the SmartLogger. For the port descriptions, see Context in
4.4.1 Connecting the SmartLogger to the SUN2000.
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Figure 4-30 shows how to connect the SmartLogger to the PID module.

Figure 4-30 Connecting the SmartLogger to the PID

ILO1IC3018

[ noTE

In the scenarios with the communication box, the SmartLogger and PID module are installed before
delivery, and the PID module is connected to the SmartLogger through the X2 terminal block.
Procedure
Step 1 Connect one end of the cable delivered with the PID to the RS485 port of the PID.

Step 2 Connect the other end of the cable to a Surge port of the RS485 signal SPD. For details, see
Step 2-Step 4 in Procedure in 4.4.1 Connecting the SmartLogger to the SUN2000.

/\ orice

Verify that the brown cable (RS485A) of the PID module is connected to Surge port 1 or 7 on
the RS485 signal SPD, and that the black cable (RS485B) is connected to Surge port 5 or 11
on the RS485 signal SPD.

-—End

Follow-up Procedure

Take the reverse steps to disconnect the SmartLogger from the PID module.

4.10 Connecting the SmartLogger to a Ripple Control
Receiver

This topic describes how to connect the SmartLogger to a ripple control receiver.
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Context

In Germany and some European areas, a ripple control receiver is used to convert a power
grid scheduling signal to a dry contact signal, in which a dry contact is required.

Figure 4-31 shows the DI ports of the SmartLogger.

Figure 4-31 DI ports of the SmartLogger
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Table 4-9describes the definition of the DI ports.

Table 4-9 DI port description

Port Functions

GNDL Dry contact_input common terminal 1, used for active
power derating for DI1-DI4

1 DI_1

2 DI_2

3 DI_3

4 DI_4

GND2 Dry contact input common terminal 2, used for reactive
power compensation for DI1-D14

Figure 4-32 shows how to connect the Smart Logger to the ripple control receiver.
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Figure 4-32 Connecting the SmartLogger to a ripple control receiver
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When active power remote control and reactive power remote control are supported, only one
out of the four outputs of each ripple control receiver can be closed.

Procedure

Step 1 Select a cable of appropriate length and connect one end of a cable to the ripple control
receiver.

Step 2 Connect the other end to the DI port in the SmartLogger. For details, see Step 2-Step 4 in
Procedure in 4.3 Connecting the RS485 Signal SPD.

/\ norice

To enable a normal power grid scheduling function, you need to set the corresponding
parameters (Active Power Control or Reactive Power Control) on the embedded WebUI. For
details, see 8 Power Grid Scheduling.

—End

Follow-up Procedure

Take operations in reversed order to disconnect the SmartLogger from the ripple control
receiver.
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System Operation

This topic describes how to start the SmartLogger and set the initialization parameters.

5.1 Power-on Process

This section describes how to check the SmartLogger before power-on and how to power on
the SmartLogger.

Checking Before Powering On the SmartLogger
Check and ensure the following before powering on the SmartLogger.

®  All cables are intact and well insulated.
e  All cables are of proper size.
e  All cables are correctly connected and secured.

Power-on Process

Power on the devices in the following sequence: Inverter > SmartLogger > PC terminal.

[ noTE

The PC terminal refers to a PC where the NetEco1000 is installed.

Step Operation

1 Perform the requirements mentioned in Checking Before Powering On the
SmartLogger.
2 Start the inverter and correctly set the communications parameters (including

Address, and Baud rate).

For details about how to set the communications parameters, refer to Setting
Communications Parameters in the SUN2000 (8KTL-28KTL) User Manual or
SUN2000 APP User Manual.

3 Connect the output terminal of the power adapter for the SmartLogger to the
power port POWER and the input terminal to the AC socket.
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Step Operation

4 Set the search address segment and baud rate for the RS485 port on the
SmartLogger monitoring panel.

If the SmartLogger is powered on for the first time, set the search address
segment and baud rate for the RS485 port in the Wizard, as shown in 5.2
Setting Initialization Parameters. If it is not powered on for the first time, set
the parameters in the Comm. Param. under the Settings, as shown in 6.2.25
Setting Communications Parameters.

5 Wait for the SmartLogger to search for inverters. After the search is completed,
the SmartLogger automatically connects to all inverters.

Alternatively, you can skip this operation and manually search for, add, or
delete inverters in follow-up operations. For details, see 6.2.32 Managing
Devices.

6 (Optional) Manually add an environment monitoring instrument, power meter,
PLC, or third-party device.

For details, see 6.2.32 Managing Devices.

NOTICE

Before adding an environment monitoring instrument or power meter, log in to the WebUI
and correctly set parameters for the device to be added. Before adding a third-party device,
import a correct configuration file for the device.

7 (Optional) Start the PC terminal and set Ethernet and NetEco parameters on the
SmartLogger.

/\ norice

e \When starting the SmartLogger, use only the 12 \V power adapter shipped along with the
shell. If adapters of other models are used, the SmartLogger may be damaged.

e L ogintothe SmartLogger on the monitoring panel. When you log in to the Settings page
or Maintenance page, an identity authentication is required. The initial password is
000001. Change the password as soon as possible to ensure the security of the user
account. For details about how to change the password, refer to 6.2.24 Changing a
Password.

5.2 Setting Initialization Parameters

When starting the SmartLogger for the first time, set initialization parameters on the
monitoring panel.

Context
(L] noTE
If the SmartLogger is started for the first time, set the initialization parameters by referring to this
section. If it is not started for the first time, it directly performs the automatic search and then the default
page.
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Procedure

®  The following table describes the process for setting initialization parameters. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

HUAWEI

1. After startup, the SmartLogger enters the
initialization page.

The default system language is English.

2. Press .J to enter the Wizard page.

To return to the default page, press ESC. If
some later re-settings are required, refer to
6.2.19 Setting the System Language, 6.2.20
Setting System Time Parameters, and 6.2.25
Setting Communications Parameters.

Wizard

Language

3. Select a display language and then press

The pages will be displayed in the selected

DET:Dizakle
Date:2016-02-27
Time:10:53:11

English
s language.
Deutzch
Italiano
BaE
Frangais
Wizard 4. Set the correct date and time and then press
DatekTime
Tz: * To select the specific parameter, press |

To set the parameter value, press 4\ or

V.

e The date and time are displayed in the
formats of YYYY-MM-DD and hh:mm:ss
respectively. YYYY stands for the year,
MM the month, DD the date, hh the hour,
mm the minute, and ss the second.

NOTICE

After the Time is successfully set, this time can be
synchronized in all the inverters connected to the
SmartLogger.
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LCD Operation Procedure

jzard—>Ethernet 5. Set the Ethernet parameters and then press
:Disable =

IF address:192.168. 0. 10
subnet mask:Zbb, 2bb. 2R 0
Gateway 192, 168, 0. 1

1

0

DN5-1:192. 168, 0.
DNs-2: 0. 0. 0.

oubmi 1
Wizard 6. Set the RS485 search address segment and
Search Address Segments then press -
aerAzio - 01 -100 You need to set the search address segments
RR425—2:001 =100 for RS485-1, RS485-2, and RS485-3

R5485-3:001-100 respectively.

Initialization—>Search Devices|| 7. Onthe page, press p |

After the search is complete, the SmartLogger

displays a search result. Press ,J to end this
Search devices now? operation.

ESC :Cancel o Enter

[} noTE

Visiting some menu requires identity authentication. Therefore, after you set the initialization parameters,
change the password immediately to ensure the security of the user account. For details, see Change the
Password.

—-End
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User Interface

This topic describes the monitoring menu and operations.

Context

The screenshots shown in this document are from SmartLogger V100R001C00SPC111. Data
in the screenshots are for reference only.

6.1 Monitoring Menu Hierarchy

The SmartLogger LCD menus include Power Station, Devices, Alarms, Settings,
Maintenance, and About. The Settings and Maintenance screens vary with the login users.

Table 6-1 LCD monitoring menus

Main Menu Second-Level | Third-Level Menu
Menu

Default screen | Power Station | E-Daily, E-Month, E-Year, E-History, E-Total

Devices Logger(Local), Inverter, Logger, Power Meter, PLC,
PID, EMI, Custom Device

Alarms Active Alarms, Alarm History, Sort By

Settings For the user operation permissions of the menu, see
Table 6-2.

Maintenance For the user operation permissions of the menu, see
Table 6-3.

About -

[ noTE

e indicates that the user has permission to operate the menu; o indicates that the user does not have
permission to operate the menu.
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Table 6-2 User operation permissions of the Settings menu

Settings Common User | Advanced Special User
User
Third-Level | Fourth-Level
Menu Menu
User Param. Language ° ° o
Date&Time ) ° o
Date Format ° o o
Contrast ° o o
Currency ° ° o
Electricity ° ° o
price/lkWh
CO2 emission ° ° o
reduction
User - ° ° °
Password
Comm. RS485-1 to o ° o
Param. RS485-3
Ethernet o ° o
NetEco o ° o
Modbus TCP o ° o
IEC103 o ° o
SmartLogger o ° o
Address
Restore - o ° °
Defaults
Table 6-3 User operation permissions of the Maintenance menu
Maintenance Common User | Advanced Special User
User
Third-Level Fourth-Level
Menu Menu
USB Expansion | Device Logs o ° °
Firmware o) ° °
Upgrade
Batch Upgrade | o ° °
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Maintenance Common User | Advanced Special User
Third-Level Fourth-Level User
Menu Menu
Exportall data | o ° °
files
Importall data | o ° °
files
Device Mgmt. Auto. Search o ) °
Add Manually | o ° °
Single Remove | o ° °
Batch Remove | o ° °
Addr. Allocate | o ° °
Config Import | o ° °
Alarm Reset o ° °
Batch o) ° °
Power-On/Off
Batch Reset o ° °
Data Clear - o ) °
System Reset - o ) °

6.2 Monitoring Operations

This topic describes how to operate on the monitoring panel, such as querying site and device
information and setting system parameters and user parameters.

6.2.1 Querying Power Station Information

Procedure

This topic describes how to view the power station information on the monitoring panel of the
SmartLogger, such as the daily, monthly, yearly, historical, and total energy yield.

The following table describes the procedure for viewing power station information. The
parameter values in the following figures are for reference only.
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e The daily energy yields can be stored for 30 days on an hourly basis.

e The monthly energy yields can be stored for 1 year on a daily basis.

e The yearly energy yields can be stored for 10 years on a monthly basis.
e The historical energy yields can be stored for 25 years on a yearly basis.

LCD

Operation Procedure

k'Wh

201T-05-10 16:32:24 1| 1 On the default screen, press « toenter the
main menu.

Eeduced C0Z: 240, 40k
botive power: 0. O0W

04 00 0200 1E: 00 16:00  £0:00 H

E-Daily: 24, 04kWh

M0

M:0 @0

2. Choose IE' and press .J

= @ 2 Y [

FPaower Station

ower Station 3.Press A and W to view the running
data of the power station.

F-onth The running data includes the daily, monthly,
yearly, historical, and total energy yield. For
B-Tear details, see step 4 to step 8.
E-Historv
E-Taotal
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LCD

Operation Procedure

Fower Statlon—»E-Daily

2015-09-15

E'Wh

0400 0F: 00 1E: 00 1600 E0:00

N

0. B53kKh

0. BBkz [ £0

ESC A v A

v

Fower Statlon—»E-Dally

2015-09-15 1BH

.

E'Wh

0400 0500 1E:00 1600 £0:00

N

0. S6kKh

0.56kg [ £0

ESC F 3 h

4. View the daily energy yield.

a. On the E-Daily screen, view the total
energy yield and hourly energy yield of the
power station on the current day.

The displayed information includes the energy
yield histogram, date, total energy yield on the
current day, CO2 emission reduction, and
revenue.

To view the energy yield in the past 30 days
(including the current day), press 4 or .

NOTE

In the daily energy yield histogram, the abscissa
stands for time (each block stands for one hour).
The ordinate stands for the total energy yield of all
the inverters connected to the SmartLogger (each
block stands for the total energy yield during the
last hour).

b. Press <J to view the energy yield of a
specific hour on the current day.

Press A or W to switch between hours.
Then you can view the total energy yield, CO;
emission reduction, and revenue
corresponding to the CO, emission reduction
during an hour before this sharp time.

NOTE
The selected block is displayed in white.
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LCD

Operation Procedure

Fower Statlon—>E-MNonth

201507
5 EWh
e 4 H 1z 16 &0 24 2%
E. 130k
B 11kz [ =1
ESC F Y v |

v

Fower Statlon—»E-MNonth

2015-07-01

4 & 12 & zo 24

P

5. 49kKh

5. 4Tkg [ £5

ESC F 3 h

5. View the monthly energy yield.

a. On the E-Month screen, view the total
energy yield and daily energy yield in the
current month.

The displayed information includes the energy
yield histogram, Month, total energy yield of
the current month, CO, emission reduction,
and revenue.

To view the energy yield in the past 12 months
(including the current month), press 4 or

NOTE

In the monthly energy yield histogram, the
horizontal axis stands for day (each block stands for
one day). The vertical axis stands for the total
energy yield of all the inverters connected to the
SmartLogger (each block stands for the total energy
yield on that day).

b. Press <J to view the energy yield on a
specific day of the current month.

Press A or W to switch between days.
Then you can view the total energy yield, CO;
emission reduction, and revenue
corresponding to the CO, emission reduction
on the current day.

NOTE
The selected block is displayed in white.
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LCD

Operation Procedure

Fower Statlon—>E-Year

2015

1 £ % 4 5 & T £ 4 10 11 1%

7. 36kNh

T.34kz [ =i

ESC A v A

v

Fower Statlon—»E-Year

2015-07

H|

1 £ % 4 5 & T # 4 10 11 1f

. 16kKh

6. 14kg [ £6

ESC F 3 h

6. View the yearly energy yield.

a. On the E-Year screen, view the total energy
yield of the current year and monthly energy
yield.

The displayed information includes the energy
yield histogram, year, total energy yield of the
current year, CO2 emission reduction, and
revenue corresponding to the CO2 emission
reduction.

To view the energy yield in the past 25 years
(including the current year), press 4\ or

NOTE

In the yearly energy yield histogram, the horizontal
axis stands for month (each block stands for one
month). The vertical axis stands for the total energy
yield of all the inverters connected to the
SmartLogger (each block stands for the total energy
yield in that month).

b. Press <J to view the monthly energy yield
of the current year.

Press A or W to switch between months.
Then you can view the total energy yield, CO;
emission reduction, and revenue
corresponding to the CO, emission reduction
in the current month.

NOTE
The selected block is displayed in white.
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Fower Statlon—>E-History

1991 - 2015
= EWh
R . . . . L
k) ad X od o3 14
T. 4THHL
T.45kz | =i
ESC A

v

Fower Statlon—»E-History

2015
= EWh
o H
g4 ad a5 04 o 14
T.4TIWh
T.45kg [ =i
ESC F Y v

7. View the historical energy yield.

a. On the E-History screen, view the total
energy yield over the past 25 years (including
the current year) and yearly energy yield.

The displayed information includes the energy
yield histogram, Year, total energy yield, CO;
emission reduction, and revenue.

NOTE

In the historical energy yield histogram, the
horizontal axis stands for year (each block stands
for one year). The vertical axis stands for the total
energy yield of all the inverters connected to the
SmartLogger (each block stands for the total energy
yield in that year).

b. Press -l to view the yearly energy yield
over the past 25 years (including the current
year).

Press 4 or W to switch between years.
Then you can view the total energy yield, CO;
emission reduction, and revenue
corresponding to the CO, emission reduction
in the current year.

NOTE
The selected block is displayed in white.

Fower Station—»E-Total

E-Total:l. BTHNWh
Feduced COZ:16. Rt
Reverme: 16681 €

8. On the E-Total screen, view the total
energy yield, CO emission reduction, and
revenue of all the devices connected to the
SmartLogger.

The total energy yield of the devices before
they connect to the SmartLogger is also
counted in the system after they are connected.

——-End

6.2.2 Querying Inverter Information

Procedure

This topic describes how to query the running information and version of each inverter

connected to the SmartLogger.

e  The following table describes the procedure for viewing inverter information. The
parameter values in the following figures are for reference only.
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2017-05-10 16:32:24

kWh

Od4:00  0F:00 1Z2:00  18:00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Z0: 00 K

Ao Mo D

1. On the default screen, press ,J to enter the
main menu.

EHEH® = it B

Devices

(]
2. Select mm and press .J

Devices—rSelect (1/2)

2): On—gric

EMI(2——1): Online

3. Select an inverter and press J

NOTE
SUN2000 (1--2) on the left indicates that the

inverter connects to Port 1 of the SmartLogger and
the communications address of the RS485 port is 2.

The device status is displayed behind the
device name.

The follow-up operations are described as
follows:

e To view the operating data of the inverter,

perform step 4.

e To view the version of the inverter,
perform step 5.
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Naintenance
Sbout

v

SUNZ000{5-1)

E-Month
E-Tear
E-Historv
E-Total
Input Data
Output Data

4. Select Running and press ,J
Press A and W to select the target
parameter, and then press <J

SINZ000 (3-1)

Furming
Nalntenance

SUNZ000 (3-1)

Type - SONZ000
Nodel J5UNZ000-25ETL
Version:V100ROO1CE1SPC110
S INVEINZ000VIRICS1001

vy, huawel. com

5. Select About and press .J

——End
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6.2.3 Manually Powering On or Off the Inverter on the
monitoring panel

This topic describes how to power on or off the inverter on the monitoring panel.

Procedure
®  The following table shows the procedure for powering on or off the inverter on the
monitoring panel. The parameter values in the following figures are for reference only.
A NOTICE
Choose Batch Power-On/Off under Maintenance to power on or off all inverters that
connect to the SmartLogger.
LCD Operation Procedure
2017-06-10 18:32:24 || 1 Op the default screen, press « to enter the
et main menu.
e o400 0E. 00 12,00 18.00 zo.00 H
E-Dailsy: 24. 0dkWh
Eeduced COZ: 240, dkg
botive power: 0. O0W
Mo @0 Do
[ ] |
2. Choose mm and press J
EHD &
Devices
Devices—roelect (1/2) 3. Select an inverter and press
SIN2000(1--2): On-grid NOTE
EMI(2—1): Online SUN2000 (1--2) on the left indicates that the
inverter connects to Port 1 of the SmartLogger and
the communications address of the RS485 port is 2.
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SUNZ000(5-1)

Funming

Naintenance

About

4. Choose Maintenance, and press ,J

Maintenance—>Login

User HName :RGYZvtel=ts SAl-T=v
Passwaord 000000

5. Set the specific User Name and Password.

NOTE

The following user names can be selected:
Common User, Advanced User, and Special User.
The initial password for Common User, Advanced
User and Special User is 000001.

6. Choose Power-On/Off, and press J

e Perform step 7 if you want to power on the
inverter manually.

e Perform step 8 if you want to power off the
inverter manually.
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SUNZ000 (1——7

ower—in

FPower-0ff

v

SUNZ000 (1-—7)

ESC :Cancel

Power on?

o Enter

7. Power on manually.

a. Choose Power-On and press |

b. Enter J again to verify your settings.

SUNZ000 (1--T7)

Paower-On

Power-0ff

v

SUNZ000 (1-—7)

ESC :Cancel

Fower off?

o Enter

8. Power off manually.
a. Choose Power-Off, and press <J

b. Enter ,J again to verify your settings.

——End

6.2.4 Sending a Reset Command to the Inverter

You can send a reset command to the inverter on the LCD.

Issue 10 (2017-08-30)

Huawei Proprietary and Confidential

Copyright © Huawei Technologies Co., Ltd.

71




SmartLogger1000
User Manual 6 User Interface

Procedure

®  The following table describes the procedure for sending a reset command to the inverter.
The parameter values in the following figures are for reference only.

LCD Procedure
2017-06-10 16:32:24 | 1 On the default screen, press «=l to enter the
ki main menu.
o Grion ogion 1z,o0 leion zoiom H

E-Dailwy: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

Ao M0 Do

(]
2. Choose mm and press J

EH®D S i B

Devices

Devices—5Select (1/2) 3. Select an inverter and press <.
SUNZ000(1—2): On—grid NOTE
FMI(2—1): Online SUN2000 (1--2) on the left indicates that the

inverter connects to Port 1 of the SmartLogger and
the communications address of the RS485 port is 2.

SUNZ000(5-1) 4. Choose Maintenance, and press |
Funming
Naintenance
About
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Maintenance—>Login 5. Set User name and Password.
NOTE

Because of the limited permission, select User
name as Advanced User. The initial password for
Advanced User is 000001.

User Name :Efieipte
Passwaord 000000

SUNZ000 (3-1) 6. Choose Reset and press -
Power-On/0ff

Eeset

Maintenance—>Reset 7. Press cJ

Enter

—End

6.2.5 Querying Information about the EMI

This topic describes how to query the EMI information on the monitoring panel.

Procedure
®  The following table describes the procedure for querying information about the EMI.
The parameter values in the following figures are for reference only.
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LCD Operation Procedure
2017-08-10 16:32:24 || 1 O the default screen, press « to enter the
s main menu.
o IZI4.: [ale} D:BI: [a]u} 12:I [a]u} 1& :I;D 2l:I:I [a]u} ?h.

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D

(]
2. Choose mm and press J

EHEH® = it B

Devices
Devices—>5elect (5/5) 3, Choose the name of the EMI and press =
Logzer (Local ) :0Online to view information about the instrument.
SUNZ000(3-2) :0n—=rid The device status is displayed behind the
PLC(3-249) :0nline device name.

PID(3-1) :Running
EMI{1-1):0nline

4. Choose Running and press ,J

e To view the running information of the
EMI, perform step 5 only.

e To view the communications address of the
EMI, perform step 6 only.
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1fomatlon

Comm, Address

v
FMI(1-1)

Total irradi.:220. 0W/m 2

Daily irradiat:q, 704kWh/m” 2

PV temperature: 39, 0desC

Ambient temp: 25, OdesC
Wind speed: 23, 0m/s

Wind direction: 4t (Northeast)

5. Choose Running Infomation and press

EMI(1-1)

Burming Infomation

Comm, Address

v
FMI(1-1)

Fort numker:1
Comm. address:l
Logical address:9

6. Choose Comm. Address and press .J

——End

6.2.6 Querying Master SmartLogger Information

This topic describes how to query Master SmartLogger information.
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Procedure

®  To query Master SmartLogger information, perform the steps described in the following
table. The parameter values in the figures are for reference only.

LCD

Procedure

2017-03-10 16:32:24

k'Wh

04 00 0200 1E: 00 16:00  £0:00

E-Dailwy: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

H

Ao M0 Do

1. On the default screen, press ,J to enter the
main menu.

EH®D S i B

Devices

(]
2. Choose mm and press J

Logzer (Local)

E-Dailw:1Z. 00kWh
E-Total : 834, 0kWh
Eeduced C0Z2:331. dkg
Input power: 20, 202N
botive power 200 000K
Eeact. power:0. 300kVar
FPower factor:0. 999

3. Choose Logger (Local) and press ,J to
view the Master SmartLogger information.

——End
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6.2.7 Querying Slave SmartLogger Information

This topic describes how to query Slave SmartLogger information on the monitoring panel.

Context
The Slave SmartLogger mainly applies to power grid scheduling of large-sized power stations.
One SmartLogger can connect to a maximum of 80 devices. When there are more than 80
inverters in the power station, a certain number of Slave SmartLoggers should be configured.
The power grid scheduling command sent to the Master SmartLogger is synchronized to the
Slave SmartLogger to enable the centralized power grid scheduling of the power station.
Devices can only be manually added and removed in the Slave SmartLogger on the
monitoring panel or the embedded WebUI.
A NOTICE
The Slave SmartLogger and the Master SmartLogger should be within the same local area
network (LAN).
Procedure
®  To query Slave SmartLogger information, perform the steps described in the following
table. The parameter values in the figures are for reference only.
LCD Procedure
2017-08-10 16:32:24 || 1 O the default screen, press « to enter the
s main menu.
o l:ld-.: ala] D:EFI: ao 12:Il:ll:l 16:‘;:! 2l:l:ll:ll:l ?h
E-Daily: 24, 0dkWh
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W
Mo Mo Do
(]
2. Select mm and press .J
EEH® = iy
Devices
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LCD

Procedure

Devices—rSelect (1/2)

Power Meter(1--2): Online

Logger '::I'lE: t, 22, 243 ' : Discomnec

3. Choose Logger to view the status and IP
address of the Slave SmartLogger.

The device status is displayed behind the
device name.

—End

6.2.8 Querying Information About the Modbus Power Meter

You can query information about the Modbus power meter over the LCD.

Procedure

® The following table describes the procedure for querying information about the Modbus
power meter. The parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-03-10 16:32:24

k'Wh

04:00 000 1200 16:00 000

E-Daily: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

H

Mo M0 Do

1. On the default screen, press J to enter the
main menu.

EH® S i B

Devices

[ ]
2. Select mm and press <J
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Operation Procedure

Devices—>Select (3/3)

Logzer(Local) :0nline
SIMZ0001(3-1) :0n-grid

Power Neter(1-1):0nline

3. Choose Power Meter and press ,J to
query the power meter information.

NOTE
Power Meter (1-1) on the left indicates that the
power meter connects to Port 1 of the SmartLogger
and the communications address of the RS485 port
is 1.

The device status is displayed behind the

device name.

ower Meter(1-1)

Funming

4. Choose Running and press J

¢ To view the running information of the
power meter, perform step 5 only.

e To view the communications address of the
power meter, perform step 6 only.

ower Meter(1-1)

Eurming Infomation

Comm, Address

v

Fower Meter(1-1)

4B line wvoltage:
B-C line wvoltage:
C—& line voltage:
Fhase & current:
Fhase B current:
FPhase U current:

betlve power:

387. 00V
387, 20¥
386, 80V
23.0A
23,04
23, 04
15, 000kW

5. Choose Running Infomation and press

-
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Fower Meteril-1)

Eurming Infomatlon

Comm, Address

v

Fower Meter(1-1)

Fort numker:1
Comm. address:l
Logical addr. :2

6. Choose Comm. Address and press <J

—End

6.2.9 Querying Information About the DL/T645 Power Meter

You can query information about the DL/T645 power meter information on the LCD.

Procedure

®  The following table describes the procedure for querying information about the DL/T645
power meter. The parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-05-10 16:32:24

E'Wh

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24, Ddlih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do

1. On the default screen, press J to enter the

main menu.
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LCD

Operation Procedure

EHEH® = it B

Devices

(]
2. Select mm and press <J

Dewvices—»Select (2/2)

Logzer(Local) :0nline

Fower Meter(3-1):0nline

3. Choose Power Meter and press J
NOTE

Power Meter (3-1) on the left indicates that the
power meter connects to port 3 of the SmartLogger
and its RS485 communications address is 1.

The device status is displayed behind the
device name.

ower Meter(3-1)
Funming
Settings

4. Choose Running and press J

To view the running information of the

power meter, perform step 5 only.
¢ To view the communications address of the
power meter, perform step 6 only.
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LCD

Operation Procedure

er(3-11 5. Choose Running Infomation and press

Infomation

Address

v

Fower Net

er(3-1J |

A-B 1
EC 1
C-4 1

Fower meter No. 000000000
Fhase A wvoltage:0. 00V
Fhase B voltage:0. 00V
FPhase C woltage:0. 00V

ine voltage:0. 00V
ine valtage:0. 00V
ine voltage:0. 00V

Fower Net

er(3-1) 6. Choose Comm. Address and press -

Burming Infomation

ol
l

romm. Address

v

Fower Net

er(3-1J

FPort number:3
Comm. address:l
Logical addr. :5

——End

6.2.10 Setting DL/T645 Power Meter Parameters

You can set DL/T645 power meter parameters on the LCD.
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Procedure
®  The following table describes the procedure for setting DL/T645 power meter
parameters. The parameter values in the following figures are for reference only.
LCD Operation Procedure
Z017-06-10 16:32:24 || 1 Op the default screen, press « to enter the
et main menu.
e o400 0E. 00 12,00 18.00 zo.00 A
E-Dailsy: 24. 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W
Mo @0 Do
[ ] |
2. Select mm and press cJ
HEHz & it
Devices
Devices—>5elect (2/2) 3. Choose Power Meter and press <.
Logger(Local) :Online NOTE
Fower Meter(3-1):0nline Power Meter (3-1) on the left indicates that the
power meter connects to port 3 of the SmartLogger
and its RS485 communications address is 1.
The device status is displayed behind the
device name.
Power Meter(3-1) 4. Choose Settings and press |
Funming
Settings
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LCD

Operation Procedure

Settings—>Login

User Name :REseists
Paszswaord 000000

5. Set User name and Password.

NOTE
Because of the limited permission, select User

name as Advanced User. The initial password for
Advanced User is 000001.

Fuwer Meter (3-1)

v

Fower Meter(3-1)

Protocol wersion iiEEtEEnid
Mum of lead bytes:d

6. Choose Running Param. and press .J

—End

6.2.11 Querying PLC Information

This section describes how to query the running information and version of a PLC connected
to the SmartLogger.

Procedure

The following table describes the procedure for viewing the information about a PLC.
The parameter values in the figures are for reference only.
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LCD

Operation Procedure

2017-05-10 16:32:24

kWh

Q400 0F: 00 1Z2:00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

16: 00 Z0: 00 K

Ao Mo D

1. On the default screen, press ,J to enter the
main menu.

EHEH® = it B

Devices

(]
2. Select mm and press .J

Devices—rSelect (3/4)

Logzer(Local) :0nline
SINZ000(3-2) :0n—-grid

2490 :0nline

PLC (3
PID(3-1) :Running

3. Select a PLC and press .J

NOTE

PLC (3-249) in the left figure indicates that the
PLC is connected to the Port 3 of the SmartLogger,
and its RS485 communications address is 249.

The device status is displayed behind the
device name.

The subsequent operations are as follows:

e To view the running information of the
PLC, perform step 4 to 6.

e To view the version information of the
PLC, perform step 7 only.

4. Select Running and press J
Naintenance
About
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1fomatlon

Comm, Address

FLC (3-249)

00 net status:networked

Device ident. :Search complete

olID:1

5. Select Running Infomation and press ,J

PLC (3-249)

Burming Infomation

Comm, Address

PLC(3-243)

Fort number:s
Comm. address:Z49
Logical addr. :6

6. Select Comm. Address and then press J
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LCD Operation Procedure

FLC(3-243) 7. Select About and press «=.
FEunning
Naintenance

PLC(3-249)
Version:V100ROO1CT25PC103
SN: SOUTHDEVICEPLCOO0Z49

—End

6.2.12 Sending a Reset Command to the PLC

You can send a reset command to the PLC on the monitoring panel.

Procedure

®  The following table describes the steps for sending a reset command to the PLC. The
parameter values in the following figures are for reference only.

LCD Operation Procedure

2017-05-10 16:32:24

1. On the default screen, press J to enter the
ek main menu.

Od:00  0F:00 12:00  18:00  Z0: 00 K

E-Daily: 24, Ddlih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do
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LCD

Operation Procedure

EHEH® = it B

Devices

(]
2. Choose mm and press ,J

Dewvices—»Select (3/4)

3. Select a PLC and press .J

Logzer(Local) :0nline
SINZ000(3-2) :0n—-grid

—24%9) :0nline

PID2-1) :Funning

NOTE

PLC (3-249) in the left figure indicates that the
PLC is connected to the Port 3 of the SmartLogger,
and its RS485 communications address is 249.

PLC(3-249)

4. Choose Maintenance and press J

Funming

Naintenance

About

Maintenance—>Login

5. Set User name and Password.

User HName :RGYZvtel=ts SAl-T=v

Passwaord 000000

NOTE

Because of the limited permission, select User
name as Advanced User. The initial password for
Advanced User is 000001.
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FLC (3-249)

6. Choose Restart and press ,J

PLC (3-249)

Confirm to restart?

ESC : Cancel o Enter

7. Press .J to verify your settings.

—-End

6.2.13 Querying PID Information

This topic describes how to query the running information and version of a PID connected to

Procedure

the SmartLogger.

®  The following table describes the procedure for viewing the information about a PID.
The parameter values in the figures are for reference only.

E-Dailwy: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

Ao M0 Do

LCD Operation Procedure
2017-06-10 16:32:24 | 1 On the default screen, press «=l to enter the
S main menu.
° piion 0R.00 1200 16i00 2000 H
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LCD

Operation Procedure

EHEH® = it B

Devices

(]
2. Select mm and press <J

Dewvices—»Select (4/4)

PID(3-1) :Running

LoggerLocal) :Online NOTE
SINZ000(3-2) :0n—-grid
PLC(3-249) :0nline

3. Select a PID and press .J

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1.

The subsequent operations are as follows:

e To view the operating data of the PID,
perform step 4 only.

e To view the version information of the
PID, perform step 5 only.

4. Select Running and press J

Running Press M and W to select Runing
Settings Infomation or Comm. Address, and then
About press -

Buming Infomation

Comm. Address
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LCD Operation Procedure

PID(3-2) 5. Select About and press «=.
FEunning

cettings

FPID(3-2)
Version:V200R1001C00
SH: 021 THRT 4810000000002

—End

6.2.14 Setting the PID Module Running Parameters

You can set the PID module running parameters on the LCD.

Procedure

®  The following table describes the procedure for setting the PID module running
parameters. The parameter values in the figures are for reference only.

LCD Operation Procedure

2017-05-10 16:32:24

1. On the default screen, press J to enter the
ek main menu.

Od:00  0F:00 12:00  18:00  Z0: 00 K

E-Daily: 24, Ddlih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do
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LCD

Operation Procedure

EHEH® = it B

Devices

(]
2. Choose mm and press ,J

Dewvices—»Select (4/4)

Logzer(Local) :0nline
SINZ000(3-2) :0n—-grid
PLC(3-249) :0nline

PID(3-1) :Running

3. Select a PID and press .J

NOTE

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1

FID(3-2)

4. Choose Settings and press J

settings—>Logzin

(IS R v anced User

Fassword 1000000

5. Set User name and Password.

NOTE
Because of the limited permission, select User
name as Advanced User. The initial password for
Advanced User is 000001.
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LCD

Operation Procedure

FID(S—I)

FowerOn/0ff
Data Clear

Dizakled
Cutput enabled:Disable
FV type:P-tvpe
PV/PE offset wolt. :0.0V
Operation mode:Normal
out. volt 0. 0¥

Commiss.
DT voltage:Na WV

MNax.

6. Choose Running Param. and press <J

—End

Parameter Description

Table 6-4 describes the PID module running parameters.

Table 6-4 Running parameter descriptions

No. | Parameter | Function Parameter | Description
Name Value
1 Offset mode | Specifies Disabled Set this parameter to Disable if the PID module is not
the offset required.
mode of the - - - -
PID N/PE Set this parameter to N/PE if the PID module is required to
module. use voltage output from the inductor virtual midpoint N.
PV/PE Set this parameter to PV/PE if the PID module is required
to use voltage output from the negative PV terminal.
This mode is applicable only to SUN80OQO.
Automatic In the SUN2000, Automatic indicates the N/PE offset
mode.
2 Output Specifies Enable Set this parameter to Enable to allow the PID module
enabled whether the output.
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No. | Parameter | Function Parameter | Description
Name Value
PID module | pjgaple Set this parameter to Disable to forbid the PID module
output is output.
enabled.
3 PV type Specifies P-type Set this parameter to P-type if the PV module type is P. In
the type of this case, the PID module output voltage is positive.
the PV
module N-type Set this parameter to N-type if the PV module type is N. In
used in the this case, the PID module output voltage is negative.
power
station. For
details
about the
PV module
type,
consult the
manufacture
r.
4 PV/PE Specifies 0-200V It is recommended that the offset voltage be set to a value
offset volt. | the DC ranging from 50 V to 200 V.
voltage
when the
offset mode
is set to
PV/PE.
5 Operation Specifies Commissio | In commissioning mode, if you need to set the output mode
Mode whether the | ning to PV/PE or N/PE, set Output enabled to Enable. The
PID module PID module delivers output voltages based on the value of
is currently Commiss. out.volt.
Worklr:g in NOTE
norma. 0!’ Before the first power-on, to check whether the PID functions
commission properly, it is recommended that Operation mode be set to
ing mode. Commissioning.

Normal In normal mode, the PID module operates automatically
after the PID module, inverter, and SmartLogger
communicate with each other properly.

6 Commiss. Specifies 0-500 V It is recommended that the commissioning voltage for the

out.volt the output 1000 V/1100 V inverter be set to a value ranging from 50
voltage V t0 400 V.
when thg | NOTE
PID m(.) ute After this parameter is set and the output from the PID module
works in- becomes stable, use a multimeter that is set to the DC position to
commission measure the three-phase (A, B, and C) voltages of the power grid
ing mode. to the ground, and check whether the voltages are the same as the
configured values.
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No. | Parameter

Name

Function

Parameter
Value

Description

7 Max. DC
voltage

Specifies
the PV-PE
voltage
when
Operation
Mode is set
to Normal
or
Commissio
ning.

500-1500 V

If the PV module type is P, the parameter value indicates
the highest DC voltage between PV+ and PE; if the PV
module type is N, the parameter value indicates the highest
DC voltage between PV- and PE.

8 Maximum
output
voltage

Specifies
the
maximum
output
voltage of
the PID
module
when
Operation
Mode is set
to Normal
or
Commissio
ning.

0-500 vV

If the compensation mode is PV/PE, the parameter value
indicates the highest DC output voltage between PV and
PE; if the compensation mode is N/PE, the parameter value
indicates the highest DC output voltage between N and PE.

9 IMD access

Specifies
whether the
PID module
and
insulation
monitor
device
(IMD) can
operate in
cycle mode.

Enable

Select Enable if you allow the PID module and IMD to
operate in cycle mode.

Only the IMDs of mainstream suppliers such as DOLD and
BENDER are supported, and the IMDs must have enabled
dry contacts.

Disable

Select Disable if you forbid the access of IMDs.

Periodic
PID runtime

10

Specifies
the
operating
time
segment of
the PID
module
when the
PID module
and IMD
operate in
cycle mode.

60—480 min

The IMD device is shut down when the PID module is
operating.
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No.

Parameter
Name

Function

Parameter
Value

Description

11

Periodic
IMD
runtime

Specifies
the
operating
time
segment of
the IMD
when the
PID module
and IMD
operate in
cycle mode.

15-480 min

The PID module is standby when the IMD device is
operating.

12

IMD control
dry contact

Dry contact
No. over
which the
SmartLogge
r controls
the IMD

DO1, DO2,
and DO3

Set appropriate ports based on the cable connections
between the IMD and the SmartLogger.

6.2.15 Manually Powering On or Off the PID on the monitoring

panel
This topic describes how to power on or off the PID on the monitoring panel.
Procedure
®  The following table shows the procedure for powering on or off the PID on the
monitoring panel. The parameter values in the following figures are for reference only.
LCD Operation Procedure

2017-05-10 16:32:24

kWh

1. On the default screen, press ,J to enter the
main menu.

Q400 0F: 00 1Z2:00

E-Daily: 24. 0dkith

16: 00 Z0: 00 K

Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D
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LCD

Operation Procedure

EHEH® = it B

Devices

(]
2. Choose mm and press ,J

Dewvices—»Select (4/4)

Logzer(Local) :0nline
SINZ000(3-2) :0n—-grid
PLC(3-249) :0nline

PID(3-1) :Running

3. Select a PID and press .J

NOTE

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1

FID(3-2)

4. Select Settings and press J

settings—>Logzin

(IS R v anced User

Fassword 1000000

5. Set User name and Password.

NOTE
Because of the limited permission, select User
name as Advanced User. The initial password for
Advanced User is 000001.
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LCD

Operation Procedure

FID(3-1)

Burming Param.

Power—0n/0ff
Data Clear

6. Choose Power-On/Off, and press ,J

e Perform step 7 if you want to power on the
inverter manually.

e Perform step 8 if you want to power off the
inverter manually.

ower—Jn

FPower-0ff

FID(3-2)

ower on?

o Enter

7. Power on manually.
a. Choose Power-On and press J
b. Enter ,J again to verify your settings.
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LCD

Operation Procedure

FID(3-2)

FPower-{n

FPower-0ff

FID(3-2)

Fower off?

ESC :Cancel o Enter

8. Power off manually.
a. Choose Power-Off, and press -
b. Enter J again to verify your settings.

—End

6.2.16 Clearing Historical PID Information

You can clear the active alarms and historical alarms stored on the PID module over the LCD.

Procedure

® The following table describes the procedure for clearing historical PID information. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-05-10 16:32:24

E'Wh

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24, Ddlih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do

1. On the default screen, press J to enter the
main menu.
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LCD

Operation Procedure

EHEH® = it B

Devices

(]
2. Choose mm and press ,J

Dewvices—»Select (4/4)

Logzer(Local) :0nline
SINZ000(3-2) :0n—-grid
PLC(3-249) :0nline

PID(3-1) :Running

3. Select a PID and press .J

NOTE

PID (3-1) in the left figure indicates that the PID is
connected to the Port 3 of the SmartLogger, and its
RS485 communications address is 1

FID(3-2)

4. Select Settings and press J

settings—>Logzin

(IS R v anced User

Fassword 1000000

5. Set User name and Password.

NOTE
Because of the limited permission, select User
name as Advanced User. The initial password for
Advanced User is 000001.
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LCD

Operation Procedure

FID(3-1)

Eurming FParam.
FowerOn/0ff

Data Clear

FID(3-1)

Clear data history?

ESC :Cancel o Enter

6. Choose Data Clear and press <J

—End

6.2.17 Querying Custom Device Information

Procedure

This topic describes how to query the running information and version of a custom device

connected to the SmartLogger.

®  The following table describes the procedure for viewing the information about a custom
device. The parameter values in the figures are for reference only.

LCD

Operation Procedure

2017-05-10 16:32:24

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24, Ddlih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do

1. On the default screen, press J to enter the

main menu.
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LCD Operation Procedure

(]
2. Select mm and press <J

EHEH® = it B

Devices
Devices—>Select (5/6) 3. Select a custom device and press -
Logzer (Local) :Online NOTE
SIN2000(3-2) :0n-grid Custom Devicel (2-1) in the left figure indicates

. . that the custom device is connected to the Port 2 of
PLC(3-249) .Dn:-L ine the SmartLogger, and its RS485 communications
PID(3-1) :Furming address is 1.

Custom Devicel (2-1) :0nline
EMI{1-1):Discomnection

v

Custom Devicel (2-1)
Fort number:Z

Comm. Address:l

Logical addr. :10

—End

6.2.18 Querying Alarm Records

This topic describes how to query active and historical alarms for the SmartLogger and the
connected inverters and how to set the alarm record sort mode on the monitoring panel.

Context
The LCD displays a maximum of 8000 latest alarm records.
Procedure
e  The following table describes the procedure for querying active and historical alarms and
setting the alarm record sort mode. The parameter values in the figures are for reference
only.
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LCD

Operation Procedure

2017-05-10 16:32:24

kWh

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

AL

M0 D:0

1. On the default screen, press ,J to enter the
main menu.

HEHHE E Ee W=

Alarms

2. Choose IZ' and press ,J

4] arm

Llarm History
sort By

3. Press W, choose the appropriate menu,
and press «J

Perform step 4 and step 5 to view active
alarms.

Perform step 6 and step 7 to view historical
alarms.

Perform step 8 to set the alarm sort mode.

SITHE

Active Alarms-»Select (1/1)

N (1-7) (73

4, On the Active Alarms screen, select the

target device name and press ,J to view all
the active alarms for this device.
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LCD

Operation Procedure

betive Alarmsil/1)

MVersion Mismatch S1D:1

v

Version Mismatch(l/1)

Alarm ID:504

Severity Minor (@

renerated:Z2013-08-13 11:26:158
Info:

Eeason ID =1

5. Select one of the alarm records by pressing
A or ¥ and view the alarm details by

pressing J
NOTE

For details about the alarm list of the
SmartLogger1000, see 9.3 Alarms.

For details about the alarm list of the SUN2000,
see the Troubleshooting in the SUN2000 series
user manual.

8 arm Historv—-rSelect (1/1)

s |-I|' "
Ll

SUNZ000 (1-7)

6. On the Alarm History screen, select the

target device name and press ,J to view all
the historical alarms for this device.
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LCD Operation Procedure

7. Select one of the historical alarms by
pressing 4 or W and view the alarm

MGrid Volt. Abnormal /1D:29 : ing «d
/MGrid Volt. Abnormal/ID:ga || details by pressing «=.
MGrid Volt. Abnormal /ID:29 NOTE

. . e [or details about the alarm list of the
MVersion Mismatch/ID:1 SmartLogger1000, see 9.3 Alarms.

o For details about the alarm list of the SUN2000,
see the Troubleshooting in the SUN2000 series
user manual.

v

Grid Volt. Abnormal (1/4)

Alarm ID:301

Severity :Major M

renerated:Z2013-08-13 11:24:2T

Cleard:2013-08-13 11:26:45
Info:

Reason ID = 29

51 arm 8. On the Sort By page, you can select the
way of sorting alarms.

betive Alarms
4larm History

4] arm

sort By

Generation time

blarm severity

——End
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6.2.19 Setting the System Language

This topic describes how to set the display language for the SmartLogger on the monitoring

panel.
Procedure
®  The following table describes the procedure for setting the display language. The
parameter values in the following figures are for reference only.
LCD Operation Procedure
2017-08-10 16:32:24 || 1 O the default screen, press « to enter the
et main menu.
e o4 00 0E. 00 12,00 16,00 zo.00 A
E-Daily: 24. 04kWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W
M0 @0 @0
2. Choose Q and press J
| | =
RN © W
settings
Settings—>Login 3. Specify the User Name and Password by
pressing 4 or W, and then press |
NOTE
4t Jrereed [lset e Because of the limited permission, select the
User Name. tdvanced User User Name as Common User or Advanced
Fassword: 000000 User. The initial password for Common User
and Advanced User is 000001.
e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit from the Settings page
and log in again within 30 seconds, no
authentication is required.
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LCD Operation Procedure

Settings 4. Choose User Param., and press p |

Uzer Password
Comm. Param.
Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

%ser Param. 5. Choose Language, and press <J

Date&Time
Date Format
Contrast
Currency
Electricity price/kWh
C0Z2 emission reduction

Cettings—>lUser Param. 6. On the Language page, select a display

Language language, and press .

The pages will be displayed in the selected
language.

English
3T
Deutsch
Italiano
B35

Frangals

—End

6.2.20 Setting System Time Parameters

This topic describes how to set the date, time and date format for the SmartLogger on the
monitoring panel.

Procedure
®  The following table describes the procedure for setting the time and date. The parameter
values in the following figures are for reference only.
Issue 10 (2017-08-30) Huawei Proprietary and Confidential 107

Copyright © Huawei Technologies Co., Ltd.



SmartLogger1000
User Manual

6 User Interface

LCD

Operation Procedure

2017-05-10 16:32:24

kWh

Od4:00  0F:00 1Z2:00  18:00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D

Z0: 00 K

1. On the default screen, press ,J to enter the
main menu.

EamEl E

Settings

2. Choose Q and press ,J

Settings—>Login

User Name :Risysaigta=te M If-1=ey
Password 000000

3. Specify the User Name and Password by
pressing 4 or W and then press |

NOTE

Because of the limited permission, select the
User Name as Common User or Advanced
User. The initial password for Common User
and Advanced User is 000001.

After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit from the Settings page
and log in again within 30 seconds, no
authentication is required.

Settings

User Password
Comm. Param.
Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose User Param., and press <J
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LCD

Operation Procedure

U=er Param.

Language

Date&Time

Date Format
Contrast
Currency

Electricity price/kWh
0% emission reduction

U=er FParam.

Language
Date&Time

Date Format

Contrast
Currency

Electricity price/kWh
0% emission reduction

5. Choose Date&Time or Date Format by
pressing W, and press pu |

NOTICE

e Modifying Date&Time will affect the integrity
of the SmartLogger's energy yield and
performance data. Hence, do not change it at
will.

o After Date&Time is successfully set, this time
can be synchronized in all the inverters
connected to the SmartLogger.

User Param.

Date&Time

DET:Dizakle
Date:2017-08-10
Time:16:48:02

B UTC+02:00 Beijine

6. On the Date&Time page, set the date and
time, set the time zone, enable or disable the

daylight saving time, and press .J

To select the specific parameter, click .J To
set the parameter value, set 4 or W

User Param.

Date Format

7. On the Date Format page, select a date
format, and press <.

YT -MN-DD
MM-DD-¥YYY
DD-MM-YYYY

——-End

6.2.21 Setting SmartLogger Contrast

You can set the SmartLogger contrast on the monitoring panel.
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Context

In addition to the method provided in this section, you can also press and hold 4 or W&
on the home screen to adjust the contrast.

Procedure
®  To set the SmartLogger contrast, perform the steps in the following table: The parameter
values in the figures are for reference only.
LCD Procedure
2017-08-10 16:32:24 || 1 O the default screen, press « to enter the
s main menu.
o l:l4l: ala] D:BI: ao 12:IIZIIZI 16:‘;0 2l:l:IIZIl:l ?h
E-Daily: 24, 0dkWh
Eeduced C0Z:1 240, 40kg
botive power: 0. 00W
M0 @0 Do
2. Choose Q and press J
[ ]| =
= o mE
Settings
Settings—>Login 3. Specify the User Name and Password by
pressing 4 or W, and then press |
NOTE
4t Jrereed [lset e Because of the limited permission, select the
User Name. tdvanced User User Name as Common User or Advanced
Fassword: 000000 User. The initial password for Common User
and Advanced User is 000001.
e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit from the Settings page
and log in again within 30 seconds, no
authentication is required.
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LCD Procedure

Settings 4. Choose User Param., and press p |

Uzer Password
Comm. Param.
Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced

User.
U=er Param. 5. Select Contrast and press p |
Language
Date&Time
Date Format

Contrast

Currency
Electricity price/kWh
0% emission reduction

cer Param —>Contrast 6. On the Contrast tab, press 4 and W to
6 set the contrast.
NOTE

The contrast value ranges from zero to ten.

—End

6.2.22 Setting the Currency and Currency Factor

This topic describes how to set the currency and currency factor for the SmartLogger.

Procedure
e  The following table describes the procedure for setting the currency and currency factor.
The parameter values in the following figures are for reference only.
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LCD

Operation Procedure

2017-05-10 16:32:24

kWh

Od4:00  0F:00 1Z2:00  18:00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D

Z0: 00 K

1. On the default screen, press ,J to enter the
main menu.

EamEl E

Settings

2. Choose Q and press ,J

Settings—>Login

User Name :Risysaigta=te M If-1=ey
Password 000000

3. Specify the User Name and Password by
pressing 4 or W and then press |

NOTE

e Because of the limited permission, select the
User Name as Common User or Advanced
User. The initial password for Common User
and Advanced User is 000001.

e  After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit from the Settings page
and log in again within 30 seconds, no
authentication is required.

Settings

User Password
Comm. Param.
Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose User Param., and press <J
e Perform step 5 to set the currency.
e Perform step 6 to set the currency factor.
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LCD

Operation Procedure

User FParam.

Language
Date&Time
Date Format
Contrast

Currency
Electricity price/kih
C0Z2 emission reduction

v

User Param.

Currency
3BF
5D
CHY
JPT

5. Set the currency.
a. Select Currency by pressing W, and press

b. Select a currency, and press -

U=zer Param.

Language
Date&Time
Date Format
Contrast

Currency

Electricity price/kih

0% emission reductlon

User Param.
Electricity price/kWh

B10 000

6. Set the currency factor.

NOTICE

Set the currency before you set the currency factor.
The currency factor is the electricity price per kWh,
which is used to calculate the energy yield revenue.

a. Select Electricity price/kWh by pressing
W, and then press pl |

b. Set the currency factor by pressing 4\ or
W, and then press pl |

——End
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6.2.23 Setting the CO2 Emission Reduction Coefficient

Procedure

The following table describes the procedure for setting the CO, emission reduction
coefficient. The data on the following figures are for reference only.

LCD Display

Procedure

2017-03-10 16:32:24

k'Wh

04 00 000 1F: 00 16: 00

E-Daily: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

Mo M0 Do

20 00 H

1. On the default screen, press «J to enter the
main menu.

=IO : ilE

settings

2. Choose Q and press J

Settings—>Login

User Name :[Xsysaigta=te M If-1=ey
Paszswaord 000000

3. Specify the User Name and Password by
pressing 4 or W and then press pu |

NOTE

Because of the limited permission, select the
User Name as Common User or Advanced
User. The initial password for Common User
and Advanced User is 000001.

After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit from the Settings page
and log in again within 30 seconds, no
authentication is required.
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LCD Display Procedure

Settings 4. Choose User Param., and press p |

Uzer Password
Comm. Param.
Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced

User.
llzer Param. 5. Select CO2 emission reduction and press
Language
Date&Time
Date Format
Contrast
Currency

Electricity price/kWh

C02 emisslion reduction

... =02 emission reduction
' emission reductiornBiRtdRe

—-End

6.2.24 Changing a Password

This topic describes how to change a password on the monitoring panel.

Context
®  The initial password is 000001 for Common User, Advanced User, and Special User.
e  After the first login, it is recommended that you change the initial password immediately
to ensure account security.
®  You are advised to change the password at least once every half year to prevent
unauthorized use of your account, which affects system security.
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Change the password in compliance with the following principles:
®  Six characters are required.
®  The password consists of digits, uppercase letters, and lowercase letters.
Procedure
®  The following table describes the procedure for changing a password. The parameter
values in the following figures are for reference only.
LCD Procedure

2017-05-10 16:32:24

E'Wh

T T T T T
Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do

1. On the default screen, press J to enter the
main menu.

EamEll E

settings

2. Choose Q and press J

settings—>Logzin

(IS R v anced User

Fassword 1000000

3. Set User Name and Password by pressing

A or 'V and press pl |
NOTE

User Name can be set to any of the following
values: Common User, Advanced User, and
Special User. The initial password is 000001.

After the authentication is successful, the
system keeps the authentication information for
30 seconds. If you exit from the Settings screen
and log in again within 30 seconds, no
authentication is required.
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Procedure

Settings

User Param.

Uzer Password

Comm. Param.
Eestore Defaults

User.

Here use the pages displayed when you
log in to the SmartLogger as Advanced

4. Select User Password by pressing W, and
press . |

settings—>User Password

Enter old password:

W o o] o]o] o]

(O00000-ZZZZZ7)

5. Enter the old password and press ,J

Increase or decrease the value by pressing 4
or W Switch between data bits by pressing

Settings—rlser Password

Enter new password:

I ool o] o] o]

(O00000-ZZZZZZ)

6. Enter a new password and press J

Increase or decrease the value by pressing 4\
or W Switch between data bits by pressing

Settings—rlser Password

Confirm new password agaln:

I o] ofo]o]o]

(O00000-ZZZZZZ)

7. Enter the new password again and press

NOTE
Ensure that you enter the new password twice
coherently. Otherwise, an error message is
displayed.
After the password is changed successfully,
the LCD displays operation success
information.

[ noTE

If you want to change the password for another account, exit from the Settings screen (without logging
in to the Maintenance screen), wait 30 seconds, log in by using the account for which you want to
change the password, and perform step 3 to step 7 in the preceding table.
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6.2.25 Setting Communications Parameters

Context

Procedure

You can set the SmartLogger parameters for communication on the monitoring panel.

®  Correctly set RS485 parameters to ensure normal communication between the
SmartLogger and the inverters and between the SmartLogger and the environmental

monitoring instrument.

®  Correctly set Ethernet parameters to ensure proper operation of Ethernet ports and
functions of logging in to the embedded WebUI, connecting to the element management

system, and sending emails.

®  Correctly set NetEco parameters to ensure normal communication between the

SmartLogger and the NetEco.

®  The following table describes the procedure for setting communications parameters. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-05-10 16:32:24

kWh

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D

1. On the default screen, press ,J to enter the

main menu.

EamEl E

Settings

2. Choose Q and press ,J
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Settings—»Login 3. Set User Name and Password by pressing
A or 'V and press |
NOTE

e Set User Name to Advanced User. The initial
password for Advanced User is 000001.

e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit from the Settings screen
and log in again within 30 seconds, no
authentication is required.

User Name :REseists
Paszswaord 000000

Settings 4. Select Comm. Param. and press |
User Param. e Perform step 5 and step 6 to set the
lzer Pagoword parameters for the RS485.

Comm. Param. e Perform step 7 and step 8 to set the
parameters for the Ethernet.

e Perform step 9 and step 10 to set the
parameters for the NetEco.

e Perform step 11 and step 12 to set the
parameters for the Modbus TCP.

e Perform step 13 and step 14 to set the
parameters for the IEC103.

Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced

User.
e Perform step 15 to set the SmartLogger
address.
Settings—>Comm. Param. 5. Select an RS485 port by pressing 4\ or
W and then press -
ES4RE-2 There are three RS485 ports: RS485-1,
RT4R5-3 RS485-2, and RS485-3. The corresponding
port for RS485-1 is COM1; RS485-2 is
Ethernet COM?2; RS485-3 is COMS3.
HetEeo
Nodbus TCP
IEC10E
Eumm. Param. —>RE=485-1 6. Set RS485 parameters and then press p |
219200 e The following baud rates are supported:
FParity:None 2400 bps, 4800 bps, 9600 bps, 19200 bps
tart address:l and 115200 bps. 9600 bps is
recommended.
End address:247
Frot 1 :Madbus e | < Start Address < End Address < 247.
rotocot- The address segments for these three ports
can overlap.
Set the address scope properly. The

broader the scope is, the longer the time is
for searching the devices.

e Parity must be set to the same value for all
devices connected to the same RS485 port.
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Settings—>Comm. Param.

Rodi5-1
Rsd85-2
Rodish—3

Ethernet
HetEco
Nodkus TCF
IEC103

7. Press W, select Ethernet, and press -l

omm. Param. —»FEthernet
Dizable

IP address:i19Z. 16E.

Subnet mask:Zbb. 255, 2B5,

Gateway:192, 168, 0,

DHE-1:192. 168, 0.

DH=-2: o, 0. 0.
Subml t

0. 10

0
1
1
0

8. Set Ethernet parameters and then press .J

NOTE
If the SmartLogger connects to the Internet through
a router, note the following when setting Ethernet
parameters:

e [f you set Auto obtain IP to Enable, the DHCP
server on the network assigns IP addresses. In
this case, you must ensure that a DHCP server is
working on the network.

e Set the gateway address to the IP address of the
router.

e Ensure that the IP address of the SmartLogger is
in the same network segment as the gateway
address.

e Set the domain name server (DNS) address to
the 1P address of the router or obtain the DNS
address from the network provider.

Settings—>Comm. Param.

E5d8k-1

ESd485-2

E5dBh-3
Ethernet

NetEco
Modbus TCF
IEC1035

9. Press W, select NetEco, and press |

omm. Faram. —NetBEco
S

Fort numkber:16100
bddress modeiLogical address

10. Set NetEco parameters and then press |

* In most cases, set Address mode to
Comm. Address. If the devices connected
to the three RS485 ports of the
SmartLogger have duplicate addresses, you
must set Address mode to Logical addr..

e Set the NetEco IP address correctly.
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Settings—>Comm. Param.
E5d8k-1
ESd485-2
E5dBh-3
Ethernet
HetEco

IEC103

11. Press W, select Modbus TCP, and press

omm. Param. —»Nodbus TCF
Disable

Client 1 IP: 0. 0. 0. 0
Client 2 IP: 0. 0. 0. 0
Client 3 IP: 0. 0. 0. 0
Client 4 IP: 0. 0. 0. 0
Client 5 IP: 0. 0. 0. 0
bddress mode:Logical address

12. Set Modbus TCP parameters and then
press

Modbus-TCP is a general standard
protocol without a security authentication
mechanism. Therefore, the function of
connecting to a third-party NMS using
Modbus-TCP is disabled by default to
reduce network security risks. Parameters
must be set correctly to enable the
function.

In most cases, set Address mode to
Comm. Address. If the devices connected
to the three RS485 ports of the
SmartLogger have duplicate addresses, you
must set Address mode to Logical addr..

Set the client IP addresses correctly.

Settings—>Comm. Param.
E5d8k-1
ESd485-2
E5dBh-3
Ethernet
HetEco
Nodkus TCF

IEC10E

13. Press W, choose IEC103, and press |

bddress:
IEC103 IP:

omm. Param. —»IEC103
Ho

126
0. 0.

14. Set IEC103 parameters and then press <J
NOTE

IEC103 is a general standard protocol without a
security authentication mechanism. Therefore, the
function of connecting to the NMS using IEC103 is
disabled by default to reduce network security risks.
Parameters must be set correctly to enable the
function.
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Settings—>Comm. Param. 15. Select SmartLogger Address and then

RS485-2 || press
Rhdih-3

Ethernet
NetEco

Modbus TCF
TEC103

—End

6.2.26 Restoring Factory Settings

This topic describes how to restore factory settings for the SmartLogger on the monitoring
panel. After this operation, all parameters, excluding the current date and time, will restore to
the default factory settings. However, the running information, alarm records, and system logs
do not change.

Context

A NOTICE

After restoring factory defaults for the SmartLogger, set the user parameters and
communications parameters in time and log in to the WebUI to set the environmental
monitoring instrument parameters and power grid dispatching parameters.

e The displayed language is English by default.

Procedure

e  The following table describes the procedure for restoring factory settings. The parameter
values in the following figures are for reference only.
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2017-08-10 16:32:24 || 1 O the default screen, press « to enter the
s main menu.
o |:l4l: [ale} |:|3‘: [a]u} :|.2:I [a]u} 1& :I;D 2':':I [a]u}

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D

EamEl E

Settings

2. Choose Q and press ,J

Settings—>Login

User Name :Risysaigta=te M If-1=ey
Password 000000

3. Enter the User Name and Password by
pressing 4 or W and then press |

NOTE

e Because of the limited permission, select the
User Name as Advanced User or Special

User. The initial password for Advanced User

and Special User is 000001.
e  After passing the permission validation, the

system keeps the authentication information for

30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Settings

Uzer Param.
User Password
Comm. Param.

Eestore Defaults

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose Restore Defaults, and press <J
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settings—rREestore Defaults 5. On the displayed page, press |

settings—>REestore Defaults 6. Press «d to complete the settings.

Complete

o Enter

—-End

6.2.27 Downloading Device Data Using a USB Flash Drive

You can download device logs using a USB flash drive over the monitoring panel, so that you
can use the logs for issue review and troubleshooting.
Context

Side View of the shell shows the USB port in the SmartLogger.

Procedure

®  The following table describes the procedure for downloading data using a USB flash
drive. The parameter values in the following figures are for reference only.

LCD Operation Procedure

2017-05-10 16:32:24

1. On the default screen, press J to enter the
% main menu.

Od:00  0F:00 12:00  18:00  Z0: 00 K

E-Daily: 24, Ddlih
Eeduced C0Z:1 240, 40kg
botive power: 0. 00W

Ao M0 Do
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HEHEUE-Y |1 =

Nalntenance

2. Choose LT_ and press .J

Maintenance—>Login

TS = vanced User
Password: 000000

3. Enter the User Name and Password by
pressing 4 or W and then press pul |

NOTE
e Because of the limited permission, select the
User Name as Advanced User or Special
User. The initial password for Advanced User
and Special User is 000001.

e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Maintenance

=B Expansion

Device Nzmt.
Data Clear

Svstem Beset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press |

NOTE
o Before this operation, connect the USB flash
drive to the USB port.

e If no USB flash drive is detected, the LCD
displays a message prompting No USB device
detected.

The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.
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Naintenance—>U5B Expansion

Firmware Upgrade
Batch Upzrade
Export all data files
Import all data files

v

Device Logs—>Select (1/2)
Logger (Local)

SUNZ000 (1-7)

5. Choose Device Logs and press <J

—End

6.2.28 Upgrading Firmware by Using a USB Flash Drive

Context

You can upgrade the firmware on the monitoring panel by using a USB flash drive. You can

upgrade the firmware of the SmartLogger and devices connected to the SmartLogger.
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A NOTICE

Before upgrading the firmware, download the upgrade package from
http://support.huawei.com and copy it to your USB flash drive.

Save the package under the root directory and do not extract the package.

When upgrading the firmware for the SUN2000, change the file name of the package to
sun2000_usb.zip.

When upgrading the firmware for the PID, change the file name of the package to
pid_usb.zip.

When upgrading the firmware for the PLC, change the file name of the package to
plc_usb.zip.

When upgrading the SmartLogger1000, ensure that the file name of the package is
logger_usb.tar.gz.

Procedure

The following table describes the procedure for upgrading the firmware by using a USB
flash drive. The parameter values in the figures are for reference only.

LCD Operation Procedure

201T-05-10 16:32:24 1| 1 On the default screen, press « 10 enter the

botive power: 0. O0W

K main menu.

04 00 0200 1E: 00 16:00  £0:00 H

E-Dailwy: 24, 0dkWh
Eeduced COZ: 240, dkg

Ao M0 Do

2. Choose LT. and press <J

ERHECE-Y |1 =

Naintenance
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Maintenance—>Login

[IEIS N = ranced User
Password: 000000

3. Enter the User Name and Password by
pressing A or W and then press pul |

NOTE
e Because of the limited permission, select the
User Name as Advanced User or Special
User. The initial password for Advanced User
and Special User is 000001.

e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Maintenance

UsE Exipansion

Device Nzmt.
Data Clear

ovstem Eeset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press ,J

NOTE
o Before this operation, connect the USB flash
drive to the USB port.

e [fno USB flash drive is detected, the LCD
displays a message prompting No USB device
detected.

The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.

Maintenance—>USE Eipansion

Device Logs

Firmware Upgrade
Batch Upzrade
Eizport all data files
Import all data files

5. Choose Firmware Upgrade, and press <J

Firmware Upsrade—>Select(l /2]

Logger (Local)

6. Press .J to select a specific device.

The SmartLogger and the inverters connected
to it can be upgraded.

The SUN2000 (1-7) on the left indicates that
this inverter connects to the Port 1 of the
SmartLogger and the communications address
for the RS485 port is 7.
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Maintenance—>1SE Expansion 7. After checki‘n-gI that Target Version is

correct, press <.
NOTICE

Curr. Ver. 'V100ROO1C00SPCO02Z For the SUN2000, its firmware can be upgraded
) ' only if the device status is On-grid or Shutdown.

Target Ver. tV100RODICOOSFCO03 Check the device status before firmware upgrade.

The SmartLogger, inverter, PLC, or PID will
restart after being upgraded.

ESC :Cancel o Enter

(The inverter upgrade screen is used as an
example.)

—End

6.2.29 Batch Upgrade

This topic describes how to perform a batch upgrade for the SUN2000 on the monitoring
panel.

Context

/\ orice

The SUN2000 that can be upgraded in batches on the SmartLogger must be SUN2000
V100R001C11SPC409, SUN2000 V100R001C81SPC101 and its later patch versions, or
SUNZ2000 V200R001CO00 and its later patch versions.

Procedure

e  The following table describes the batch upgrade procedure. The parameter values in the
figures are for reference only.

LCD Procedure

017708710 16:32:24 || 1 On the default screen, press « 10 enter the
EWh

1 main menu.

04 00 0200 1E: 00 16:00  £0:00 H

E-Dailwy: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

Ao M0 Do
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HEHEUE-Y |1 =

Nalntenance

2. Choose LT_ and press .J

Maintenance—>Login

TS = vanced User
Password: 000000

3. Enter the User Name and Password by
pressing 4 or W and then press pul |

NOTE
e Because of the limited permission, select the
User Name as Advanced User or Special
User. The initial password for Advanced User
and Special User is 000001.

e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Maintenance

5B Expansion

Device Nzmt.
Data Clear
Svstem Beset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press |

NOTE

o Before this operation, connect the USB flash
drive to the USB port.

e If no USB flash drive is detected, the LCD
displays a message prompting No USB device
detected.

The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.

Maintenance—>USE Eipansion

Device Logs
Firmware Upgrade

Batch Upgrade
FEiport all data files
Import all data files

5. Choose Batch Upgrade and press J
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Batch Upgrade 6. Choose SUN2000 and press <J

Batch Upzrade 7. After checking that Target ver. is correct,
press
NOTICE

Target ver. :¥20ORO01CO0SPCO04 e For the SUN2000, its firmware can be upgraded
T only if the device status is On-grid or
Shutdown. Check the device status before

firmware upgrade.

e The upgrade takes 20 minutes when the baud
rate is 9600 bps.

e After the upgrade is successful, the SUN2000
automatically restarts.

ESC :Cancel o Enter

—End

6.2.30 Exporting All Files

You can export all files from the SmartLogger on the monitoring panel.

Context
If the SmartLogger needs to be replaced, you can export all files before the replacement and
then import the exported files to the new SmartLogger to ensure data integrity.
Procedure
®  The following table describes the procedure for exporting all files. The parameter values
in the figures are for reference only.
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2017-05-10 16:32:24

kWh

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao Mo D

1. On the default screen, press ,J to enter the
main menu.

w2 E

Nalntenance

2. Choose LT_ and press <J

Maintenance—>Login

[IEIS N = ranced User
Password: 000000

3. Enter the User Name and Password by
pressing 4 or W and then press |

NOTE

e Because of the limited permission, select the
User Name as Advanced User or Special
User. The initial password for Advanced User
and Special User is 000001.

e  After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Maintenance

U5E Expansion

Device Nzmt.
Data Clear
ovstem Beset

Here use the pages displayed when you
log in to the SmartLogger as Advanced
User.

4. Choose USB Expansion and press ,J

NOTE
o Before this operation, connect the USB flash
drive to the USB port.

e If no USB flash drive is detected, the LCD
displays a message prompting No USB device
detected.

The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following
steps.
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Maintenance—>USB Expansion 5. Select Export all data files and press |
Device Logs
Firmware Upgrade
Batch Upgrade

Eizport all data files
Import all data files

—End

6.2.31 Importing All Files

You can import all files to the SmartLogger on the monitoring panel.

Context
If the SmartLogger needs to be replaced, you can export all files before the replacement and
then import the exported files to the new SmartLogger to ensure data integrity.
Procedure
e  The following table describes the procedure for importing all files. The parameter values
in the figures are for reference only.
LCD Procedure
2017-06-10 16:32:24 || 1 O the default screen, press « to enter the
et main menu.
e o400 0E. 00 12,00 18.00 zo.00 H
E-Dailsy: 24. 0dkWh
Eeduced COZ: 240, dkg
botive power: 0. O0W
Mo @0 Do
2. Choose LT. and press <J
[ ] | =
] == [ 22
Naintenance
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Maintenance—>Login 3. Enter the User Name and Password by
pressing A or W and then press pul |
NOTE

e Because of the limited permission, select the
User Name as Advanced User or Special
Pazsword: 000000 User. The initial password for Advanced User

and Special User is 000001.

e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

[IEIS N = ranced User

Naintenance 4. Choose USB Expansion and press ,J
5B Expansion NOTE
Device Mgmt. e Before this operation, connect the USB flash
Data Clear drive to the USB p-ort.-
g R e [fno USB flash drive is detected, the LCD
ystem heset displays a message prompting No USB device
detected.

The system takes 5 to 10 seconds to detect the
USB flash drive. Then perform the following

steps.
Here use the pages displayed when you P
log in to the SmartLogger as Advanced
User.
Maintenance—>USB Expansion 5. Select Import all data files and press |

Device Logs
Firmware Upgrade
Batch Upzrade
Eizport all data files

Import all data files

——End

6.2.32 Managing Devices

You can search, add, delete, and assign addresses to devices that are connected to the
SmartLogger on the monitoring panel.

Context
®  Provided that all the inverters are correctly connected to the SmartLogger and that all the
communications parameters are correctly set, the SmartLogger can perform the
automatic search and detect all the connected inverters.
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Procedure

Before you perform the Auto. Search operation, if the SmartLogger is connected to
devices that no longer exist in the PV power system, remove them from the SmartLogger
manually. Otherwise, these devices are still detectable with Disconnection status.

After you add, delete, or replace a device, or change the RS485 address, search for
devices again or restart the SmartLogger (the SmartLogger automatically searches for
devices after it restarts).

EMI, slave SmartLogger, power meter, PLC, and third-party devices cannot be
automatically recognized, and must be manually added.

For devices that no longer exist in the PV power system, perform Single Remove or
Batch Remove in time to avoid wasting the system resources.

The RS485 addresses of all inverters are the same when delivered. If the firmware
version of the SUN2000 is V100R001C00SPC010 or later, or V100R001C81SPC105 or
later, you can perform automatic address assignment on the SmartLogger and adjust the
addresses to realize remote site setup and improve maintenance efficiency.

When connecting a third-party device, you need to import a configuration file for the
device, and then manually add the device.

If you perform Alarm Reset, all active and historical alarms for the selected device will
be deleted and the SmartLogger will be enabled to collect new alarm data.

/\ norice

o |[f Data Clear is performed on Huawei devices such as the inverter and PID module,

Alarm Reset must be performed on the SmartLogger and NMS. Otherwise, the
SmartLogger cannot collect alarm information generated by the devices after Data Clear
is performed.

If Alarm Reset or Data Clear is performed on the SmartLogger, Alarm Reset must also
be performed on the NMS. Otherwise, the NMS cannot obtain alarm information collected
by the SmartLogger after Alarm Reset or Data Clear is performed.

The following table describes the procedure for managing the devices. The parameter
values in the following figures are for reference only.

botive power: 0. 00W

LCD Operation Procedure
201770810 16:32:24 || 1 On the default screen, press « 10 enter the
et main menu.
o |:|4I: oo |:|3‘: [a]n] :|.2:I [a]n] 1 :I:D 2':':I [a]n] r]l.

E-Daily: 24, 0dkWh
Eeduced C0Z2: 240, 40kg

Ao M0 Do
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Operation Procedure

HEHEUE-Y |1 =

Nalntenance

2. Choose LT_ and press .J

Maintenance—>Login

TS = vanced User
Password: 000000

3. Enter the User Name and Password by
pressing 4 or W and then press pul |

NOTE

Because of the limited permission, select the
User Name as Advanced User or Special
User. The initial password for Advanced User
and Special User is 000001.

After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Maintenance

5B Expansion

Device Nzmt.
Data Clear
oystem Reset

4. Choose Device Mgmt. and press |

Perform step 5 to enable the SmartLogger
to automatically search for devices.

Perform step 6 to add devices to the
SmartLogger.

Perform step 7 to remove a single device.

Perform step 8 to remove devices in
batches.

Perform steps 9-12 to automatically assign
addresses.

Perform step 13 to import a configuration
file.

Perform step 14 to reset alarms.

Perform steps 15-17 to start or shut down
inverters in batches.

Perform step 18 to reset inverters in
batches.
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aintenance—>Device Nzmt.

Add Warmallw
single Eemove
Batch Eemove
Addr. Allocate
Confiz Import
Llarm Eeset

v

Device Nzmt. —»Auto. Search

5. Choose Auto. Search and press ,J

Before performing the automatic search,
ensure that all the devices can normally
communicate with the SmartLogger.

NOTE
e After you add, delete, or replace a device, or

change the RS485 address, search for devices

again.

e |fadevice is added, search for the device on
SmartLogger or restart the SmartLogger and
then search for the device on the NMS.

the

Maintenance—>Device Mzmt.

Auto. Search
Add Warmallv
sinsgle Eemove
Batch Eemove
Addr. Allocate
Config Import
Alarm Eeset

v

Device Nzmt. —»Add Nanuallwy
Device type - iR
Comm. protocal ‘Modbus-ETUO

IP address: 0. 0. 0.

6. Choose Add Manually and press .J

NOTE

e EMI, slave SmartLogger, power meter, PLC,
and third-party devices must be manually
added.

e |f the communication is abnormal, or the
address on the port has been used, the device
cannot be added.
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Maintenance—>Device Nzmt.

bduto. Search
Add Warmallw

single Eemove
Batch Eemove

Addr. Allocate

Confiz Import
Llarm Eeset

v

Single Remove—>Select (4/4)

PID(1-2)

Custom Devicel (3-1)

SUNZ000(1-1)

7. Choose Single Remove and press <J
twice.

NOTE
For devices that no longer exist in the PV power
system, remove them in time to avoid wasting
system resources.

Maintenance—>Device Mzmt.

Auto. Search
Add NWarmallv
sinsgle Eemove
Batch Eemove

Addr. Allocate

Config Import
Alarm Eeset

v

Device Nzmt. —»Batch Femove

Batch

TEMOVE ?

ESC :Cancel

8. Choose Batch Remove and press .J

NOTE
For devices that no longer exist in the PV power
system, remove them in time to avoid wasting
system resources.
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Maintenance—>Device Nzmt.

Auto. Search
Add Warmallw
single Eemove
Batch Eemove

bddr. Allocate
Confiz Import
Alarm Eeset

v

bddr., Allocate—>Addr. Allocate

9. Select Addr. Allocate, set the start
addresses assigned for RS485-1, RS485-2, and

RS485-3, and then press .J to allocate the
addresses.

bddr. Allocate

10. Press .J to confirm the address
assignment.
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... —Addr. Adjustment

... —Addr. Adjustment

AMO10T1I64901D2001 22 e il

11. After the setting of Addr. Allocate is
completed, press ,J to adjust addresses.

Device Nemt. —»Auto. Search

Device Nzmt. —»Auto. Search

Search complete.
Device found & POS.

o Enter

12. After the setting of Addr. Adjustment is

completed, press ,J to search the devices.
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Maintenance—Device M=mt. 13. Choose Config Import, select a custom

Auto. Search device as required, and press o import a
Add Manually configuration file.
single Remove NOTE ) i o
e Before importing a configuration file, you must
Batch Remove plug in a USB drive that contains the
Addr. Allocate configuration file.
e After importing a configuration file, you need to
Alarm Reset manually add a third-party device.
Device Nzmt. —»Confiz Import
Custom Device 1
Custom Device 2
Custom Device 3
Custom Device 4
Custom Device &
Maintenance—Device M=mt. 14. Choose Alarm Reset, select a device as
Auto. Search required, and press -l
Add NWarmallv
sinsgle Eemove
Batch Eemove
Addr. Allocate
Config Import
4] arm Reset—>Select (1/5)
SUNZO00 (3-2)
PLC(3-249)
PID(3-1)
Custom Devicel (2-1)
FMI{1-1)
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Maintenance—Device Memt. 15. Choose Batch Power-On/Off and press
4dd Namaallv

Single Eemove
Batch ERemove
Addr. Allocate
Confiz Import
blarm Eeset
Batch Power—-On/0ff

]

... —»Batch Power-On/0ff 16. Choose Batch Power-On and press |

Batch Power-On

Batch Power-Off

Batch Power-n
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... —»Batch PowerOn/0ff

Batch Power—-On

Batch Power-Off

v

Batch Fower-0Off

Batch power off?

ESC :Cancel

o Enter

17. Choose Batch Power-Off and press ,J

Maintenance—>Device Mzmt.

single Eemaove
Batch Remowve
Addr. Allocate
Config Import
Alarm Eeset
Batch Power—-On/0ff

Device Ngmt. —»Batch Reset

Ferform batch reset?

ESC :Cancel o Enter

18. Choose Batch Reset and press J to
Al confirm the batch reset operation.

——End

6.2.33 Clearing Data

This topic describes how to delete alarm and performance data on the monitoring panel.
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Context

Procedure

Clear data if the SmartLogger location changes and its historical data need to be deleted.

/\ orice

e After the data clear operation is performed, all information stored on the SmartLogger,
including energy yield, performance data, and alarms, will be removed.

After the data clear operation is performed, the devices connected to the SmartLogger are
not removed. If an original device will not connect to the SmartLogger, remove the device.

If you perform Data Clear on the SmartLogger, you also have to perform Alarm Reset on
the NMS. Otherwise, the alarm information collected by the NMS and SmartLogger will

be different.

The following table describes the procedure for clearing data. The parameter values in

the figures are for reference only.

LCD

Operation Procedure

2017-05-10 16:32:24

E'Wh

T T T T T
Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24. Dd4kih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do

1. On the default screen, press J to enter the

main menu.

HEHEUE-Y |1 =

Nalntenance

2. Choose J_T_ and press .J
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Maintenance—>Login 3. Enter the User Name and Password by

pressing A or W and then press pul |
NOTE

e Because of the limited permission, select the
User Name as Advanced User or Special
Pazsword: 000000 User. The initial password for Advanced User

and Special User is 000001.

e After passing the permission validation, the
system keeps the authentication information for
30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

[IEIS N = ranced User

Maintenance 4. Press W, select Data Clear, and press

5B Expansion

Device Nzmt. NOTICE
Cleared data cannot be restored. Therefore, perform
this operation with caution.

Data Clear
ovstem Eeset

Maintenance—>Data Clear 5. On the displayed screen, press |

Clear historical dataf?

ESC : Cancel

Maintenance—>Data Clear 6. After the data is cleared, press pu | No
further operation is required.

Complete

o Enter

——End

6.2.34 Resetting the System

You can reset the system on the LCD.
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Procedure

The following table lists the procedure for resetting the system. The parameter values in
the following figures are for reference only.

LCD

Operation Procedure

2017-03-10 16:32:24

k'Wh

04 00 0200 1E: 00 16:00  £0:00

E-Dailwy: 24, 0dkWh
Eeduced C0Z: 240, 40k
botive power: 0. O0W

H

Ao M0 Do

1. On the default screen, press ,J to enter the

main menu.

ERHEOE Y | |=

Naintenance

2. Choose LT. and press <J

Maintenance—>Login

[IEIS N = ranced User
Password: 000000

3. Enter the User Name and Password by
pressing 4 or W, and then press -
NOTE

e Because of the limited permission, select the
User Name as Advanced User or Special

User. The initial password for Advanced User

and Special User is 000001.
e After passing the permission validation, the

system keeps the authentication information for

30 seconds. If you exit the screen and log in
again within the 30 seconds, no permission
authentication is required.

Maintenance

5B Expansion
Device Nzmt.
Data Clear

svstem Eeset

4. Choose System Reset by pressing W, and

press
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6.2.35 Querying Product Information

Procedure

LCD

Operation Procedure

|T|'[aint enance—ravstem Eeset

ESC :Cancel

5. Press <J

—End

This topic describes how to query the information about the SmartLogger on the monitoring

panel.

®  The following table describes the procedure for querying product information. The
parameter values in the following figures are for reference only.

LCD

Operation Procedure

2017-05-10 16:32:24

E'Wh

Od:00  0F:00 12:00  18:00  Z0: 00

E-Daily: 24, Ddlih
Eeduced C0Z2: 240, 40kg
botive power: 0. 00W

Ao M0 Do

1. On the default screen, press J to enter the
main menu.

b out

Tvpe: SmartLoggzerl 000
Model *SmartLoggerl 000-10
Version:V100R001C005PC111
sMZ2102310PGWIOEBOOOZER

vy, huawel. com

2. Select and press .J

——End
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7 WebUI

7.1 Note

A NOTICE

The web software version corresponding to the WebUI snapshots in this document is
SmartLogger V100R001CO00SPC111. The data on the WebUI snapshots is for reference
only.

Parameters displayed on operation pages vary depending on the role that you use to log in
to the WebUI. This document describes the operation pages displayed after you log in as
Advanced User.

When you log in to the WebUI with different identifications, parameters displayed on the
operation pages vary. This document describes the operation pages displayed after you log
in as Advanced User.

Configurable parameters vary depending on the device model and grid code. The actual
display prevails. The parameter list provided in this document includes all configurable
parameters.

The 600 V and 1000 V inverters refer to the inverters with the maximum input voltage of
600 V and 1000 V respectively. The 1100 V inverters refer to the inverters with the
maximum input voltage of 1100 V and the SUN2000-33KTL-US/36KTL-US/40KTL-US.
The maximum input voltage can be queried from the product nameplate or the appropriate
user manual.

7.2 Preparations for Login

Operating Environment

The operating environment for the WebUI should meet the following requirements:

Operating system: Windows

Internet Explorer 8 to Internet Explorer 11, Firefox17—Firefox39, or
CHROME41-CHROME45 (Windows 7)
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®  Minimum resolution: 1024x768

[ noTE

e For Internet Explorer 8, the recommended release is 8.0.7601.17514 or later.
e For Internet Explorer 10, the compatible mode is recommended.

Setting the IP Address

Correctly set the IP address, subnet mask, and gateway for the SmartLogger, PC, and network
devices (when connected).

Setting the LAN

/\ orice

e |If the SmartLogger is connected to a local area network (LAN) and a proxy server has
been set, you need to cancel the proxy server settings.

o |f the SmartLogger is connected to the Internet and the PC is connected to the LAN, do not
cancel the proxy server settings.

Step1 Open Internet Explorer.
Step 2 Choose Tools > Internet Options.
Step 3 Click the Connections tab and then click LAN settings.
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Figure 7-1 LAN setting (1)
r B
Internet Options M
| General I Security I Privacy I Content |[Connecﬁons IPrograms I Advanced|
To set up an Internet connection, dlick
Setup,
Dial-up and Virtual Private Metwork settings
Add
Remove...
Choose Settings if you need to configure a proxy Settings
server for a connection.
(@) Never dial 2 connection
Dial whenever a network connection is not present
Always dial my default connection
Current Mone Set default
Local Area Metwork (LAN) settings
LAN Settings do not apply to dial-up connections. ll
Choose Settings above for dial-up settings.
Ok, l [ Cancel Apply
b
Step 4 Deselect User a proxy server for your LAN.
Figure 7-2 LAN setting (2)
r B
Local Area Metwork (LAN) Settings M
1 e ——— -
Automatic configuration
Automatic configuration may override manual settings. To ensure the
use of manual settings, disable automatic configuration.
[¥]:Automatically detect settings:
|:| Use automatic configuration script
Address
Proxy server
@se a proxy server for your LAN (These settings will not apply to
ial-up or VPN connections).
Address: Part: (80 Advanced
Bypass proxy server for local addresses
[ QK ] l Cancel
|
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Step 5 Click OK.
----End

Setting Internet Explorer Security

/\ norice

To export fault information and operation logs, you need to set the Internet Explorer security.

Step 1 Open Internet Explorer.
Step 2 Choose Tools > Internet Options.

Step 3 Click the Security tab and then click Sites in Trusted sites.

Figure 7-3 Internet Explorer security setting (1)
Internet Opticns lélﬂ—hj

| General | Security |Privaq-' I Content I Connections I Programs I Advanced|

Select a zone to view or change security settings.

@ & (/|0
- b
Internet  Local intranet | \EEERE1EE]  Restricted

sites
Trusted sites —_—

Site:
'; This zone contains websites that you |

A trust not to damage your computer or
your files,
You have websites in this zone.

Security level for this zone
Allowed levels for this zane: Al

Low
- Minimal safequards and warning prompts are provided
- Most content is downloaded and run without prompts
- All active content can run
— - Appropriate for sites that you absolutely trust

[7]Enable Protected Mode {requires restarting Internet Explorer)

l Custom level... H Default level ] |

[ Reset all zones to default level ]

[ 0K l [ Cancel Apply

Step 4 Enter the website address of the WebUI (enter the default IP address 192.168.0.10 of the
SmartLogger for the first login), click Add, and then click Close.
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Figure 7-4 Internet Explorer security setting (2)
Trusted sites ﬁ

# You can add and remove websites from this zone. All websites in
1 ‘;" this zone will use the zone's security settings.

Add this website to the zone:
( J(_eee |

Websites:

* hisilicom, com -

el
i
[=]
m

* hisilicon. com
* hislicon.com
* huawei.com

- PPURUURE N PR JRppp

-

[ Require server verification (hitps:) for all sites in this zone

Close

Step 5 Set Security level for this zone to Medium or Low.

—End

7.3 Logging In to the WebUI

Context
The SmartLogger has been connected to a PC directly or over the Ethernet. For details, see
4.8 Connecting an Ethernet Network Cable.
If you log in to the WebUI for the first time, a security risk warning shown in Figure 7-5 is
displayed. Click Continue to this website. to continue the WebUI login.
(L] noTE
e Itis recommended that users use their own certificates. If the certificate is not replaced, the security
risk warning will be displayed during each login.
e After logging in to the WebUI, you can import a certificate under Network Security Certification
on the 7.11.3 Setting Security Parameters page.
e The imported security certificate needs to be bound to the SmartLogger IP address. Otherwise, the
security risk warning will still be displayed during login.
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Figure 7-5 Security risk warning

-3
|,@ There is a problem with this website's security certificate.

The security certificate presented by this website was not issued by a trusted certificate authority.
The security certificate presented by this website was issued for a different website's address.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
server.

We recommend that you close this webpage and do not continue to this website.

@' Click here to close this webpage.

[-@' Continue to this website (not recommended]‘]

@ More information

Procedure

Step 1 Enter https://XX.XX.XX.XX in the address box of the browser, and press Enter. The login
page is displayed.

Figure 7-6 Login page

)

HUAWEI

@ power system

nspire

Language

UEST RN ETL N Advanced User -

Password

[ noTE

XX XX XX.XX is the IP address for the SmartLogger. For example, the default IP address for the
SmartLogger is https://192.168.0.10.

Step 2 Specify Language, User Name, and Password, and then click Log In.

[ noTE
[ ]

The user name is Common User, Advanced User, or Special User. The password is 000001 in
V100R001C95SPCO010 or earlier and is Changeme in V100R001C95SPC020 or later.

e  After the first login, change the initial password immediately to ensure account security.

e |f you enter wrong passwords for five consecutive times in 5 minutes, your account will be locked
out. You have to try again with the account 10 minutes later.
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If any page is blank or a menu cannot be accessed after you log in to the WebUI, clear the
cache, refresh the page, or log in again.

~-End

7.4 WebUI Menu
The WebUI varies with the role that you use to log in.

[ noTE

e indicates that the user has permission to operate the menu; © indicates that the user does not have
permission to operate the menu.

Table 7-1 Users and permission on the WebUI

Menu Common | Advanced | Special
3 . User User User
Main Second-Level | Third-Level Fourth-Level
Menu Menu Menu Menu
Over View Plant Running - - ° ° °
Info.
Active Alarm - - ° ° °
Plant Yield - - ° ° °
Performance - - ° ° °
Data
Device Running | - - ° ° °
Info.
Monitoring SmartLoggerl0 | Running Info. - ) ° °
00
Active Alarm - ) ° °
About - ) ° °
Inverter? Running Info. - ° ° °
Active Alarm - ° ° °
Performance - ° ° °
Data
Yield - ° ° °
Running Grid o ° °
Param. Parameters
Protect o ° °
Parameters
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Menu Common | Advanced | Special
. 3 User User User
Main Second-Level | Third-Level Fourth-Level
Menu Menu Menu Menu
Feature o ° °
Parameters
Power o o °
Adjustment
Tracking - o ° o
System
LVRT - o o °
Characteristic
Curve
About - ° ° °
PLC Running Info. - ° ° °
STA List - o ° o
Networking - o ° o
Settings
About - ° ° °
EMI Running Info. - ° ° °
Performance - ) ° °
Data
About - ) ° °
Power Meter® Running Info. | - ° ° °
Performance - ) ° °
Data
Running - o ° o
Param.
About - ) ° °
PID Running Info. | - ° ° °
Active Alarm - ° ° °
Performance - ° ° °
Data
Running - o ° o
Param.
About - ° ° °
Custom Device | Running Info. | - ° ° °
Teleindication | - ) ° °
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Menu Common | Advanced | Special
Main Second-Level | Third-Level Fourth-Level User User User
Menu Menu Menu Menu
Telemetering - ) ° °
Telecontrol - ° ° °
Teleadjust - ° ° °
Query Alarm History - - ) ° °
Operation Log - - o ° °
Export Data - - o ° °
Settings User Param. Date&Time - ° ° o
Plant - ° ° o
Currency - ° ° o
Comm. Param. | Ethernet - o ° o
RS485 - o ° o
EMI - o ° o
Power Meter - o ° °
NetEco - o ° o
Modbus TCP - o ° o
IEC103 - o ° o
IEC104 - o ° o
Extended FTP - o ° o
Param. Email - o o o
Port Settings DO - o ° o
UsB - o ° o
Alarm Output - - o ° o
Extended Port - - o o °
Settings
Active Power - - o o °
Control
Reactive Power | - - o o °
Control
Dry Contact - - o o °
Remote Shut
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Menu Common | Advanced | Special
User User User
Main Second-Level | Third-Level Fourth-Level
Menu Menu Menu Menu
Maintenance | Firmware - - o ° °
Upgrade
Product - - ° ° °
Information
Security - - ° ° °
Settings
System Maint. - - o ° °
Device Log - - o ° °
Onsite Test Inspection - o ° °
Spot-check® - o ° °
License - - o ° °
Management
Device Mgmt. Connect - o ° °
Device
Device list - o ° °
Export Param. | - o ° °
Alarm Reset - o ° °
Collect Perf. - o ° °
Data
Adjust total - o ° °
energy yield
L] noTE

e a: Inthe inverter, Tracking System and LVRT Characteristic Curve are only available for the
1100 V inverter.

e b: The power meter can support the standard Modbus-RTU or DL/T645 protocol. Running Param.
is only available for the power meter that supports DL/T645.

e ¢: The spot-check function is available only for the inverter for which Grid Code is set to Japan
standard.
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7.5 Icon Description

Icon Description Icon Description
@] Click the About Click the Drop-down
icon to query the icon to select a
WebUI version parameter or time.
information.
= Click the Exit icon Alarms are classified
' to log out. into major, minor, and
warning ones. Click the
Alarm icon to query an
alarm.
> Click the Click the Start icon to
Increase/Decrease start the device.
< icon to adjust time.
@ The Select icon Click the Stop icon to
indicates that a shut down the device.
& parameter is
selected.
The Select icon Click the Reset icon to
indicates that a reset the device.
( parameter is not
selected. Click the
icon to selecta
parameter.
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7.6 WebUI Layout

Figure 7-7 WebUI layout

2 3

4

e l—l__n—‘_—|

PR stonicring T AT Err— |arars— S

Im;mmmam Performance Data ~ Yield ~ Running Param. ~ About I (X = X%
o.

la/Ub/Uc
13 1a/b/lc
14 Grid frequency

16 Locking
17 Startup time

18 Shutdown time
Collect DSP data

15 Cabinet temperature

Value Unit

36 kW
0.00 KWh
0.00 kWh
000 kg
NA W
NA kW

z
g
FRERE N

z
H
a

&
G

Table 7-2 WebUI layout description

No. Function Description
1 Secondary Under the primary navigation menu, choose the device to
navigation menu | be queried or the parameter to be set under the secondary
navigation menu.
2 Tertiary After choosing a secondary menu, choose a tertiary menu
navigation to access the query or setting screen.
menu?
3 Primary Click the corresponding primary navigation menu before
navigation menu | you perform any operation over the WebUI.
4 Display Select the display language or choose to log out.
language
5 Alarm icon Displays the severities and number of alarms in the system.
You can access the alarm page by clicking the number.
6 Details page Displays the details of the queried information or
parameter settings.
7 Power grid Displays the current power grid scheduling mode of the
scheduling status | system.
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No. Function Description
8 System time Displays the current system time.
a: There are no tertiary navigation menus under certain secondary navigation menus.

7.7 Overview

7.7.1 Plant Running Information

Choose Over View > Plant Running Info. and query information on the displayed page.

Figure 7-8 Plant running information

Power Station Information

Plant name

Plant address

Number of inverters 5

Total rated power 96.00kW
Active power E-Daily E-Total Reduced CO2 emission Revenue
0.31kW 460.23MWh 28.47MWh 28.39t ==

. ®@Power O Yield

Active power(kw)
2.0

0.8

0.4

0.0

00:00 04:00 08:00 12:00 16:00 20:00 00:00 h

[ noTE

The PV plant running information contains only the information about all the Huawei SUN2000s
connected to the SmartLogger.

7.7.2 Active Alarm

Choose Over View > Active Alarm and query alarms on the displayed page.
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Figure 7-9 Active alarm

Active Alm Quantity: 5

Device All E' Severity | All E' Sorting mode | Time E'

Alarm ID Severity Device Alarm Name Gel
111 Warning 40KTL-US(COM1-8) Abnormal String 6 201
109 Warning 40KTL-US(COM1-8) Abnormal String 4 201
108 Warning 40KTL-US(COM1-8) Abnormal String 3 201
107 Warning 40KTL-US(COM1-8) Abnormal String 2 201
106 Warning 40KTL-US(COM1-8) Abnormal String 1 201

7.7.3 Plant Yield

Choose Over View > Plant Yield and query energy yield data on the displayed page.

Figure 7-10 Energy yield
MR Morth  Year  History

*
“a1rm 171 Pagel:l

Yield
Tme (¢ (2007 V][5 v[[0 v 0>
kwh
-
2.00
1.60 -
1.20
0.80
<
0.40
OC-:DD 04:00 08:00 12:00 16:00 20:00 00:00
Time Yield(kWh) Reduced CO2 emission(kg) Revenue(€)
Total 414 413
00:00:00-01:00:00 0.00 0.00
01:00:00-02:00:00 0.00 0,00
02:00:00-03:00:00 0.00 0.00
03:00:00-04:00:00 0.00 0.00
04:00:00-05:00:00 0.00 0.00
05:00:00-06:00:00 0.00 0.00 =

L] noTE

You can select a tab on the tertiary navigation tree to query the energy yield data of the specific period.
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/\ orice

The daily energy yields can be stored for 30 days on an hourly basis.
The monthly energy yields can be stored for 1 year on a daily basis.
The yearly energy yields can be stored for 10 years on a monthly basis.
The historical energy yields can be stored for 25 years on a yearly basis.

7.7.4 Performance Data

Choose Over View > Performance Data and query related information on the displayed
page.

Figure 7-11 Performance data

®Table O Curve O Export Time ¢ [2017 v [s vl[20 v »

Generation time E-Daily(kWh) Input power(kW) Active power(kW) A
2017-5-20 00:00:00 0.00 3.549 3.415 22,
2017-5-20 00:05:00 2.68 3.548 3.449 22,
2017-5-20 00:10:00 5.37 3582 3407 22
2017-5-20 00:15:00 8.07 3493 3.359 22,

. 2017-5-20 00:20:00 1076 3476 3.402 22,
2017-5-20 00:25:00 1346 3478 3.374 22,
2017-5-20 00:30:00 1617 3466 3421 22,
2017-5-20 00:35:00 18.86 3.542 3.397 22,
2017-5-20 00:40:00 21.57 3.535 3.440 22,
2017-5-20 00:45:00 24.27 3.506 3.412 22,
2017-5-20 00:50:00 26.94 3581 3.447 22,
2017-5-20 00:55:00 29.64 3582 3418 22‘\«

< >

“4 1P » 1/11 Page

[ noTE
[ ]

You can click an option in the upper left corner of the page to display the data in the specified format
or export the data.

e When changing the name of the exported file after data is exported, retain the extension .tar.gz.
Otherwise, the file will be unusable.

7.7.5 Device Running Information

Choose Over View > Device Running Info. and query device running information on the
displayed page.
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Figure 7-12 Device running information

Total Device Qty.:2
Device address Device status E-Daily(kWh) Active power(kW) Reactive power(kVar)
33KTL(COM1-1) 1-1 Disconnection 0.00 0.000 0.000
V2R1-40K(COM1-2)C 1-2 Disconnection 0.00 0.000 0.000
< >

7.8 Device Monitoring

7.8.1 Querying Device Status
The indicator in front of the device name indicates the current status of a device.

e Ifthe indicator is 9, the inverter is in the On-grid state, and the EMI, power meter,
slave SmartLogger, or PLC module is in the Online state, and the PID module is the
Running state.

e Ifthe indicatoris = , the inverter, EMI, power meter, slave SmartLogger, PLC module,
or PID module is in the Disconnection state.

e Ifthe indicator is @, the inverter is in the Loading state.

e Iftheindicatoris ,the inverter is in the Initializing, Power-Off, Idle, or any other
state in which it does not feed power to the power grid.

[ noTE

If a device is in the Disconnection state, its parameters cannot be set.

7.8.2 SmartLogger
7.8.2.1 Querying Master SmartLogger-Related Information

Choose Monitoring > Logger(Local) and query master SmartLogger-related information on
the displayed page.
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Figure 7-13 Querying master SmartLogger-related information

Active Alarm About

No. Signal Name Value Unit

1 Energy yield of current day 0.00 kWh A

2 Total energy yield 0.00 kWh

3 Reduced CO2 emission 0.00 kg

4 Input power 0.000 kW

5 Active power 0.000 kW

6 Reactive power 0.000 kVar

7 Power factor 0.000

8 Inverter efficiency 0.00 %

42 DC current 0.0 A

10 Ia 0 A

11 Ib 0 A

12 Ie 0 A

13 Locked Locked

14 Max. value for reactive adjustment 0.0 kVar

15 Min. value for reactive adjustment 0.0 kVar

16 Max. value for active adjustment 0.0 kW

17 Remote scheduling (P) NA kW

18  Remote scheduling (Q) NA KVar

19 Remote scheduling (P) NA %

20 Remote scheduling (PF) NA

21 NetEco server 10.21.219.181

22 NMS11IP NA

23 NMS2 IP NA ¥

7.8.2.2 Querying Slave SmartLogger-Related Information

[ noTE

You can click a tab on the tertiary navigation menu to query master SmartLogger-related information.

Select a slave SmartLogger on the Monitoring tab page to query its information.
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Figure 7-14 Querying slave SmartLogger-related information
TR

No. Signal Name Value Unit
SN 2102311NAE10G6000029
IP Address 192.168.0.99

Device status Online

B ow oo e

Logical addr. 12

7.8.3 Inverter
7.8.3.1 Querying Related Information

On the Monitoring tab page, select the inverter to be queried and access the query page to
query related information.
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Figure 7-15 Querying inverter-related information

Active Alarm Performance Data Yield Running Param. About é o W
No. Signal Name Value Unit
1 Device status Disconnection
2 Rated power 36 kW
3 Energy yield of current day 0.00 kWh
4 Total energy yield 0.00 kWh
5 Reduced CO2 emission 0.00 kg
6 Input power NA kW
7 Active power NA kW
8 Reactive power NA kVar
9 Power factor NA
10 PV1/PV2/PV3/PV4/PV5/PVE voltage NA A
11 PV1/PV2/PV3/PV4/PV5/PV6 current NA A
12 Ua/Ub/Uc NA v
13 Ta/lb/Ic NA A
14 Grid frequency NA Hz
15 Cabinet temperature NA degC
16 Locking NA
17 Startup time NA
18 Shutdown time NA
19 Collect DSP data NA

[ noTE

e Youcanclickthe _ Running Info. 4 | Active Alarm Performance Data

Yield = o [ ABOUt " i on the tertiary navigation menu to query inverter-related
information.

e You can click the Start, Stop, or Reset icon to send the corresponding command to the inverter. The
login password is required if you need to send a command.

7.8.3.2 Setting Running Parameters (Advanced User)

Settings Page

Because of permission restriction, log in as Advanced User. Select the inverter to be set on
the Monitoring page and click the Running Param. tab.
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Figure 7-16 Running Param. (advanced user)
Running Info. Active Alarm Performance Data Yield About
Grid Parameters Protect Parameters Feature Parameters
Clan No. Signal Name Value Unit
O 1 Grid code VDE-AR-N-4105 v
O 2 Isolation Input ungrounded(with TF) ﬂ
41 » n page
Grid Parameters
Table 7-3 Parameter description
No. Parameter Description Value Range Supportive
Inverter
1 Grid code Set this parameter based on N/A 600 V, 1000 V, and
the grid code of the country or 1100 V inverters
region where the inverter is
used and the inverter
application scenario.
2 Isolation Specifies the inverter working | ® Input 1000 V and 1100 V
mode based on the grounding grounded(with TF) | inverters
status at the DC side and the e Input
connection to the power grid. ungrounded(witho
ut TF)
e Input
ungrounded(with
TF)
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Protection Parameters

Table 7-4 Parameter description

No. Parameter Description Unit | Value Range Supportive Inverter
1 Insulation To ensure device safety, | MQ | The value range for the | 600 V, 1000 V, and
resistance the inverter detects the 600 V inverter is [0.02, | 1100 V inverters
protection insulation resistance of 1.5], that for the 1000
the input side to the V inverter is [0.033,
ground when it starts a 1], and that for the
self-check. If the detected 1100 V inverter is
value is less than the [0.033, 1.5].
preset value, the inverter
does not export power to
the power grid.

Feature Parameters

Table 7-5 Parameter description

No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter
1 MPPT When the inverter | N/A | e Disable 600 V, 1000 V, The scan interval is
multi-peak | is used in scenarios e Enable and 1100 V set through MPPT
scanning where PV strings inverters scanning interval.

are obviously
shaded, enable this
function. Then the
inverter will
perform MPPT
scanning at regular
intervals to locate

the maximum
power.

2 MPPT Specifies the % [5, 30] 600 V, 1000 V, This parameter is
scanning MPPT scan and 1100 V displayed only
interval interval. inverters when MPPT

multi-peak
scanning is set to
Enable.
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No. | Parameter

Description

Unit

Value Range

Supportive
Inverter

Remarks

3 RCD
enhancing

RCD refers to the
residual current of
the inverter to the
ground. To ensure
device security and
personal safety,
RCD should
comply with the
standard. If an AC
switch with a
residual current
detection function
is installed outside
the inverter, this
function should be
enabled to reduce
the residual current
generated during
inverter running,
thereby preventing
the AC switch
from
misoperations.

N/A

e Disable
e Enable

1000 V and 1100
V inverters

N/A

4 Reactive
power
output at
night

In some specific
application
scenarios, a power
grid company
requires that the
inverter can
perform reactive
power
compensation at
night to ensure that
the power factor of
the local power
grid meets
requirements.

N/A

e Disable
e FEnable

600 V, 1000 V,
and 1100 V
inverters

For the inverters
except the 600 V
inverter, this
parameter is
available only
when Isolation is
set to Input
ungrounded(with
TF).
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No. | Parameter

Description

Unit

Value Range

Supportive
Inverter

Remarks

5 Strong
adaptability

If the value of
power grid short
circuit
capacity/power
plant installed
capacity is less
than 3 and the
power grid
impedance exceeds
the upper
threshold, the
power grid quality
will be affected
and the inverter
may be unable to
run properly. Set
Strong
adaptability to
Enable.

N/A

e Disable
e Enable

1000 V inverter

N/A

6 Power
quality
optimizatio
n mode

If Power quality
optimization
mode is set to
Enable, the
inverter output
current harmonics
will be optimized.

N/A

e Disable
e FEnable

1000 V and 1100
V inverters

N/A
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No. | Parameter

Description

Unit

Value Range

Supportive
Inverter

Remarks

7 PV module
type

Specifies the type
of PV modules.

N/A

¢ Crystalline
silicon

e Film

e CPV1

e CPV2

1000 V and 1100
V inverters

e |f PV module
type is set to
Crystalline
silicon or Film,
the inverter will
run properly
and will not
shut down if
PV modules are
shaded.

e |f PV module
type is set to
CPV 1, the
inverter can
restart quickly
in 60 minutes if
PV modules are
shaded and the
input power
greatly
decreases.

e |f PV module
type is set to
CPV 2, the
inverter can
restart quickly
in 10 minutes if
PV modules are
shaded and the
input power
greatly
decreases.

8 Crystalline
silicon PV
compensati
on mode

This parameter
reduces the DC
voltage of PV
modules to the PE
by reducing the
impedance of the
inverter input side
to the PE, thereby
effectively
reducing PID
effect of PV
modules.

N/A

e Output
disabled
* P-type
output
¢ N-type
output

1000 V and 1100
V inverters

This parameter is
displayed if PV
module type is set
to Crystalline
silicon. Set this
parameter to
P-type output for
P-type PV modules
and N-type output
for N-type PV
modules.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter

9 Communic | The standards of N/A | o Disable 600 V, 1000 V, If Communication
ation certain countries e Enable and 1100 V interrupt
interrupt and regions require inverters shutdown is set to
shutdown that the inverter Enable and the

must shut down inverter

after the communication has

communication is been interrupted

interrupted for a for a specified time

certain time. (set by
Communication
interruption
duration), the
inverter will
automatically shut
down.

10 Communic | Specifies the % [1, 120] 600 V, 1000 V, N/A
ation duration for and 1100 V
interruption | determining inverters
duration communication

interruption, and is
used for automatic
shutdown for
protection in case
of communication
interruption.

11 Communic | If this parameteris | N/A | e Disable 600 V, 1000 V, For the 600 V
ation enabled, the e Enable and 1100 V inverter, this
resumed inverter inverters parameter is
startup automatically starts displayed when

after
communication
recovers. If this
parameter is
disabled, the
inverter needs to
be started manually
after
communication
recovers.

Communication
interrupt
shutdown is set to
Enable.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter
12 Soft start Specifies the S [20, 1800] 1000 V and 1100 This parameter is
time duration for the V inverters set to 360 by

power to gradually default if the

increase when the Australian AS4777

inverter starts. grid code is
selected, to 300 by
default if the
Italian CEI0-21 or
CEI0-16 grid code
is selected, and to
600 by default if
the Egyptian
EGYPT grid code
is selected.

13 AFCI The North N/A | o Disable This parameter is N/A

American standard e Enable supported by only
requires the the products
inverter to provide marked -US.

the DC arc

detection function.

14 | Arc Adjusts the N/A | e High This parameter is
detection sensitivity of arc e Moderate displayed only
adaptation | detection. when AFCI is set
mode * Low to Enable.

15 | AFCI Send the AFCI N/A | N/A
self-test self-test command

manually.

16 Current When the IV A [0.00, 2.00] 1000 V and 1100 N/A
error curves of PV V inverters
during strings are being
scanning scanned, the

current change of
PV strings
operating properly
should be
monitored to avoid
inaccurate
scanning caused by
sunlight change. If
the current exceeds
the specified value,
it is determined
that the sunlight
changes, and the
IV curves should
be scanned again.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter

17 OVGR If this parameteris | N/A | e Disable 1100 V inverter This parameter is
linked set to Enable, the e Enable displayed after the
shutdown inverter shuts Japanese grid code

down after is selected.
receiving the

OVGR signal. If

this parameter is

set to Disable, the

inverter does not

shut down after

receiving the

OVGR signal.

18 Dry contact | Identifies the dry N/A e NC 1000 V and 1100 Set this parameter

function contact signals e OVGR V inverters to OVGR for

from the OVGR signals, and

SmartLogger. set it to NC for
other signals. This
parameter is
displayed after the
Japanese grid code
is selected.

19 Hibernate | The inverter N/A | e Disable 600 V, 1000 V, N/A
at night monitors PV e Enable and 1100 V

strings at night. If inverters
Hibernate at

night is set to

Enable, the

monitoring

function of the

inverter will

hibernate at night,

reducing power

consumption.

20 PLC For inverter N/A | e Disable 1100 V inverter e If Tracker
communica | models that e Enable controller is
tion support both set to a model,

RS485 and PLC this parameter
communication, cannot be set to
when RS485 Enable.

communication is
used, you are
advised to set PLC
communication to
Disable to reduce
power
consumption.

e |f the inverter
communicates
with the
SmartLogger
over PLC, this
parameter
cannot be set to
Enable on the
WebUI.

Issue 10 (2017-08-30)

Huawei Proprietary and Confidential
Copyright © Huawei Technologies Co., Ltd.

174




SmartLogger1000

User Manual 7 WebUI
No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter
21 Upgrade This parameter is N/A | e Disable 600 V and 1100 V | After the inverter
delay mainly used in the e Enable inverters upgrade starts, if
upgrade scenarios Upgrade delay is
where the PV set to Enable, the
power supply is upgrade package is
disconnected at loaded first. After
night due to no the PV power
sunlight or supply recovers
unstable at dawn or and the activation
dusk due to poor conditions are met,
sunlight. the inverter
automatically
activates the
upgrade.
22 String The inverter - e Disable 1000 V and 1100 If PV strings are
monitor monitors PV e Enable V inverters easily shaded, you
strings in real time. are advised to set
If any PV string is String monitor to
abnormal (such as Disable to prevent
being shaded or false alarms.
with decreased
energy yields), the
inverter generates
an alarm to remind
maintenance
personnel of timely
maintenance.
23 String Specifies the delay | min [2, 720]
detection time for generating
low power | abnormal string
delay alarms when the
inverter detects
that a PV string is
\évgvzqurmsth low T_his parameter is
paraméter ic lO_OO V and 1100 dlsplayed When _
; . V inverters String monitor is
mainly used in the
; set to Enable.
scenario where PV
strings are shaded
for a long time in
the morning and
evening, and is
used to prevent
false alarms.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter

24 String Specifies the delay | min [2, 720]
detection time for generating
high power | abnormal string
delay alarms when the

inverter detects
that a PV string is
working with high
power.

25 String Specifies the % [1, 100]
detection thresholds for
power determining
segment whether a PV
division string is working
percentage | with high power or

low power. This
parameter is used
to distinguish the
working status of
PV strings.

26 String Specifies the N/A | o SUN2000-(
detection threshold for 8KTL-28K
reference determining PV TL): [0.05,
asymmetric | string exception. 1]
coefficient | The false alarms e Others: [5,

caused by fixed 100]
shadow shading

can be controlled

by changing this

parameter.

27 String Specifies the N/A | [1, 100]
detection threshold for
starting starting PV string
power exception
percentage | detection. The

false alarms caused
by fixed shadow
shading can be
controlled by
changing this
parameter.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter

28 Shutdown | If this parameteris | N/A | ® SUN2000-( | 1000 V and 1100 N/A
at 0% set to Enable, the 8KTL-28K | V inverters
power limit | inverter shuts TL): [0.05,

down after 1]
receiving the 0% « Others: [5,
power limit 100]
command. If this

parameter is set to

Disable, the

inverter does not

shut down after

receiving the 0%

power limit

instruction.

29 Maximum | Specifies the kVA | [Maximum 1100 V inverter If the maximum
apparent output upper active power, active power
power threshold for the Smax_limit] equals Smax_limit,

maximum apparent this parameter is
power to adapt to not displayed.
the capacity

requirements for

standard and

customized

transformers.

30 Maximum | Specifies the kw [0.1, 1000 V and 1100 For 1000 V
active output upper Pmax_limit] V inverters inverters, this
power threshold for the parameter is

maximum active configurable only

power to adapt to for the

various market SUNZ2000-25KTL-

requirements. US, and the
maximum value is
27.5 kW.

31 Tracking Selects a controller | N/A | ® No tracking | 1100 V inverter N/A
system vendor. controller
controller e Each

controller
vendor
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter
32 Commande | The standards of N/A | e Disable 1000 V and 1100 N/A
d shutdown | certain countries e Enable V inverters
hold after and regions require
power that if the inverter
recovery is shut down based
on a command and
powers on again
after power
recovers, it should
still be in
commanded
shutdown state.
33 Grounding | If this parameteris | N/A | e Disable 600 V inverter N/A
abnormal set to Enable, the e Enable
shutdown inverter shuts
down after

receiving the
grounding error
signal. If this
parameter is set to
Disable, the
inverter does not
shut down after
receiving the
grounding error
signal.

7.8.3.3 Setting Running Parameters (Special User)

Settings Page

Because of permission restriction, log in as Special User. Select the inverter to be set on the
Monitoring page and click the Running Param. tab.
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Figure 7-17 Running Param. (special user)

Running Info.

Active Alarm

Performance Data

¥ Grid Parameters. Protect Parameters

Feature Parameters

el About

Power Adjustment

LIan No. Signal Name Value Unit
] 1 Grid code VDE-AR-N-4105 ﬂ
| 2 Auto start upon grid recovery Enable ﬂ
O 3 Grid connection duration after power grid recovery |60 (0-900) s
| 4 Grid reconnection voltage upper limit 2530 (230.0-312.8) v
O 5 Grid reconnection voltage lower limit 195.5 (103.5-218.5) v
| 6 Grid reconnection frequency upper limit 50.05 (50.00-56.00) Hz
O 7 Grid recannection frequency lower limit 47.50 (42.50-50.00) Hz
« 0 o Reactive power compensation (cos-P) trigger aTE T -
voltage
O 9 Reactive power compensation (cos-P) exit voltage |98 (90-100) %
HALPW 1/ Page
Grid Parameters
Table 7-6 Parameter description
No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter
1 Grid code Set this parameter N/A | N/A 600 V, 1000 V, N/A
based on the grid and 1100 V
code of the country inverters
or region where the
inverter is used and
the inverter
application
scenario.
2 Output Specifies whether N/A | ® Three-phas | SUN2000-33KTL, | N/A
mode the inverter has an e three-wire | SUN2000-36KTL,
output neutral wire e Three-phas and the inverter
_based on the_ _ e four-wire lrpodel!s marked
inverter application -Us
scenario.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter

3 PQ mode If PQ mode 1 is N/A | e PQmodel [ SUN2000-36KTL | N/A

selected, the e PQ mode 2 and
maximum AC SUNZ2000-42KTL
output power equals

the maximum

apparent power. If

PQ mode 2 is

selected, the

maximum AC

output power equals

the rated output

power.

4 Auto start Specifies whetherto | N/A | ¢ Disable This parameter is
upon grid allow the inverter to e Enable 1000 V and 1100 set to Disable by
recovery automatically start V inverters default if the

after the power grid Japanese grid code
recovers. is selected.

5 Grid Specifies the S [0, 900] 1000 V and 1100 | The value range
connection | waiting time for V inverters for 1000 V and
duration inverter restart after 1100 V inverters
after power | the power grid under the Japanese
grid recovers. grid code is [150s,
recovery 900s].

6 Grid The standards of Vv [100%Vn,
reconnectio | certain countries 136%Vn]

n voltage and regions require

upper limit | that the inverter
must not connect to
the power grid
when the power In 1000 V
grid voltage is inverters, the
higher than the SUN2000-(8KTL-
upper limit. 1000V and 1100 | 28KTL) does not

7 Grid The standards of Y [45%\/n, V inverters supporttthls
reconnectio | certain countries 95%Vn] parameter.

n voltage and regions require Vn represents the
lower limit | that the inverter rated voltage.

must not connect to
the power grid
when the power
grid voltage is
lower than the
lower limit.
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No. | Parameter | Description Unit | Value Range | Supportive Remarks
Inverter
8 Grid The standards of Hz [100%Fn,
reconnectio | certain countries 112%Fn]
n frequency | and regions require
upper limit | that the inverter
must not connect to
the power grid
when the power In 1000 VV
grid frequency is inverters, the
higher than the SUN2000-(8KTL-
upper limit. 1000V and 1100 | 28KTL) does not
9 | orid The standards of | Hz | [85%Fn, V inverters support this
reconnectio | certain countries 100%Fn] parameter.
n frequency | and regions require Fn represents the
lower limit | that the inverter rated frequency.
must not connect to
the power grid
when the power
grid frequency is
lower than the
lower limit.
10 Reactive Specifies the % [100, 110] 1000 V and 1100 N/A
power voltage threshold V inverters
compensati | for triggering
on (cosy-P) | reactive power
trigger compensation when
voltage LVRT occurs.
11 Reactive Specifies the % [90, 100] 1000 V and 1100 | N/A

power
compensati
on (cosy-P)
exit voltage

voltage threshold
for exiting reactive
power
compensation when
the inverter recovers
from LVRT.

V inverters
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Table 7-7 Parameter description
No. | Parameter | Description Unit | Value Range Supportive Remarks
Inverter
1 Unbalance Specifies the % [0.0, 50.0] 1000 V and N/A
voltage inverter 1100V
protection protection inverters
threshold in the
case of
unbalanced
power grid
voltage.
2 Phase The Japanese © [3, 15] 1000 V and Configurable
protection standard requires 1100 V abruptly
point that during inverters changed phase
passive islanding angles are 3%
detection, 6599 12<and
protection should 15< which are
be triggered if an displayed after
abrupt voltage the Japanese
phase change is grid code is
detected. selected.
3 Phase angle | The standards of | N/A | e Disable 1000 V and N/A
offset certain countries e Enable 1100 V
protection and regions inverters
require that the
inverter needs to
be protected
when the
three-phase angle
offset of the
power grid
exceeds a certain
value.
4 10 minute Specifies the \% [1xVn, 1.36 x Vn]
ov 10-minute 1000 V and
protection overvoltage 1100V
protection inverters
threshold. Vn represents
the rated
5 10 minute Specifies the ms e 1000V inverter: voltage.
ov 10-minute [50, 600000] 1000 V and
protection overvoltage e Others: [50, 1100V
time protection 7200000] inverters
duration.
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No. | Parameter | Description Unit | Value Range Supportive Remarks
Inverter
6 Level-1 OV | Specifies the \Y [1xVn, 1.36 x Vn]
protection level-1 1000 V and
overvoltage 1100 V
protection inverters
threshold. Vn represents
the rated
7 Level-1 OV | Specifies the ms e 1000V inverter: voltage.
protection level-1 [50, 600000] 1000 V and
time overvoltage e Others: [50, 1100V
protection 7200000] inverters
duration.
8 Level-2 OV | Specifies the \Y [1xVn, 1.36 x Vn]
protection level-2 1000 V and
overvoltage 1100V
protection inverters
threshold. Vn represents
the rated
9 Level-2 OV | Specifies the ms e 1000V inverter: voltage.
protection level-2 [50, 600000] 1000 V and
time overvoltage e Others: [50, 1100 V
protection 7200000] inverters
duration.
10 Level-1 UV | Specifies the \Y [0.15x Vn, 1 xVn]
protection level-1 1000 V and
undervoltage 1100V
protection inverters
threshold. Vn represents
the rated
11 Level-1 UV | Specifies the ms e 1000V inverter: voltage.
protection level-1 [50, 600000] 1000 V and
time undervoltage e Others: [50, 1100V
protection 7200000] inverters
duration.
12 Level-2 UV | Specifies the \Y [0.15x Vn, 1 xVn]
protection level-2 1000 V and
undervoltage 1100V
protection inverters
threshold. Vn represents
the rated
13 Level-2 UV | Specifies the ms e 1000V inverter: voltage.
protection level-2 [50, 600000] 1000 V and
time undervoltage « Others: [50, 1100V
protection 7200000] inverters
duration.
14 Level-1 OF | Specifies the Hz [Lx Fn, 1.15x Fn]
protection level-1 1000 V and Fn represents
overfrequency 1100 V the rated
protection inverters frequency.
threshold.
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No. | Parameter | Description Unit | Value Range Supportive Remarks
Inverter
15 Level-1 OF | Specifies the ms e 1000 V inverter:
protection level-1 [50, 600000] 1000 V and
time overfrequency e Others: [50, 1100V
protection 7200000] inverters
duration.
16 Level-2 OF | Specifies the Hz [1x Fn, 1.15 x Fn]
protection level-2 1000 V and
overfrequency 1100V
protection inverters
threshold. Fn represents
the rated
17 Level-2 OF | Specifies the ms e 1000V inverter: frequency.
protection level-2 [50, 600000] 1000 V and
time overfrequency e Others: [50, 1100 V
protection 7200000] inverters
duration.
18 Level-1 UF | Specifies the Hz [0.85x Fn, 1 x Fn]
protection level-1 1000 V and
underfrequency 1100V
protection inverters
threshold. Fn represents
the rated
19 Level-1 UF | Specifies the ms [50, 7200000] frequency.
protection level-1 1000 V and
time underfrequency 1100V
protection inverters
duration.
20 Level-2 UF | Specifies the Hz [0.85x Fn, 1 x Fn]
protection level-2 1000 V and
underfrequency 1100V
protection inverters
threshold. Fn represents
the rated
21 Level-2 UF | Specifies the ms e 1000V inverter: frequency.
protection level-2 [50, 600000] 1000 V and
time underfrequency e Others: [50, 1100 V
protection 7200000] inverters
duration.
22 Level-3 OV | Specifies the \Y [1xVn, 1.36 x Vn] e In 1000V
protection level-3 1000 V and inverters,
overvoltage 1100V only the
protection inverters inverters
threshold. marked
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No. | Parameter | Description Unit | Value Range Supportive Remarks
Inverter
23 Level-3 OV | Specifies the ms e 1000 V inverter: "-Us” .
protection | level-3 [50, 600000] support this
time overvoltage e Others: [50, 1000 V and parameter.
protection 7200000] 1100V e Vn
duration. inverters represents
the rated
voltage.
24 Level-4 OV | Specifies the \ [1xVn, 1.36 x Vn] e [n1000V
protection level-4 1000 V and inverters,
overvoltage 1100V only the
protection inverters inverters
threshold. marked
25 Level-4 OV | Specifies the ms e 1000V inverter: sulpJ)p?ort this
protection level-4 [50, 600000] parameter.
time overvoltage e Others: [50, 1000 V and . v
protection 7200000] _1100 \Y n
duration. inverters represents
the rated
voltage.
26 Level-3 UV | Specifies the \% [0.15xVn, 1xVn] e [n1000V
protection level-3 1000 V and inverters,
undervoltage 1100V only the
protection inverters inverters
threshold. marked
— : "-Us”
27 Level-3UV | Specifies the ms e 1000V inverter: support this
protection level-3 [50, 600000] parameter.
time undervoltage e Others: [50, 1000 V and . v
protection 7200000] _1100 Vv n
duration. inverters represents
the rated
voltage.
28 Level-4 UV | Specifies the \Y [0.15x Vn, 1 xVn] e In 1000V
protection level-4 1000 V and inverters,
undervoltage 1100V only the
protection inverters inverters
threshold. marked
29 Level-4 UV | Specifies the ms e 1000V inverter: sul;p?ort this
protection level-4 [50, 600000] parameter.
time undervoltage e Others: [50, 1000 V and . v
protection 7200000] _1100 \Y/ n
duration. inverters represents
the rated
voltage.
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Inverter

30 Overfrequen | Specifies the grid | Hz 50 Hz: 50.5 Hz,
cy overfrequency 51.0 Hz, 51.5 Hz,
protection protection and 52.0 Hz .
threshold threshold. 60 Hz: 60.6 Hz 600 Vinverter | N/A

61.2 Hz, 61.8 Hz,
and 62.4 Hz

31 Overfrequen | Specifies the grid | s 0.5s, 1.0s, 1.5s, and N/A
cy overfrequency 2.0s .
protection protection 600 V inverter
duration duration.

32 Underfreque | Specifies the grid | Hz 50 Hz: 49.5 Hz,
ncy underfrequency 49.0 Hz, 48.5 Hz,
protection protection 48.0 Hz, 47.5 Hz,
threshold threshold. and 47.0 Hz )

600 V inverter N/A
60 Hz: 59.6 Hz,
59.0 Hz, 58.4 Hz,
57.8 Hz, and
57.2 Hz

33 Underfreque | Specifies the grid | s 0.5s, 1.0s, 1.5s, and N/A
ncy underfr_equency 2.0s 600 V inverter
protection protection
duration duration.

34 AC Specifies the grid | V 110.0V, 1125V,
overvo!tage overvo!tage 115.0 V, and 120.0 600 V inverter N/A
protection protection
threshold threshold.

35 AC Specifies the grid | s 0.5s, 1.0s, 1.5s, and N/A
overvo!tage overvo!tage 2.0s 600 V inverter
protection protection
duration duration.

34 AC Specifies the grid | V 80.0V, 825V, 85.0
undervol.tag undervpltage V, 87.5V, and 90.0 600V inverter N/A
e protection | protection
threshold threshold.

35 AC Specifies the grid | s 0.5s, 1.0s, 1.5s, and N/A
undervolt undervpltage 2.0s 600 V inverter

protection
duration.

36 AC Specifies the N/A Disable
overvoltage | level-1 Enable 600 V inverter | N/A
protection overvoltage
enable protection.
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Inverter
37 FRT When the power | N/A | e Disable N/A
grid voltage is e Enable

abnormally low
for a short time,
the inverter
cannot
disconnect from
the power grid
immediately and
has to work for
some time. This

600 V inverter

is called LVRT.
38 Active Specifies N/A | e Disable
islanding whether to enable e Enable
protection the active .
enable islanding 600 V inverter N/A
protection
function.
39 Passive Specifies N/A | e Disable N/A
islanding whether to enable e Enable
protection the passive .
enable islanding 600 V inverter
protection
function.
40 Voltage The Japanese ° 396999 12<and
phase jump | standard requires 15°
detection that during
value for passive islanding
_passiv_e detecti(_)n, 600 V inverter N/A
islanding protection should

be triggered if an
abrupt voltage
phase change is

detected.
41 Frequency Refers to a N/A | e Disable N/A
feedback control module e Enable
module that calculates

the reactive
power based on
the offset
deviation of grid
frequency and
promotes
frequency offset
when islanding
occurs.

600 V inverter
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Inverter
42 Step Refersto a N/A | e Disable
injection control module e Enable
module that injects step
reactive power to
promote
frequency offset
when the offset
deviation of grid 600 V inverter N/A
voltage and
frequency is very
small. When
islanding occurs,
the inverter and
load reaches
balance.
43 Frequency Specifies level-1 | N/A | [0, 100] N/A
feedback gain of the 600 V inverter
module K1 | frequency
value feedback module.
44 Frequency Specifies level-2 | N/A | [0, 100]
feedback gain of the .
module K2 | frequency 600 V inverter N/A
value feedback module.
45 Restart Specifies how the | N/A | ¢ Manual N/A
mode after inverter restarts e Automatic .
grid failure | after a grid fault 600 V inverter
is rectified.
46 Restart Specifies the S 6s, 150s, 180s, 240s,
duration delay before and 300s
after grid restart after a 600 V inverter N/A
failure grid fault is
rectified.
47 System soft | Specifies the S [20, 800] N/A
start time duration for the
power to
gradually 600 V inverter
increase when
the inverter
starts.
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Inverter

48 Voltage rise | The Japanese N/A | e Disable N/A
suppression | standard requires e Enable

that the inverter

should control

the active power

and reactive 600 V inverter
power when the

output voltage

exceeds a certain

value to ensure

the grid voltage

stability.

49 Voltage rise | The Japanese \Y/ 107.0V, 107.5V,
suppression | standard requires 108.0 v, 108.5V,
reactive that the inverter 109.0V, 109.5 V,
adjustment | should adjust the 110.0V, 1105V,
point reactive power to 111.0V, 1115V,

prevent the grid 112.0V,and 112.5 | 600V inverter N/A
voltage from \Y/

rising when the

output voltage

exceeds a certain

value.

50 Voltage rise | The Japanese \Y 109.0 V, 109.5V, e The
suppression | standard requires 110.0V, 1105V, parameter
active that the inverter 1110V, 1115V, value is
derating should derate the 112.0V, 1125V, automaticall
point active power to 113.0V, 1135V, y displayed

prevent the grid
voltage from
rising when the
output voltage
exceeds a certain
value.

114.0V, and 114.5
\%

600 V inverter

after Voltage
rise
suppression
reactive
adjustment
point is set.

® The value of
Voltage rise
suppression
active
derating
point must
be greater
than that of
Voltage rise
suppression
reactive
adjustment
point.
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Table 7-8 Parameter description

No. | Paramete | Description Unit | Value Range | Supportive Remarks
r Inverter

1 LVRT When the power grid | N/A | ¢ Disable 1000 V and 1100 | This parameter is

voltage is abnormally e Enable V inverters set to Enable by
low for a short time, default if the

the inverter cannot German
disconnect from the BDEW-MV grid
power grid code is selected.
immediately and has

to work for some

time. This is called

LVRT.

2 LVRT Specifies the \% [50%Vn, 1000 V and 1100 | This parameter is

threshold | threshold for 92%Vn] V inverters displayed when

triggering LVRT. LVRT issetto

Enable.
In 1000 V
inverters, the
SUN2000-(8KTL-
28KTL) does not
support this
parameter.
Vn represents the
rated voltage.

3 LVRT Specifies whether to N/A | e Disable 1000 V and 1100 | This parameter is
undervolta | shield the e Enable V inverters displayed when
ge undervoltage LVRT issetto
protection | protection function Enable.
shield during LVRT.
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No. | Paramete | Description Unit | Value Range | Supportive Remarks
r Inverter
4 LVRT During LVRT, the N/A | [0, 3] 1000 V and 1100 | This parameter is
reactive inverter needs to V inverters displayed when
power generate reactive LVRT is set to
compensat | power to support the Enable.
ion power | power grid. This This parameter is
factor parameter is used to setto 2.5 by
set the reactive power default if the
generated by the South African
Inverter. grid code is
selected.
For example, if
you set LVRT
reactive power
compensation
power factor to
2, the reactive
power generated
by the inverter is
20% of the rated
power when the
AC voltage drops
by 10% during
LVRT.
5 High When the power grid | N/A | e Disable 1000 V and 1100 | N/A
voltage voltage is abnormally e Enable V inverters
ride-throu | high for a short time,
gh the inverter cannot
disconnect from the
power grid
immediately and has
to work for some
time. This is called
HVRT.
6 Active Specifies whetherto | N/A | e Disable 1000 V and 1100 | N/A
islanding | enable the active e Enable V inverters
islanding protection
function.
7 Passive Specifies whether to N/A | e Disable 1000 V and 1100 | This parameter is
islanding | enable the passive e Enable V inverters displayed after the
islanding protection Japanese grid
function. code is selected.
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No. | Paramete | Description Unit | Value Range | Supportive Remarks
r Inverter

8 Voltage The standards of N/A | Disable 1000 V and 1100 | This parameter is
rise certain countries and e Enable V inverters set to Enable by
suppressio | regions require that default if the
n the active power of Italian grid code

the inverter be CEIO-16 is
derated according to a selected.
certain gradient when

the output voltage

exceeds a certain

value.

9 Voltage The standards of % [100, 115] 1000 V and 1100 | ® This parameter
rise certain countries and V inverters is displayed
suppressio | regions require that when Voltage
n reactive | the inverter must rise
adjustment | generate a certain suppression is
point amount of reactive set to Enable.

power when the e The value of
output voltage . Voltage rise
exceeds a certain suppression
value. active

10 | Voltage | The standards of % [100, 115] 1000 V and 1100 derating point
rise certain countries and V inverters ;‘éztt ebrethan
suppressio | regions require that
n active the active power of that of Voltage
derating the inverter be rse .
point derated according to a SUpPression

certain gradient when reactive
the output voltage adj_ustment
exceeds a certain point.
value.

11 Frequency | The inverter triggers | N/A | ® Disable 1000 V and 1100 | N/A
change protection when the e Enable V inverters
rate power grid frequency
protection | changes too fast.

12 Frequency | Specifies the Hz/s | e 1000V 1000 V and 1100 | This parameter is
change frequency change rate inverter: V inverters displayed if
rate protection threshold. [0.1, 2.5] Frequency
prc_)tection e Others: [0.1, change_ratg
point 5] protection is set

to Enable.

13 Frequency | Specifies the S [0.2, 20.0] 1000 V and 1100
change frequency change rate V inverters
rate protection duration.
protection
time
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No. | Paramete | Description Unit | Value Range | Supportive Remarks
r Inverter

14 Soft start | Specifies the time for | s [20, 800] 600 V, 1000 V, This parameter is
time after | the power to and 1100 V set to 360 by
grid gradually increase inverters default if the
failure when the inverter Australian

restarts after the AS4777 grid code
power grid recovers. is selected, and to
300 by default if
the Brazilian
ABNT NBR
16149 or South
African SA_RPPs
grid code is
selected.
Power Adjustment Parameters
Table 7-9 Parameter description

No. | Paramete | Description Unit Value Range Supportiv | Remarks
r e Inverter

1 Active Adjusts the %ls e 1000V 600 V, 1000 | N/A
power change speed of inverter: [0.1, | V, and 1100
change the inverter 50] V inverters
gradient active power. e Others: [0.1,

1000]

2 Fixed Adjusts the e 600V | 1000V 600 V, 1000 | Pmax represents the
active active power inverter inverter: [0, V, and 1100 | maximum active
power output of the W Pmax] V inverters | power.
derated inverter in fixed | o Others: | o Others: [0, In the 1000 V

values. kW Pmax_limit] inverter, the upper
threshold for the
SUN2000-25KTL-US
is 27.5 kW, and the
upper threshold for
other models of
inverters is Pmax.

3 Active Adjusts the % [0, 100] 600 V, 1000 | If this parameter is set
power active power V, and 1100 | to 100, the inverter
percentage | output of the V inverters | delivers the maximum
derating inverter in output power.

percentages.

4 Reactive Adjusts the %/s [0.1, 1000] 600 V and N/A
power change speed of 1100V
change the inverter inverters
gradient reactive power.
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No. | Paramete | Description Unit Value Range Supportiv | Remarks
r e Inverter

5 Power Adjusts the N/A (-1.000, 1000 V and | N/A
factor power factor of -0.800]U[0.800, | 1100V

the inverter. 1.000] inverters

6 Trigger The standards Hz When the output | 1000 V and | N/A
frequency | of certain frequency is 50 1100V
of over countries and Hz, the value inverters
frequency | regions require range is [45.00,
derating that the output 55.00].

active power of When the output
the inverter frequency is 60
should be Hz, the value
derated when range is [55.00,
the power grid 65.00].
frequency

exceeds a

certain value.

7 Quit Specifies the Hz When the output | 1000 V and | N/A
frequency | frequency frequency is50 | 1100 V
of over threshold for Hz, the value inverters
frequency | exiting range is [45.00,
derating overfrequency 55.00].

derating. When the output
frequency is 60
Hz, the value
range is [55.00,
65.00].

8 Recovery | Specifies the %/min [5, 20] 1000 V and | This parameter is set
gradient of | power recovery 1100V to 16 by default if the
over gradient for inverters Australian AS4777
frequency | overfrequency grid code is selected,
derating derating. and to 15 by default if

the Italian CEI0-21 or
CEIO0-16 grid code is
selected.
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No. | Paramete
r

Description

Unit

Value Range

Supportiv
e Inverter

Remarks

9 Remote
power
schedule

If this parameter
is set to Enable,
the inverter
responds to the
scheduling
instruction from
the remote port.
If this parameter
is set to
Disable, the
inverter does
not respond to
the scheduling
instruction from
the remote port.

N/A

e Disable
e Enable

600 V, 1000
V, and 1100
V inverters

N/A

10 Schedule
instruction
valid
duration

Adjusts the
duration within
which the
scheduling
instruction is
valid.

[0, 86400]

600 V
inverter

If this parameter is set
to O, the instruction is
valid permanently.

11 Maximum
apparent
power

Specifies the
output upper
threshold for the
maximum
apparent power
to adapt to the
capacity
requirements for
standard and
customized
inverters.

kVA

[Maximum
active power,
Smax_limit]

600 V
inverter

If the maximum active
power equals
Smax_limit, this
parameter is not
displayed.

12 Maximum
active
power

Specifies the
output upper
threshold for the
maximum
active power to
adapt to various
market
requirements.

kw

[0.1,
Pmax_limit]

600 V
inverter

N/A
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No. | Paramete | Description Unit Value Range Supportiv | Remarks
r e Inverter
13 Shutdown | If this parameter | N/A e Disable 600 V N/A
at 0% is set to Enable, e Enable inverter
power the inverter
limit shuts down after
receiving the
0% power limit
instruction. If
this parameter is
set to Disable,
the inverter
does not shut
down after
receiving the
0% power limit
instruction.
14 Reactive Adjusts the N/A (-1.000, 1.000] 600 V N/A
power inverter output inverter
compensat | reactive power.
ion (Q/S)
15 Reactive Adjusts the N/A (-1.000, 600 V N/A
power power factor of —0.800]U[0.800, | inverter
compensat | the inverter. 1.000]
ion (PF)

7.8.3.4 Setting a Tracking System

If a PV string uses a tracking system with controllers, you can set parameters for the tracking
system over the WebUI.

[l noTE

e The parameters vary depending on the controller manufacturer. Set parameters based on site

requirements.

e This function applies only to the 1100 V SUN2000.

Because of permission restriction, log in as Advanced User. Choose Monitoring >
SUN2000 > Tracking System to access the target page.
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Figure 7-18 Setting a tracking system

Running Info. Active Alarm Performance Data Yield Running Param. Tracking System

@ Support System ) Configure Para

About

Support System
Tracker controller  Tonking
Support system type  Tilted single axis

Total number of supports 0

Batch Stop [l Batch Cir Fault il Tilts Batch Setting | Az Batch Setting

[l noTE

You can click the Select icon in the upper left corner of the page to select a setting page.

7.8.3.5 Setting the LVRT Characteristic Curve
L noTe

Only the 1100 V SUN2000 supports the LVRT characteristic curve, and other models of SUN2000s do

not have this function.

Because of permission restriction, log in as Special User. Choose Monitoring > SUN2000 >

LVRT Characteristic Curve and set the characteristic curve on the displayed page.
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Figure 7-19 Setting the LVRT characteristic curve

Running Info. Active Alarm Performance Data Yield LULLIeRE s LVRT Characteristic Curve About

Characteristic curve points 2 El

Ujuc

»i(ms)

.00 T T T T T T
-1000 1000 3000 5000 7000 9000 11000
t(ms) U/Uc(%)

A 20 (0~-10000) 0.20
B 1000 (0~-10000) 0.80

Batch configurations

(0.00~1.00)
(0.00~1.00)

[ noTE

After you set the LVRT characteristic curve for one SUN2000, click Batch configurations to
synchronize the LVRT characteristic curve settings to other SUN2000s.

7.8.4 PLC

The SmartLogger is integrated with the PLC CCO and connected to the SUN2000 that
supports the PLC function over an AC power cable. Data is transmitted over the power cable

to implement PLC networking.

7.8.4.1 Querying Related Information

Choose Monitoring > PLC and query related information on the displayed page.
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Figure 7-20 Querying PLC-related information

STA List ing Settings  About (%)
No. Signal Name Value Unit

1 Device status OnlLine

2 CCO net status networked

3 Device identification status Search complete

4 SNID 1

(L] noTE
You can click the  running Info. 4 o " ABOUE | (3 on the tertiary navigation menu to
query PLC-related information.

7.8.4.2 Setting the STA List

Because of permission restriction, log in as Advanced User. Choose Monitoring > PLC >
STA List and set Baud rate for the listed devices on the displayed page.
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Figure 7-21 Setting the STA list

Running Info. Eng‘ Networking Settings About
PLC ing status: ked of online STAs: 3
O No. MAC Address Device SN Comm Address Baud rat(
1 2¢:27 :d7 : 2f :b2 :01 40KTL{COM3-1) INV_2000V2R1C00_0001 1 115200
2 2¢:27 :d7 : 2f :b2 :02 40KTL(COM3-2) INV_2000V2R1C00_0002 2 115200
3 2¢:27 :d7 : 2f :b2 :03 40KTL{COM3-3) INV_2000V2R1C00_0003 3 115200

<
Sync. Baud Rates Export STA List

[ noTE
[ ]

The STA list displays information about the SUN2000 equipped with the PLC STA module that is
being connected.

e When changing the name of the exported file after the STA list is exported, retain the
extension .tar.gz. Otherwise, the file will be unusable.

7.8.4.3 Networking Settings

Because of permission restriction, log in as Advanced User. Choose Monitoring > PLC >
Networking Settings.
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Running parameters

Figure 7-22 Running parameters

Clan
m]

Ooooo

e |

Running Info. STA List Networking Settings About

® Running Param. O SN List

No. Signal Name Value Unit
1 Baud rate 9600 v

2 Anti-crosstalk Disable v

3 Network frequency band 2-12 (MHz) v

4 Box-type transformer No. 0 (0-511)

5 Winding Ne. 0 (0-7)

[l noTE

Baud rate is set to 115200 by default, which provides optimal communications performance and
does not need to be changed.

If Anti-crosstalk is set to Enable, the inverter with a PLC STA in the SN list can access networking.

Parameters Box-type transformer No. and Winding No. can be set for the PLC CCO with
SUN2000 V100R001C72SPC100 or later versions. In multi-split transformer scenarios, specify
Winding No. based on the actual winding number of the SmartLogger connected to the transformer.
When the box-type transformer and winding numbers of the inverter with an STA are consistent with
those of the PLC CCO, the inverter can access networking.
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SN List

Figure 7-23 SN list

Running Info. STA List Networking Settings About

) Running Param. © SN List

B No. SN Match Status Transformer No.  Winding No. Device Comm Address
a 1 210107250010F7002434
] 2 210107250010F7002435
| 3 210107250010F7002436
a 4 210107250010F7002437

[ noTE

e The SN list displays the relevant information of the inverters with PLC STAs that can be connected.

e Tap Synchronize, and synchronize the box-type transformer and winding numbers of the PLC CCO
to the inverter.

7.8.5 EMI
7.8.5.1 Querying Related Information

Choose Monitoring > EMI and query related information on the displayed page.
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Figure 7-24 Querying EMI-related information
Performance Data  About
No. Signal Name Value Unit
1 Daily irradiation amount NA kWh/mA2
2 Total irradiance NA W/mA2
3 PV module temperature NA degC
4 Ambient temperature NA degC
5 ‘Wind speed NA m/s
6 ‘Wind direction NA
(L] noTE
e Youcanclickthe . Running Info. 4 Performance Data  ,,  About .,
the tertiary navigation menu to query EMI-related information.
e EMI performance data can be stored for a month and exported. When changing the name of the
exported file, retain the extension .tar.gz. Otherwise, the file will be unavailable.
7.8.6 Power Meter

7.8.6.1 Querying Related Information

Choose Monitoring > Meter and query related information on the displayed page.
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Figure 7-25 Querying the meter information

¥ Running Info. Performance Data About

No. Signal Name Value Unit
1 Device status Online

2 Line voltage between phases A and B 0.00 v

3 Line voltage between phases B and C 0.00 v

4 Line voltage between phases C and A 0.00 v

5 Phase A current 0.0 A

6 Phase B current 0.0 A

7 Phase C current 0.0 A

8 Active power 0.000 kW
9 Reactive power 0.000 kVar
10 Active electricity 0.0 kWh
11 Power factor 0.000

[ noTE

e Youcanclick the _ Running Info. 4 Performance Data . About  pon
the tertiary navigation menu to query meter information.

e The performance data of the meter can be exported. When changing the name of the exported file,
retain the extension .tar.gz. Otherwise, the file will be unusable.

7.8.6.2 Setting Running Parameters

Because of permission restriction, log in as Advanced User. Choose Monitoring > Meter >
Running Param. to access the target page.

[ noTE

Set running parameters only for the power meter that supports the DL/T645 protocol.
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Figure 7-26 Setting running parameters

Running Info. Performance Data About

Clan No. Signal Name Value Unit
= 1 Protocol version DL/T645-2007 E
0 2 Number of lead bytes 4 (0-4)

7.8.7 PID
7.8.7.1 Querying Related Information

Choose Monitoring > PID and query related information on the displayed page.

L] noTE

This document describes the page displayed when the PIDO1 module is connected as an example.
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Figure 7-27 Querying PID module-related Information
Active Alarm Performance Data About 0 o

N T, I S TR N
= 0

=
oo

. Signal Name

Device status

Qutput voltage

Qutput current

Cabinet temperature

PV1 input voltage

PV2 input voltage

Line voltage between phases A and B
Line voltage between phases B and C
Line voltage between phases C and A
Grid frequency

Power grid imbalance

Voltage harmonic

[l noTE

e You can click the

Value
Running
380.0
50
233
7770
778.0
380.0
381.0
383.0
50.0
0.0
0.0

Running Info. 4 . Active Alarm

Unit

Performance Data

About

tab on the tertiary navigation menu to query PID module-related information.

e Performance data of the PID module can be exported. When changing the name of the exported file,

retain the extension .tar.gz. Otherwise, the file will be unavailable.

7.8.7.2 Setting Running Parameters

Because of permission restriction, log in as Advanced User. Choose Monitoring > PID >
Running Param. to access the target page.
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Figure 7-28 Setting running parameters
Running Info. ~Active Alarm  Performance Data BN L2YC L, About

Clai No. Signal Name Value Unit

O 1 Offset mode Disabled v

O 2 Output enabled Disable v

O PV type P-type v

O 4 Operation mode Normal v

m] 5 PV/PE offset voltage 00 0.0-200.0) v

m| 6 Maximum DC voltage NA (500-1500) v

O 7 Maximum output voltage 0 (0-500) v

O 8 IMD access Enable v

m] 9 Periodic PID runtime NA (60-480) min
jum| 10 Periodic IMD runtime NA (15-480) min

O 1 IMD control dry contact No v

Table 7-10 Parameter description

No. | Parameter | Function Parameter | Description
Name Value
1 Offset mode | Specifies the offset | Disabled Set this parameter to Disable if the PID module is
mode of the PID not required.
module. - - -

N/PE Set this parameter to N/PE if the PID module is
required to use voltage output from the inductor
virtual midpoint N.

PV/PE Set this parameter to PV/PE if the PID module is
required to use voltage output from the negative PV
terminal.

This mode is applicable only to SUN800O.

Automatic In the SUN2000, Automatic indicates the N/PE
offset mode.

2 Output Specifies whether | Enable Set this parameter to Enable to allow the PID
enabled the PID module module output.
output is enabled. - - - -

Disable Set this parameter to Disable to forbid the PID
module output.

3 PV type Specifies the type | P-type Select this value if the PV module type is P. In this
of the PV module case, the PID module output voltage is positive.
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No. | Parameter | Function Parameter | Description
Name Value
used in the power | n_tyne Select this value if the PV module type is N. In this
station. For details case, the PID module output voltage is negative.
about the PV
module type,
consult the
manufacturer.
4 PV/PE Specifies the DC 0-200V It is recommended that the offset voltage be set to a
offset volt. | voltage when the value ranging from 50 V to 200 V.
offset mode is set
to PV/PE.
5 Operation Specifies whether | Commissio | In commissioning mode, if you need to set the
Mode the PID module is | ning output mode to PV/PE or N/PE, set Output
currently working enabled to Enable. The PID module delivers output
in normal or voltages based on the value of Commissioning
commissioning output voltage.
mode. NOTE
To check whether the PID module functions properly, it is
recommended that Operation mode be set to
Commissioning upon first power-on.
Normal In normal mode, the PID module operates
automatically after the PID module, inverter, and
SmartLogger communicate with each other properly.
6 Commissio | Specifies the 0-500Vv It is recommended that the commissioning voltage
ning output | output voltage for the 1000 /1100 V inverter be set to a value
voltage when Operation ranging from 50 V to 400 V.
Mode is set to NOTE
Commissioning. After this parameter is set and the output from the PID
module becomes stable, use a multimeter that is set to the
DC position to measure the three-phase (A, B, and C)
voltages of the power grid to the ground, and check
whether the voltages are the same as the configured values.
7 Maximum Specifies the 500-1500 V | If the PV module type is P, the parameter value
DC voltage | PV-PE voltage indicates the highest DC voltage between PV+ and
when Operation PE. If the PV module type is N, the parameter value
Mode is set to indicates the highest DC voltage between PVV-and
Normal or PE.
Commissioning.
8 Maximum Specifies the 0-500V If the offset mode is PV/PE, the parameter value
output highest output indicates the highest DC output voltage between PV
voltage voltage of the PID and PE. If the offset mode is N/PE, the parameter

module when
Operation Mode
is set to Normal or
Commissioning.

value indicates the highest DC output voltage
between N and PE.
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No. | Parameter | Function Parameter | Description
Name Value
9 IMD access | Specifies whether | Enable Select Enable if you allow the PID module and IMD
the PID module operate in cycle mode.
and insulation Only the IMDs of mainstream suppliers such as
monitor device DOLD and BENDER are supported,and the IMDs
(IMD) can operate must have enabled dry contacts.
in cycle mode.
NOTICE
Only when IMD access is set to Enable, can you set
Periodic PID runtime, Periodic IMD runtime, and IMD
control dry contact.
Disable Select Disable if you forbid the access of IMDs.
10 | Periodic Specifies the 60-480 The IMD is shut down when the PID module is
PID runtime | operating time minutes operating.
segment of the PID
module when the
PID module and
IMD operate in
cycle mode.
11 | Periodic Specifies the 15-480 The PID module is standby when the IMD is
IMD operating time minutes operating.
runtime segment of the
IMD when the PID
module and IMD
operate in cycle
mode.
12 | IMD control | Dry contact No. DO1, DO2, | PIDO01: Set appropriate ports based on the cable
dry contact | over which the and DO3 connections between the IMD and the SmartLogger.
SmartLogger
controls the IMD
13 | Clear Data | Clears the active N/A You can select Clear Data to clear active alarms
alarms and and historical alarms for the PID module.
historical alarms
stored on the PID
module.

7.8.8 Custom Device

The SmartLogger can connect to third-party devices supporting the Modbus-RTU protocol,
such as the box-type transformer and EMI. Since the protocol specifications vary depending
on vendors, you need to obtain a protocol specifications file in .cfg format from Huawei and
import the file into the SmartLogger for successfully connecting to a third-party device.

[ noTE
[ )

Custom devices cannot be detected automatically and need to be added manually. For details, see
7.11.8.1 Connecting Devices.

e The SmartLogger can connect to a maximum of five types of custom devices and can connect to

multiple devices of the same type.
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7.8.8.1 Querying Related Information

Select a custom device on the Monitoring page and query its information on the displayed
page.

Figure 7-29 Querying custom device-related information

Teleindication Telemetering Telecontrol Teleadjust
No. Signal Name Value Unit
1 SN CT02311HJBO0GB001486
2 Port number 6
3 Comm Address 1
4 Logical address 146
5 Device status Online
[LInoTe

You can click the __Running Info. 4 | Teleindication .~ Telemetering 35 on the
tertiary navigation menu to query custom device-related information.

7.8.8.2 Setting Telecontrol Parameters

Select the customized device to be set on the Monitoring screen and choose Telecontrol.
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Figure 7-30 Setting telecontrol parameters

Running Info. indicati il Telecontrol Teleadjust
All No. Signal Name Value Unit
1 Power-On 0
2 Power-Off 0
(o

“ 41 1)1 Page | |9

7.8.8.3 Setting Teleadjust Parameters

Select the customized device to be set on the Monitoring screen and choose Teleadjust.

Figure 7-31 Setting teleadjust parameters

Running Info. Teleindication Telemetering Telecontrol Teleadjust

Clan No. Signal Name Value Unit
0 1 Protec. OV niveau-1 0
0 2 Durée protec. OV niv.1 0
“1rw 1/1pge| Y
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7.9 Querying Historical Data
7.9.1 Querying Historical Alarms

Choose Query > Alarm History and query alarms on the displayed page.

Figure 7-32 Historical alarms

Alarm History
Device  Logger{Local) Estaﬁtime 2016-02-14 End time 2017-02-14
Sorting mode | Time El

Number of qualified operation logs: 0
No. Alarm ID Severity Device Alarm Name Generation time

3
441 rm 1/1 Page |

7.9.2 Querying Operation Logs

Because of permission restriction, log in as Advanced User or Special User. Choose
Query > Operation Log and query logs on the displayed page.

Issue 10 (2017-08-30) Huawei Proprietary and Confidential 212
Copyright © Huawei Technologies Co., Ltd.



SmartLogger1000
User Manual 7 WebUI

Figure 7-33 Operation log

Operation Log

Number of qualified operation logs : 175

No. User Name Operation Time Operation Source Content
1 Advanced User 2017-02-14 06:56:40 WEB Login IP: 192.168.0.2
2 Special User 2017-02-14 06:56:33 WEB Logout IP: 192.168.0.2
3 Special User 2017-02-14 06:55:13 WEB Login IP: 192.168.0.2
4 Advanced User 2017-02-14 06:54:53 WEB Logout IP: 192.168.0.2
5 Advanced User 2017-02-14 06:53:22 WEB Login IP: 192.168.0.2
6 Special User 2017-02-14 08:53:15 WEB Logout IP: 192.168.0.2
7z Special User 2017-02-14 06:41:20 WEB Login IP: 192.168.0.2
8 Advanced User 2017-02-14 00:41:14 WEB Logout IP: 192.168.0.2
9 Advanced User 2017-02-14 06:31:35 WEB Login IP: 192.168.0.2
10 Advanced User 2017-02-14 06:31:35 WEB Logout: due to user login
11 Advanced User 2017-02-14 06:30:43 WEB Login IP: 192.168.0.1
12 Advanced User 2017-02-14 06:30:43 WEB Logout: due to user login
13 Advanced User 2017-02-14 06:26:39 WEB Local Time:2017-02-13 06:26:46->2017-02-14 06:26:39
14 Advanced User 2017-02-13 06:18:58 WEB Add Meter(COM4-1)
15 Advanced User 2017-02-13 06:18:38 WEB Logger(Local)-End address->247
16 Advanced User 2017-02-13 06:18:37 WEB Logger(Local)-Start address->1
17 Advanced User 2017-02-13 06:18:37 WEB Logger(Local)-Baud rate->39600
18 Advanced User 2017-02-13 06:18:37 WEB Logger(Local)-Parity->None
19 Advanced User 2017-02-13 06:18:37 WEB Logger(Local)-0x2556- > Modbus
20 Advanced User 2017-02-13 06:18:37 WEB Logger(Local)-End address->247

4“4 1 rmw 1/9 Page

7.9.3 Exporting Data

Because of permission restriction, log in as Advanced User or Special User. Choose
Query > Export Data and export data on the displayed page.

Figure 7-34 Exporting data

Export Data

©) Alarm History ) Yield ) Operation Log ) Grid scheduling ) Al

Log archiving

L] noTE

When changing the name of the exported file, do not change the file name extension. Otherwise, the file
may be unavailable.
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Opening the Exported File

The exported file is in CSV format and can be opened in Excel. After opening the file in Excel,
the cells may not be neatly organized. Set List separator to ,.

To view and change the list separator, perform the following steps:

1.  Open Control Panel and choose Region and Language.
2. Under Formats, click Additional settings.

Figure 7-35 Viewing and changing the list separator (1)

D Region and Language J - ﬂ
[ Formats " Location I Keyboards and Languages I ﬂdm\msﬂatnrel
Format:
[Eng\ish (America) v]
Change serting method
Date and time formats
Short date: led‘rm ']
I
Long date: [dddd, MMMM dd. yyyy -
Short time: [h:mm tt vI
Long time: [h:mrn:ss t "]
il First day of week: [Sunday ']
i What does the notation mean?
Examples
I Short date: 6/25/2016
Long date: Saturday, June 25, 2016
Short time: 8:31 PM
Long time: 8:31:10 PM
i —
I l Additional settings... ]
Ge online to learn about changing languages and regional formats

3. View and change the list separator.
- If List separator is ,, click OK.
- If List separator is not ,, change it to ,, and click OK.
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Figure 7-36 Viewing and changing the list separator (2)

¥ Customize Format @‘
Mumbers ‘CurrencyI I Time I Date | Sarﬁngl
Example
Positive:  123,456,783.00 Negative:  -123,456,789.00
Decimal symbel: ] -
Mo. of digits after decimal: [2 v]
Digit grouping symbaol: . -
Digit grouping: (123,456,789 -
Megative sign symbol: - A
MNegative number format: [-1.1 v]
Display leading zeros: ["." ']
List separator: [, - ]
Measurement system: [ Metric - ]
Standard digits: [015456789 N ]
I Use native digits: INe\rEr 'I
Click Reset to restore the system default settings for
numbers, currency, time, and date.

7.10 Settings

7.10.1 User Parameters

7.10.1.1 Setting the Date and Time

Because of permission restriction, log in as Common User or Advanced User. Choose
Settings > Date&Time to access the target page.
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Figure 7-37 Setting the date and time

Time Zone

Local time zone (UTC+08:00)Beijing

=

Date

Time [15:13:36 HHMM:SS

=
Time Synchronization

Clock source [ NetEco v

Date  |2017-04-10 MDD

A NOTICE

The Local time zone parameter is unavailable for zones without DST.

e After Date&Time is set, the date and time of all the inverters connected to SmartLogger

are updated accordingly. Ensure that the settings are correct.

e Modification of Date&Time may affect the recording of energy yield and performance

data. Therefore, do not change the time zone or system time arbitrarily.

7.10.1.2 Setting Plant Information

After you set plant information, a plant configuration file can be generated. You can upload

this file to a third-party hosting website to implement remote monitoring.

Because of permission restriction, log in as Common User or Advanced User. Choose

Settings > Plant to access the target page.
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Figure 7-38 Setting plant information

Plant Info.

Plant name

Plant address

\ |
\ |
Plant owner ‘ |
Plant owner address ‘ |

CN(China, People's Republic of) :

Country

(1) noTE

When setting plant information, you cannot successfully enter any character such as
<>:,""?()#&\$|%+;~"" in the English half-width status.

7.10.1.3 Setting Gain Parameters

Because of permission restriction, log in as Common User or Advanced User. Choose
Settings > Revenue to access the target page.

Figure 7-39 Setting gain parameters

| Gain Parameters

|

Currency  |FUR
Electricity prce/ W ©000-999.959)
(€02 emission reduction coefficient kg/k\Wh (0.000~10.000)
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[l noTE
Electricity price/kWh indicates the local power price, and is used to calculate the translation gain of the
energy yield.

7.10.2 Communications Parameters

7.10.2.1 Setting Ethernet Parameters

Because of permission restriction, log in as Advanced User. Choose Settings > Ethernet to
access the target page.

Figure 7-40 Setting Ethernet parameters

Auto obtain IP
Auto obtain IP Disable (configurable on the LCD)
IP address
IPaddress 192168, 0, 12
Subnet mask 255,255 255, O
Default gateway 192 168, 0, 1
DNS Server Address
Primary DNS server 192 168, 0, 1
Secondary DNS server 0 0 0 ©

=n

/\ nomce

If the SmartLogger connects to the Internet through a router, note the following when setting
Ethernet parameters:

e Set the gateway address to the IP address of the router.

e Ensure that the IP address of the SmartLogger is in the same network segment as the
gateway address.

e Set the domain name server (DNS) address to the IP address of the router or obtain the
DNS address from the network provider.

L] noTE

If the IP address is changed, you need to use the new IP address to log in to the system.

7.10.2.2 Setting RS485 Parameters

Because of permission restriction, log in as Advanced User. Choose Settings > RS485 to
access the target page.

Issue 10 (2017-08-30) Huawei Proprietary and Confidential 218
Copyright © Huawei Technologies Co., Ltd.



SmartLogger1000

User Manual 7 WebUI
Flgure 7-41 RS485 parameters
RS485
R5485 Protocol Parity Baud rate Start address End address
RS485-1 Modbus V| Nene v [s600 M jem 247 o
RS485-2 Modbus v| [None v] [ss00 M e 247 Jaaew
R$485-3 Modbus v| [None ] [9600 ML e 247 1-247,
oo |
Night Comm. Settings
Night silent | Disable v
Enter time |18:00 HH:MM
Bxittime  |05:00 HH:MM
Wakeup period -viw;-::rim-:-'
oot

L] noTE

RS485-1 to RS485-3 correspond to the communications ports COM1 to COM3, and the default
baud rate is 9600 bps. The baud rates for devices connected to the same RS485 port must be the
same.

Set the protocol supported by the RS485 port based on either the protocol supported by the
connected device or the status of the device in the network. When the SmartLogger serves as a slave
node to interconnect with a third-party device over Modbus-RTU, set Protocol to Modbus-Slave.
When the connected SUN2000 performs rapid power grid scheduling using both PLC and RS485,
set Protocol to Modbus-Control.

Protocol and Parity must be set to the same values for all devices connected to the same RS485
port.

1 < start address < end address < 247. The address segments for each RS485 port from RS485-1 to
RS485-3 can overlap.

Set the address range as required. A larger address range requires a longer searching time. The start
and end addresses have no impact on the devices that have been connected.

7.10.2.3 Setting EMI Parameters

The SmartLogger can connect to an EMI that supports the standard Modbus-RTU/RS485
protocol. One SmartLogger can connect to and manage only one EMI.

Devices from different vendors may support different protocol specifications. To normally
obtain information from the connected EMI, correctly configure the protocol specifications
over the SmartLogger WebUI based on the protocol specifications delivered by the vendor.

After the SmartLogger connects to the EMI, manually add the device. For details, see 7.11.8.1
Connecting Devices. Device Type should be set to EMI.

Devices from different vendors may support different protocol specifications. To normally
obtain information from the connected EMI, correctly configure the protocol specifications
over the SmartLogger WebUI based on the protocol specifications delivered by the vendor.
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Because of permission restriction, log in as Advanced User. Choose Monitoring > EMI and

set EMI parameters.

e If you use a specific model of EMI, select the model from the drop-down list box.

Figure 7-42 EMI (1)

Environmental Monitoring Instrument
EMI model

Synchronize Environment Data

L] noTE

|ABB VSN800-14
Hukseflux SRx
Kipp&Zonen SMPx
Lufft WSx-UMB

Meteo control SR20-D2
Rainwise PVmet-150
Rainwise PVmet-200
Jingzhou Yangguang(PC-4)
Handan(RYQ-3)

Sensar (ADAM)

Other

Lufft WSx-UMB(exteral sensors)

Synchronize Environment Data: If Enable is selected, wind speed and direction data will be sent to
the inverter in a PV plant with the tracking system.

e If you use a split EMI that is connected through an analog-to-digital converter, choose

Sensor (ADAM) from the drop-down list box.

Figure 7-43 EMI (2)

Environmental Monitoring Instrument
EMI model
Synchronize Environment Data

Read function code

Sensor (ADAM)
Disable
Read holding register 03H

[l [ [<] [<«] [<] [<]

Jio-ess25

Ji0-65535

Data report mede  |Integer
Word ordering  [Big endian
Read mode | Multiple read
Start address [0
End address [
No.  Signal Name Signal address Lower Thres. Upper Thres.
1 Total irradiance [ ] oo | [0 |
L 2 Ambient temperature [t | [oo | oo |
3 PV module temperature [2 | [oo | Joo |
) Wind direction [6 ] oo | [0 |
B Wind speed B | [oo | oo |

=

Spec
0-20mA
0-20mA
0-20mA
0-20mA
0-20mA

M
M

™M
™

Start (mV/mA)

End (mV/mA)

[o0

[200

| |
[00 | [200 |
[00 | [200 |
[o0 | [200 |
[00 | [200 |
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(L] noTE

Correctly set the parameters in accordance with the Modbus parameters provided by the EMI
manufacturers. Otherwise, the EMI data cannot be successfully read.

e Synchronize Environment Data: If Enable is selected, wind speed and direction data will be sent
to the inverter in a PV plant with the tracking system.

e Set Read Mode based on the mode supported by the EMI.

If Multiple read is selected, set Start address and End address based on the acquired Modbus
signal address range on the EMI.

o If the EMI can collect a certain signal, set Signal address for the signal to the corresponding register
address. If the EMI cannot collect a certain signal, set Signal address for the signal to 65535.

® |f you use any other model of EMI, select Other from the drop-down list box and set the
EMI parameters.

Figure 7-44 EMI (3)

Environmental Monitoring Instrument
EMI model  |Other
Synchronize Environment Data | Disable
Read function code  |Read holding register 03H
Data report mode  |Integer

Word ordering  [Big endian

[ [ <] [<]

Read mode  |Multiple read

Start address [0

End address  [8

No. Signal Name Signal address Gain Offset
Total irradiance

Ambient temperature

PV module temperature
Wind direction

Wind speed

TSN NEN

K[ [€]

=

L] noTE

Correctly set the parameters in accordance with the Modbus parameters provided by the EMI
manufacturers. Otherwise, the EMI data cannot be successfully read.

e Synchronize Environment Data: If Enable is selected, wind speed and direction data will be sent
to the inverter in a PV plant with the tracking system.

e Set Read Mode based on the mode supported by the EMI.

If Multiple read is selected, set Start address and End address based on the acquired Modbus
signal address range on the EMI.

e If the EMI can collect a certain signal, set Signal address for the signal to the corresponding register
address. If the EMI cannot collect a certain signal, set Signal address for the signal to 65535.

7.10.2.4 Setting Power Meter Parameters

Because of permission restriction, log in as Advanced User or Special User. Choose
Settings > Power Meter to access the target page.
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Power Meter Without Feedback of Grid Connection Data

If a power meter connected in the PV plant does not need to provide feedback of the grid
connection data, set Meter feedback output to Disable.

®  \When the model of the connected power meter is UMG604, PD510, or PZ96L, select
the model in the drop-down list box of Intelligent Power Meter Type.

®  \When the model of the connected power meter is any other one, select Other from the
drop-down list box of Intelligent Power Meter Type and then set related parameters.

Figure 7-45 Power meter

Power Meter Param. Settings(Modbus-RTU)
Intelligent Power Meter Type | Other
Read function eode | Read holding register 03H
Read mode | Multiple read
Data reporting mode | Floating peint
Meter feedback output | Disable
Start address 19000
End address 19099

Voitage change ratio |1

Current change ratio |1

Ne. Signal Name Signal address Number of Registers Gain

1 Phase A voltage 19000 2 10
2 Phase B voltage 19002 2 10
3 Phase C voltage 19004 2 10
4 A-B line voltage 19005 2 10
5 B-C line voltage 19008 2 10
6 C-Aline voltage 19010 2 10

Phase A current 19012 2 10
8 Phase B current 19014 2 10
9 Phase C current 19016 2 10
10 Active power 19026 2 10
1 Reactive power 19042 2 10
12 Active electricity 19060 2 10
13 Reactive electricity 19092 2 10
14 Power factor 65535 2 10
15 Apparent power 19034 0-65535, 2 10

Power Meter with Feedback of Grid Connection Data

If a power meter connects to the PV plant and the power meter needs to report the data at the
grid-connected point through the AO port on the SmartLogger, the primary SmartLogger
needs to expand the Al/AO port by connecting to an ADAM. After correctly configuring
expanded ports (see 7.10.6 Setting Extended Ports for details), set Meter feedback output to
Enable and set the parameters for each port as required.
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Figure 7-46 Setting parameters for grid connection data feedback

Power Meter Param. Settings(Modbus-RTU)

Intelligent Power Meter Type | UMG604

H

Meter feedback output [T -

Feedback GCP Param. Settings

port
AO1
AO2
AO3
AO4

Feedback Parameter Start Current (mA) End Current (mA) Start Data
No E 4.000 (0-20) 20.000 (0-20) 0.000
No E 4.000 20.000 (0-20) 0.000
No E 4.000 20.000 (0-20) 0.000
No E 4.000 (0-20) 20.000 (0-20) 0.000

L] noTE

Start current and End current indicate the valid value range of signals carried by the analog output
loop. The current range is less than or equal to the current range specified in the AO specifications.

Start Data corresponds to End Data.

End Data
0.000
0.000
0.000
0.000

Unit

Start Data and End Data are the valid signal value range of the selected Feedback Parameter. Set
the two parameters based on site requirements. An excessive range results in low precision of the

feedback while an insufficient range results in the incompleteness of the feedback.

Unit is the unit for the selected Feedback Parameter. When setting Start Data and End Data, note

the unit selected. Otherwise, false input and output may be generated.

7.10.2.5 Setting NetEco Parameters

To set parameters correctly, ensure that the SmartLogger can connect to the Huawei NMS
such as NetEco and FusionSolar, or a third-party NMS.

You need to log in as Advanced User that has the permission to set the parameters. Choose
Settings > NetEco to enter the page.
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Figure 7-47 Setting NetEco parameters

NetEco
NetEco server
Port number
Address mode
SSL encryption

Second challenge authentication

Security Certificate
Upload CA certificate file
Upload local certificate file

Upload key file

16100 (1~65535)

Logical address ﬂ

Enable ﬂ

Disable v
Browse
Browse
Browse

[JEnable key password

=

=
=
=
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e Set NetEco server to the IP address or domain name of the NetEco server.

e When the SmartLogger connects to the Huawei NMS, retain the default value 16100 for Port
number. When the SmartLogger connects to the third-party NMS, set Port number according to
the server port enabled in a third-party NMS.

e |n most cases, set Address mode to Comm. Address. If the devices connected to the three RS485
ports of the SmartLogger have duplicate addresses, you must set Address mode to Logical address.

e If SSL encryption is set to Disable, data will be transmitted without being encrypted, which may
result in user data theft. Therefore, exercise caution when deciding to set SSL encryption to

Disable.

7.10.2.6 Setting Modbus TCP Parameters

Set Modbus TCP parameters for the SmartLogger to communicate with a third-party NMS.

Because of permission restriction, log in as Advanced User. Choose Settings > Modbus
TCP to access the target page.
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Figure 7-48 Setting Modbus TCP parameters

Modbus TCP

Link setting Enable(Limited) ﬂ

Client 1 IP Address 10_ 142 57_ 148

Client 2 IP Address 0, 0, 0, o

Client 3 IP address 0. 0. 0. 4]

Client 4 IP address 0. 0, 0. [¢]

Client 5 IP address 0. 0, 0. [¢]
Address mode  |Comm. Address ﬂ

SmartLogger address l:l‘}:—‘ﬁ

(L] noTE

e Modbus TCP is a general standard protocol without a security authentication mechanism. To reduce
network security risks, the function of connecting to a third-party NMS using Modbus TCP is
disabled by default. To use this function, set Link setting to Enable(Limited) or
Enable(Unlimited). If you select Enable(Limited), the SmartLogger can communicate with up to
five third-party NMSs whose IP addresses are set under Modbus TCP. If you select
Enable(Unlimited), the SmartLogger can communicate with all third-party NMSs with valid IP
addresses.

o If the function of connecting to a third-party NMS using Modbus TCP is enabled, data will be
transmitted without being encrypted, which may result in user data theft. Therefore, exercise caution
when deciding to enable this function.

e In most cases, set Address mode to Comm. Address. If the devices connected to the COM ports of
the SmartLogger have duplicate communications addresses, you must set Address mode to Logical
address.

7.10.2.7 Setting IEC103 Parameters

Third-party devices that use the standard IEC103 interface protocol may be connected to a PV
plant. The SmartLogger can read the information about such third-party devices and upload
the information to the NetEco, thereby enhancing the PV plant solutions.

As Huawei inverter devices (such as SUN2000s) support protocols different from third-party
devices that use standard IEC103 (such as box-type transformers, combiner boxes, and
inverters), they cannot be connected in series on the same RS485 bus.

If the SmartLogger connects to the NetEco, it transparently transmits IEC103 device
information to the NetEco.

Because of permission restriction, log in as Advanced User. Choose Settings > IEC103 to
access the target page.
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Figure 7-49 Setting IEC103 parameters

IEC103
IEC103 port No.  |No [=]
IEC103 address 126 (1-255)

IEC103 IP 0, 0, 0, O

i |

[ NnoTE

e Standard IEC103 is a general standard protocol without a security authentication mechanism. To
reduce network security risks, the function of connecting to a third-party NMS using IEC103 is
disabled by default. To use this function, set Link setting to Enable.

e Third-party devices and Huawei devices must be connected to different ports of the SmartLogger.
Otherwise, the communication will be abnormal.

e The value of IEC103 IP must be consistent with the NetEco IP address.

7.10.2.8 Setting IEC104 Parameters

If the SmartLogger connects to a third-party NMS over the IEC104 protocol, IEC104
parameters must be correctly set to enable the third-party NMS to monitor the running status
of devices connected to the SmartLogger.

Because of permission restriction, log in as Advanced User. Choose Settings > IEC104 to
access the target page.
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Figure 7-50 Setting IEC104 parameters

@ Basic parameters () Transfer table configuration

IEC104 Parameter Settings
Link setting Enable(Limited) El
IEC104-11P
IEC104-21P
IEC104-3 1P
IEC104-41P

2L el
Lelee|lele
Lelee|lele
ol o o o o

[EC104-51P
PublicIP address 1 1-65534

Teleindication default segment 50

Telemetry default segment 50 (
Control mode | Control after se\e

=n
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e |EC104 is a general standard protocol without a security authentication mechanism. To reduce
network security risks, the function of connecting to a third-party NMS using IEC104 is disabled by
default. To use this function, set Link setting to Enable. To use this function, set Link setting to
Enable(Limited) or Enable(Unlimited). If you select Enable(Limited), the SmartLogger can
communicate with up to five third-party NMSs whose IP addresses are set under IEC104. If you
select Enable(Unlimited), the SmartLogger can communicate with all third-party NMSs with valid
IP addresses.

e You can click the Select icon in the upper left corner of the page to access the required setting page.
e You can export an IEC104 configuration file in CSV format.

After the IEC104 configuration file exported from the SmartLogger and the device type IEC104
information files delivered with devices are correctly configured on a third-party NMS, the
third-party NMS will be able to monitor the devices connected to the SmartLogger over the IEC104
protocol.

7.10.3 Extended Parameters
7.10.3.1 Setting FTP Parameters

The FTP function is used to access a third-party NMS. The SmartLogger can report the
configuration information and running data of the managed plant system through FTP. A
third-party NMS can access Huawei devices after being configured.

Because of permission restriction, log in as Advanced User. Choose Settings > FTP to
access the target page.
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Figure 7-51 Setting FTP parameters

Basic parameters

FTP server
User name
Password

Remote directory

Report Settings

Latest Report Status

[ no

Data export  Disable
FTP file format  |Format 1 El
Export mode Cyclic El
Export interval 30 min (5~1440)
File mode | Accumulated data El
Transfer status ~ Success
Last transmission ~ 2000-01-01 00:00:00
Suomit | St roport s

TE

FTP server can be set to the domain name or IP address of the FTP server. If FTP server is set to
the domain name of the FTP server, ensure that the address of the DNS server on the Ethernet page
is set correctly.

User name and Password indicate the user name and password that need to be entered when you
log in to the FTP server.

After setting Remote directory, you can create a subdirectory in the default data upload directory
(specified by the FTP server).

If Data export is set to Enable, you can set the SmartLogger to report data regularly or at a
specified time. If you set the SmartLogger to report data regularly, you can choose whether to report
all data or only the incremental data of a day each time.

In FTP file format, the Format 2 file contains two more information points than the Format 1 file,
namely, E-Day (energy yield of current day) and E-Total (total energy yield).

7.10.3.2 Setting Email Parameters

The SmartLogger can send emails to inform users of the energy yield, alarm, and equipment
status information of the PV plant system, helping users to know the running conditions of the
PV plant system in time.

When using this function, ensure that the SmartLogger can be connected to the configured
email server and that the Ethernet parameters and email parameters for the SmartLogger are
correctly set. Ensure that no password is set between the SmartLogger and the email server.

Because of permission restriction, log in as Advanced User. Choose Settings > Email to
access the target page.
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Figure 7-52 Setting email parameters

Basic parameters
SMTP server
User name
Password

SMTP port 25

Email language English El
Send address
Receive address 1
Receive address 2
Receive address 3
Receive address 4
Receive address 5
Yield
Send Email | Disable =]
Senton schedule | 22:00 (HH:MM)
Alarms
Send Email  |Disable [=]
Alarm level Major El
Latest Report Status
Transfer status ~ Success
Last transmission ~ 2000-01-01 00:00:00

L] noTE
[ ]

SMTP Server can be set to the domain name or IP address of the SMTP server.

If it is set to the domain name of the SMTP server, ensure that the address of the DNS server is set
correctly.

e SMTP Port specifies the port used for sending emails.

e User name and Password specify the user name and password used for logging in to the SMTP
server.

e Send address specifies the sender's email address. Ensure that the sender's email server is the same
as the server specified by SMTP server.

e You can click Send test mail to check whether the SmartLogger can successfully send emails to
users.

7.10.4 Port Settings
7.10.4.1 Setting DO Parameters

This topic describes how to set DO configuration parameters for resetting an external 3G
router over the WebUI.

Context

The SmartLogger provides three DO ports. You can connect one DC power cable of the 3G
router to one DO port of the SmartLogger in series and power on or off the wireless module
by disconnecting or connecting the DO dry contact to control the reset of the 3G router.

Considering the restrictions on the current that can pass the DO port of the SmartLogger, you
need to determine the number of DO ports to be used for the control based on the maximum
power supply current of the 3G router (the maximum power supply current can be calculated
based on the maximum power consumption and DC power supply voltage).

®  When the power supply current is smaller than 1 A, use one DO port.
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®  When the power supply current is larger than 1 A but smaller than 1.6 A, use two DO
ports.

®  When the power supply current is larger than 1.6 A but smaller than 2.4 A, use three DO
ports.

®  \When the power supply current is larger than 2.4 A, access is not allowed because the
current exceeds the upper limit.

Connecting a 3G Router to the SmartLogger Over a DO Port

Before connecting a 3G router to the SmartLogger, cut off a DC power cable of the connector,
and then connect the cable cut to the DO port on the SmartLogger.

®  Figure 7-53 shows the connection when one DO port is used.

Figure 7-53 Connecting one DO port

1 -

Adapter 3G Router
DC Power Cable

1L01IC3007

®  Figure 7-54 shows the connection when two DO ports are used.
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Figure 7-54 Connecting two DO ports
AC Input
Adapter 3G Router
DC Power Cable
ILO11C3008
®  Figure 7-55 shows the connection when three DO ports are used.
Figure 7-55 Connecting three DO ports
AC Input
Adapter 3G Router
DC Power Cable
IL0O1IC3009
DO Configuration
After connecting the 3G router to the SmartLogger properly, you can set DO configuration
parameters over the WebUI to make the external 3G router automatically reset if the
SmartLogger fails to connect to the NetEco, email server, or FTP server within 30 minutes.
Because of permission restriction, log in as Advanced User. Then choose Settings > DO.
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Figure 7-56 DO configuration

DO Configuration
DOl  Reset the external router ~
Do2 No control v

DO3 No control M

[ |
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Set DO1, DO2, and DO3 to Reset the external router or No control based on the connections between
the router and the three DO ports of the SmartLogger.

7.10.4.2 Setting USB Parameters

This topic describes how to set USB parameters for resetting an external 3G router over the
WebUI.

Context

The SmartLogger provides a USB port, which has a power capacity of 5 V/1 A. If the DC
power cable of the 3G router has a standard USB connector and has a maximum current of
less than 1 A, it can directly connect to the USB port on the SmartLogger. Hence the
SmartLogger can power on or off the 3G router, which allows the SmartLogger to control the
reset of the 3G router when the communication link is interrupted.

/\ orce

e Only the SmartLoggers in versions later than V100R001C90SPC300 enjoy this function.

o |f the maximum working current of the 3G router is greater than 1 A, it cannot be
connected over a USB port.

Connecting a 3G Router over a USB

Connect the USB connector of the DC power cable of the 3G router to the USB port on the
SmartLogger, as shown in Figure 7-57.
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Figure 7-57 Connecting the 3G router and the SmartLogger

3G Router

ILO1IC3011

USB configuration

After connecting the 3G router to the SmartLogger properly, you can set USB configuration
parameters over the WebUI to make the external 3G router automatically reset if the
SmartLogger fails to connect to the NetEco, email server, or FTP server within 30 minutes.

Because of permission restriction, log in as Advanced User. Then choose Settings > USB.

Figure 7-58 USB configuration

USB configuration

UsB No control M

=
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7.10.5 Alarm Output

After an inverter alarm is linked to a DO port, the alarm signal is delivered from the DO port
when the inverter generates the alarm.

Because of permission restriction, log in as Advanced User. Choose Settings > Alarm
Output.

L] noTE

Before linking an inverter alarm to a DO port, ensure that the DO port is not set for other purposes.

Otherwise, the setting will fail.

if the SmartLogger restarts or powers off.

Figure 7-59 Alarm output

DO Configuration

No. Alarm Name Dol Do2

DO1 alarm status Close

DO2 alarm status Close

[ EE]

DO3 alarm status | Close

=3

High String Voltage
Abnormal DC Circuit
Abnormal Invert Circuit
Abnormal Grid Voltage
Abnormal Grid Frequency
Low Insulation Resistance
Abnormal Residual Current
Cabinet Overtemperature
Abnormal SPI Communication
Abnormal Grounding
System Fault

Abnormal Auxiliary Power
AFCI Self-Check Failure
DC Arc Fault

Abnormal PV String Connection

Cnfhuwara Varcinn | lnmateh

Table 7-11 Mapping between alarm names and inverter alarms

After the function is enabled, the DO port status may change and the alarm output may be abnormal

Do3

No. Alarm Name

Inverter Alarm | No. Alarm Name

Inverter Alarm

1 High String e High String 2 Abnormal DC Circuit Abnormal DC Circuit

Voltage Voltage
¢ High DC Input
Voltage

3 Abnormal Invert | Abnormal Inv. 4 Abnormal Grid Voltage | Abnormal Grid Voltage
Circuit Circuit

5 Abnormal Grid Abnormal Grid 6 Low Insulation Low Insulation
Frequency Freq. Resistance Resistance

7 Abnormal Abnormal 8 Cabinet Overtemperature
Residual Current | Residual Current Overtemperature
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No. Alarm Name Inverter Alarm | No. Alarm Name Inverter Alarm
9 Abnormal SPI Abnormal SPI 10 Abnormal Grounding Abnormal Grounding
Communication Communication
11 System Fault System Fault 12 Abnormal Auxiliary Abn. Auxiliary Power
Power
13 AFCI Self-Check | AFCI Self-Check | 14 DC Arc Fault DC Arc Fault
Failure Failure
15 Abnormal PV Abnormal PV 16 Software Version Software Ver. Unmatch
String Connection | String Connection Unmatch
17 Upgrade Failed Upgrade Failed 18 License Expired License Expired
19 String Reverse e String 20 String Backfeed e String Backfeed
Connection Reversed e String 1-8 Reversed
e String 1-8
Reversed
21 Abnormal String | © Abnormal 22 Phase Wire Phase Wire
Power String Power Short-Circuited to PE Short-Circuited to PE
e Abnormal
String 1-8
23 Grid Loss Grid Failure 24 Grid Undervoltage Grid Undervoltage
25 Grid Overvoltage | Grid Overvoltage | 26 Grid Voltage Imbalance | Grid Voltage Imbalance
27 Grid Grid 28 Grid Underfrequency Grid Underfrequency
Overfrequency Overfrequency
29 Unstable Grid Unstable Grid 30 Output Overcurrent Output Overcurrent
Frequency Frequency
31 Output DC Output DC 32 Device Fault Device Fault
Component Component
Overhigh Overhigh
33 Faulty Power Faulty Power 34 Abnormal Battery Abnormal Battery
Collector Collector
35 Faulty Monitoring | ® Monitoring 36 Active Islanding Active Islanding
Unit Unit Faulty
* Flash Fault
37 Passive Islanding | Passive Islanding | 38 Transient AC Transient AC

Overvoltage

Overvoltage

7.10.6 Setting Extended Ports
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Before setting extended ports, ensure that the SmartLogger connects to an analog-to-digital
converter (for example, ADAM4117) that supports the Modbus-RTU protocol.

Because of permission restriction, log in as Special User. Choose Settings > Extended Port
Settings to access the target page.

Figure 7-60 Setting extended ports

Port d'expansion AL

No. Port 485Port 485Address Register Address Port Specifications

1 Az [0 fo-30Disabl 247 o-m 5 Jo-m (0-20mA) v
2 A4 [0 fo-30Disabl 247 (0~247 B Jom (0~20mA) v
AQ Expansion Port

No. Port 485Address Register Address Port Specifications

1 A0L 247, L Je-m (0~20mA) V]
2 A02 247 B Jom (0~20mA) &
3 AD3 247 B Jom ©0~20mA) V]
4 AO4 ~247) B Jom (0~20mA) v
5 A0S 247 (0~247 [E (0~20mA) v

7.10.7 Dry contact remote shutdown

You can remotely shut down dry contacts on the WebUI.

The SmartLogger provides eight DI ports, that is, DI1 (GND1) to DI4 (GND1) and DI1
(GND2) to DI4 (GND2). The OVGR can be connected to any DI port, as shown in Figure
7-61.
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Figure 7-61 Networking

|_|

SmartLogger | D

RS485

Figure 7-62 shows the DI ports of the SmartLogger.

Inverter 1

Inverter 2

Inverter n

Inverter 1

—{AC Combiner Box 1}—

Inverter 2

Inverter n

Inverter 1

Dry Contact Signal

OVGR

—{AC Combiner Box 2}

Inverter 2

W Wi

—‘AC Combiner Box n}—

-
Inverter n

!

Figure 7-62 DI ports of the SmartLogger

r

|
GND1 1

DI

|
3 4 GND2

“/

2
L2 §

ILO1WCQ008

Table 7-12 describes the DI ports.

Table 7-12 DI port description

(O—

Cubicle

— Grid

ILO1IC3020

Port

Functions

GND1

Dry contact input common terminal 1, used for active
power derating for DI11-Dl14

DI_1

DI_2

DI_3

Al W | DN|PF

DI_4
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Port Functions
GND2 Dry contact input common terminal 2, used for reactive
power compensation for DI1-DI14

/\ orce

Before setting the function of remote shutdown over dry contacts in the following method,
ensure that Dry contact remote control is not set in 8 Power Grid Scheduling.

On the Settings tab page, select Dry Contact Remote Shut and set relevant parameters, as
shown in Figure 7-63. Because of permission restriction, log in as Special User.

Figure 7-63 Dry contact remote shutdown

Dry Contact Remote Shutdown

connection port  None T
Effective dry contact status Open M
OVGR Shutdown Setting  Disable M

Cubicle alarm enabling Disable v

=

[ no

TE

The OVGR sends dry contact signals and can be connected to any DI port of the SmartLogger. Set
related parameters based on the actual connection between the OVGR and the SmartLogger.
Otherwise, the dry contact remote shutdown function cannot be implemented.

Set Connection port based on the actual connection between the OVGR and the SmartLogger.

Effective dry contact status can be set to Close or Open. If OVGR Shutdown Setting is set to
Enable and Effective dry contact status is set to Close, the SmartLogger sends the inverter remote
shutdown command only when the DI port specified by connection port is closed.

OVGR Shutdown Setting can be set to Enable or Disable. Set OVGR Shutdown Setting as
required.

Cubicle alarm enabling can be set to Enable or Disable. If Cubicle alarm enabling is set to
Enable, if the dry contact signal is effective and the Cubicle is abnormal, an alarm indicating
abnormal Cubicle is generated.
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7.11 Maintenance

7.11.1 Upgrading Firmware

You can upgrade the firmware of the SmartLogger, inverter, PLC module, or PID module over
the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Firmware Upgrade to access the target page.

Figure 7-64 Firmware upgrade

® Single Upgrade () Batch Upgrade

Select an upgrade file: Browse
O No. Device Devices Status Curr. ver. Target ver. Upgrade Progress
O 1 Logger(Local) @ V200R001C30SPC106 NA
O 2 40KTL(COM3-1) @ V200R001C0O0SPC111 NA
O 3 40KTL(COM3-2) @ V200R001C00SPC111 NA
O 4 40KTL{COM3-3) @ V200R001C00SPC111 NA
O 5 PLC(COM3-249) @ V100R001C72SPC108 NA
< >
.
Single Upgrade

1. Click Single Upgrade.
2. Select the name of the device that requires a firmware upgrade.

/\ omce

The Single Upgrade mode does not apply to two or more types of devices each time. For
example, you cannot select both the inverter and PLC module.

3. Select the upgrade file.
4.  Click Upgrade.
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Batch Upgrade
[LInoTe

e The inverter that can be upgraded in batches on the SmartLogger must be SUN2000
V100R001C11SPC409, SUN2000 V100R001C81SPC101 and its later patch versions, or SUN2000
V200R001CO00 and its later patch versions.

e For all types of inverters except 1000 V inverters, each inverter can be upgraded on the Batch
Upgrade WebUI separately.

1. Click Batch Upgrade.
2. Select the upgrade file.
3. Click Upgrade.

7.11.2 Product Information

Choose Maintenance > Product Information and query SmartLogger information on the
displayed page.

Figure 7-65 Product information

| Product Information

SN
2102310PQW10EB000368
Device Type

SmartLoggerl000

Firmware Version

V100R001CO0SPC111

7.11.3 Setting Security Parameters

Choose Maintenance > Security Settings to access the target page.
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Figure 7-66 Setting security parameters
Security Settings

User Name Online Status

Advanced User Qnline
Password Change

Automatic logout time

Automatic logout time |5 minutes E
Network Security Certificate
Select a certificate format  |CRT fDrmatEl
Please select a security certificate Upload
Select the network i rtificate key to b T
elect the network security certificate 93‘1 Dd :
uploade:
[enable key password
=3

Update Key
Cpane

'WEB TLS1.0 Setting

TLS1.0 enable | Enable E (The WebUI will restart after the setting is madified. Enabling this item will pose security risks.)

ot |

(L] noTE
[ ]

The initial password is Changeme for system users Common User, Advanced User, and Special

User.

e After the first login, change the initial password immediately to ensure account security.

e You are advised to change the password at least once every half a year to prevent unauthorized use
of your account and impact on system security.

e After Automatic logout time is set, a user is automatically logged out if the user does not perform
any operation within the specified time period.

e You are advised to use the existing network security certificate and key.

Change the password in compliance with the following rules:

®  Containing 6 to 20 characters

® A combination of at least two types of digits, uppercase letters, and lowercase letters
e Different from the old password

7.11.4 System Maintenance

Because of the permission restriction, log in as Advanced User or Special User. Choose
Maintenance > System Maint..
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Figure 7-67 System maintenance

Submit

(L noTE

The login password is required if you need to send a system maintenance command.

7.11.5 Device Log

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Device Log to access the target page.
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Figure 7-68 Device log

Device Log

Select No. Device SN Devices Status Progress Execution Status

O 1 Logger(Local) 2102311HJB10G5000169 @

m} 2 PLC(COMO-249) PLCO02311HIBG5000169 L4

O 3 33KTL(COM1-1) 21010729676TGC901210 @

] 4 V2R1-40K(COM1-2)C 21010725036TF9906250 @

< >
7.11.6 Site T
.11.6 Site Test

After a inverter is put into use, it should be inspected periodically to detect any potential risks
and problems. The SmartLogger can inspect inverters over the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Onsite Test to access the target page.
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Figure 7-69 Site test

MR pot-check

@ Single Inspection ) Batch Inspection

Inspected devices: 0

o F ion failure: 0

]
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o

No.

20KTLICOM1-1)
40KTLICOM1-2)
28KTLICOM1-3)

(

SOKTL(COM1-4)

T T T I

60KTLICOM1-7)

Start Inspection
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e The spot-check function is available only for the inverter for which Grid Code is set to Japan

standard.

Device SN
INV_2000V1R1C00_0001
INV_2000V2R1C00_0002
INV_2000V1R1C81_0003

INV_2000V2R2C00_0004

40KTL-JP(COM1-5) INV_2000V2R2C01_0005

40KTL-US(COM1-6) INV_2000V2R2C20_0006

INV_20HAV1R1C00_0007

.

Devices Status Progress Execution Status

@

@

®

e ® ¢ @

Start time

Log archiving

e You can click the Select icon in the upper left corner of the page to select an inspection mode.

7.11.7 Managing the License

You can view the inverter license information and manage the license on the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > License Management.

To view the inverter license information, tap License information.

To apply for a license, tap License application and export a license application file, as
shown in Figure 7-70.

To load the obtained license to the inverter, tap License loading, as shown in Figure

7-71.

To revoke the license or export the revocation code file, tap License revocation.
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Figure 7-70 Applying for a license

© License information © License application ) License loading ) License revocation

Total Device Qty. : 1
A Ne. Device Device status License Status SN Rated Power(kW)
i} 1 33KTL(COM3-4) Normal 2101073021ESECO00075 30 &
Export License Appli File

For the inverter with no license, you can export the application file and apply for a license on

the Electronic Software Delivery Platform (ESDP).

Figure 7-71 Loading a license

) License information () License application © License loading () License revocation
Total Device Qty.: 1 File Status. @ To be loaded : 0 No file: 0 @ Loaded:1
[ No. Device Device status License Status File Status Loading Progress License loadin
) 1 33KTL(COM3-4) Normal @ 2017-06-12 =
<[ =
SIS s
To load a license to the inverter, perform the following steps:
1. Import the license file.
2. Select the inverter whose File Status is To be loaded.
3. Load the license.
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Ensure that the extension of the license file to be imported is .dat or .zip.
7.11.8 Device Management

7.11.8.1 Connecting Devices

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Connect Device to access the target page.

Figure 7-72 Connecting devices

Total Device Qty.:8 Q0w
Connect Device
Device disconnection time 5 min(5-30)

[l No. Device Port-Comm Addr./IP address SN Devices Status
] 1 Meter(COM3-1) 3-1 AM1V20064900hwappyan @
B 2 PID(COM3-2) 3-2 SOUTH_DEVICE_PID_002 @
] 3 28KTL(COM3-3) 3-3 INV_2000V1R1C81_0003 @
] 4 40KTL(COM3-4) 3-4 INV_2000V2R1C00_0004 @

4 O 5 50KTL(COM3-5) 3-5 INV_2000V2R2C00_0005 @
] 6 40KTL-JP(COM3-6) 3-6 INV_2000V2R2C01_0006 @
] 7 EMI(COM3-7) 3-7 EM1V20064300hwappyan @
B 8 PLC(COM3-249) 3-249 SOUTH_DEVICE_PLC_249 @

Auto. Search Add Devices Auto Assign Address Import Config. Export Config

L] noTE
[ ]

Huawei devices can be automatically detected or manually added. The EMI, power meter, slave
SmartLogger, and third-party devices cannot be automatically detected. You need to add them
manually.

o Before manually adding an EMI connected over the COM port, set RS485 parameters correctly by
following the instructions in 7.10.2.2 Setting RS485 Parameters. When adding an EMI, set Device
Type to EMI. After adding an EMI manually, correctly set the EMI parameters. For details, see
7.10.2.3 Setting EMI Parameters.

e Before manually adding the Modbus or DL/T645 power meter, set RS485 parameters correctly by
following the instructions in 7.10.2.2 Setting RS485 Parameters. Before manually adding the
Modbus power meter, correctly set the power meter parameters. For details, see 7.10.2.4 Setting
Power Meter Parameters. When adding a power meter, set Device Type to Power Meter and
Comm.protocal to the protocol supported by the power meter.

e When manually adding a slave SmartLogger, correctly set Modbus TCP parameters. Set Link
setting to Enable, and set the client IP address to the IP address for the slave SmartLogger. For
details, see 7.10.2.6 Setting Modbus TCP Parameters. When adding a slave SmartLogger, set Device
Type to SmartLogger and set IP Address to the IP address of the slave SmartLogger.

e When connecting a third-party device, you need to import a configuration file for the device and
then manually add the device.

e An accessed device can be removed manually, and a removed device can be added again.
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e Auto Assign Address allows you to adjust device addresses based on serial numbers. If a device
cannot access due to address conflict, perform this operation to assign a new device address and then
access the device.

e After a device is connected, you can export the configurations for the device. If you need to change
the name of the exported file, retain the extension .cfg. Otherwise, the file will be unavailable.

e You can click the Start, Stop, or Reset icon to send the corresponding command to all SUN2000s
connected to the SmartLogger. The login password is required if you need to send a command.

7.11.8.2 Device List

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Device list to access the target page.

Figure 7-73 Device list

Total Device Qty.:6

O No. Device port Comm Address Logical addr. Transformer No. Winding No. SN Device status
O 1 EMI{COMO-1) 0 1 20 -- -- EMO02311HJB01G5000169 @

O 2 PLC(COMO0-249) 0 249 1 [¢] 0 PLC0O02311HJBG5000169 @

O 3 33KTL(COM1-1) 1 1 18 0 0 21010729676TGC901210

O 4 V2R1-40K(COM1-2)( 1 2 3 4] 0 21010725036TF9906250

O 5 EMI(COM2-1) 2 1 19 - - EM02311HJB00G5000169

O 6 Meter(COM3-1) 3 1 13 -- -- AMO02311HJB00G5000169

Modify Device Info | Import Device Info | Export Device Info

L] noTE

You can modify the device name and address on the WebUI, or export a device information file in CSV
format and import the CVS file into the WebUI after modification.

7.11.8.3 Exporting Parameters

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Export Param. to access the target page.
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Figure 7-74 Exporting data

Total Device Qty.:1

= SUN2000

Devices Status

] No. Device SN
] 1 33KTLICOM1-1) 21010729676TGC901210
e e

You can export configuration parameters of multiple inverters to a .csv file. Site engineers can then
check whether the inverter configurations are correct in the exported file.

7.11.8.4 Resetting Alarms

If you need to reset the active and historical alarms of certain or all devices connecting to the

SmartLogger, and re-collect alarm data, reset alarms.

Because of permission restriction, log in as Advanced User or Special User. Choose

Maintenance > Alarm Reset to access the target page.
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Figure 7-75 Resetting alarms

Total Device Qty.:1

Clan No. Device Port-Comm. addr. SN Devices Status
O 1 33KTLCOM1-1) 11 21010729676TGC901210

oo |

/\ rorce

e If you reset alarms, all the active and historical alarms of the selected devices will be reset
and the SmartLogger will start to collect new alarm data.

e |[f alarms are cleared on Huawei devices such as the inverter and PID module, Alarm
Reset must be performed on the SmartLogger and NMS. Otherwise, the SmartLogger
cannot collect the alarm information generated by the devices after the alarms are cleared.

e If Alarm Reset is performed on the SmartLogger, you have to implement Alarm Reset on
the NMS. Otherwise, the NMS cannot obtain the alarm information collected by the
SmartLogger after alarms are reset.

7.11.8.5 Re-collecting Performance Data
You can re-collect previous performance data and energy yield over the WebUI.

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Collect Perf. Data to access the target page.
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Figure 7-76 Re-collecting performance data

®) Performance Data (_ E-Daily ) E-Month () E-Year

Collection period: Recent Day(l—SD)

Clan No. Device SN Device status Progress Execution Status
] 1 36KTL(COMO-2) 210107302310G3000888
Collect Data

You can re-collect the performance data of devices on the Performance Data page. You can re-collect
the energy yields of devices by E-Daily, E-Month, or E-Year. Set Collection period before

re-collecting them. You can query the re-collection results on the Monitoring page.

/\ rorce

When the performance data is being re-collected after the software version of the

SUN2000-33KTL/40KTL upgrades from SUN2000 V200R001CO0SPCXXX to SUN2000
V200R001C90SPCXXX, you cannot query the daily energy yield generated before the

upgrade of the software version.

7.11.8.6 Correcting the Total Energy Yield

Because of permission restriction, log in as Advanced User or Special User. Choose
Maintenance > Adjust total energy yield to access the target page.
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Figure 7-77 Correcting the total energy yield

Total Device Qty.:1

[JAI Ne. Device Device status E-Total(kWh) Adjust total energy yield (kWh)
o 1 36KTLICOMO-2) 2256.10 oo |0-42049600)
|
|
iomi |
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Power Grid Scheduling

8.1 Power Adjustment Description

According to standard requirements, the SmartLogger can reliably adjust power for the
connected inverters in real time to ensure that the PV plant can respond to requirements of the
power grid company in a timely manner.

Two power grid scheduling modes are available: active power control and reactive power
control.

/\ rorce

To ensure that the SmartLogger will deliver scheduling commands to the connected inverters,
you must enable active or reactive power control before adjusting the active or reactive power
for a PV plant. If you disable active or reactive power control, the SmartLogger will not
deliver scheduling commands to the connected inverters and the inverters will retain their
status after the previous change.

Active Power Control

If the PV plant has requirements of power limitation, the power grid scheduling personnel
should limit the active power or disable all the active power for the PV plant, that is, to enable
the active power derating mode.

Because of permission restriction, log in as Special User. Choose Settings > Active power
control to access the target page.
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Figure 8-1 Active power control

| Active power control
Active power control |Enable v

Active power control mode | Disable active power reduction v

==

Reactive Power Control

Large-scale PV plants are required to adjust the voltage at the grid-tied point. Power grid
scheduling personnel enable the PV plant to absorb or add the reactive power at the grid-tied
point, that is, to enable the reactive power compensation, based on the real-time reactive
power transmission status in the power grid.

Because of permission restriction, log in as Special User. Choose Settings > Reactive power
control to access the target page.
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Figure 8-2 Reactive power control

Reactive Power Control

Reactive power control Enable

(][]

Reactive power control mode Disable reactive power output

=

8.2 Active Power Adjustment

/\ omce

Before setting Active power control mode, set Active power control to Enable.

8.2.1 Disabling Active Power Derating

If the inverter is required to run full load, set Active power control mode to Disable active
power reduction.
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Figure 8-3 Disabling active power derating

| Active power control

Active power control  |Enable v
Active power control mode | Disable active power reduction v

==

8.2.2 Dry Contact Remote Control

A NOTICE

If ports of DI1-DI4 have been configured in 7.10.7 Dry contact remote shutdown, Dry
contact remote control is unavailable.

e Before setting dry contact remote control, ensure that the SmartLogger connects to a
correct ripple control receiver. For details, see 4.10 Connecting the SmartLogger to a
Ripple Control Receiver.

Set Active power control mode to Dry contact remote control.
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Figure 8-4 Dry contact remote control

Active power control
Active power control Enable E
Active power control mode | Dry contact remote control E
No. DI1(GND1) DI2(GND1) DI3(GND1) DI4(GND1) Percentage(%)
51 o© E E = o-100 Contn | conol
[ |
S
[ noTe
e A maximum of 16 levels are supported for the percentages.

e ""indicates a low level. When connecting to GND1, the four DI ports of the SmartLogger are
low-level ports. If not connected, the ports are high-level ports.

e The status combination of DI1(GND1)-DI4(GND1) should differ from each other. Otherwise,
abnormal command parsing will occur.

e If the actual input DI signal is inconsistent with that configured on the WebUI, the SmartLogger
controls the SUN2000 to work at full power and the Abnormal Active Schedule alarm is generated.

e If Reactive Power Control is set to Al/DI remote control, Dry contact remote control is
unavailable for Active Power Control.

8.2.3 Percentage Fix Limitation

The SmartLogger provides simplified active power percentage configuration as well as power
control automation, that is, to automatically adjust the active power derating percentage in
different periods of the day.

If the maximum power output of the inverter needs to be controlled, set Active power control
mode to Percentage fix limitation.
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Figure 8-5 Percentage fix limitation

Active power control
Active power control | Enable
Active powier control mode | Percentage fix limitation
Ne. Start time Percentage(%)

1 00:00:00 100

o e
—
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e [f the inverter needs to run with specified maximum power in certain periods of a day, add setting

records based on site requirements.

e When multiple time points are set, the inverter will run with the maximum power specified for the
time point that is earlier than and the closest to the system current time point. For example, if you
add 00:00:00 and 12:00:00 on the WebUI and the system current time point is 14:30:00, the inverter
will run with the maximum power specified for 12:00:00.

8.2.4 Remote Scheduling

The NMS or independent power adjustment device sends scheduling commands over the
communications port that works with Modbus-TCP or IEC104, without the need of user

configuration or operation. The SmartLogger can automatically switch between scheduling

modes and send scheduling commands.

When Active power control mode is set to Remote scheduling, the SmartLogger receives
the scheduling commands from the upstream NMS, converts them into valid command data
identifiable to the inverters, and then sends the data to all the connected inverters. Based on
the principle of preference of remote scheduling, the SmartLogger sets Active power control
mode to Remote scheduling after receiving a scheduling command from the upstream NMS.
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Figure 8-6 Remote scheduling

| Active power control
Active power control  |Enable
Active power control mode Remote scheduling

Schedule strategy | Strategy 1

LIKI[<I[<]

Adjustment coefficient |1.000

=3

(L] noTE

Disable, Strategy 1, and Strategy 2 are available for Schedule strategy.

e Disable: The SmartLogger controls the inverter to work at full load and will not receive scheduling
commands sent by the NMS.

e Strategy 1: Open-loop scheduling policy. That is, the SmartLogger evenly allocates the power value
from the scheduling and delivers the average values to each inverter, which then operates with the
specific power. The adjustment value delivered by the SmartLogger is constant.

e Strategy 2: The customized function is provided for a site.

Adjustment coefficient: The power value will be sent to the inverter after being multiplied by the preset
coefficient.

8.2.5 AI Remote Control

The remote scheduling command sent by the SmartLogger controls the active power output of
the PV plant in analog input mode. Set Active power control mode to Al remote control.

/\ rorce

Before setting this parameter, ensure that the SmartLogger connects to the telecontrol system.
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Figure 8-7 Al remote control

Active power control
Active power control Disable
Active power control mode | Al remote control
Derated command input port |No

Derated command feedback port | No

EEEE

Value identification precision 1
Power station total rated power (Pn) 6000 3

Plant overload power (Pmax) 6300 kW

Active control parameters

==
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e Value identification precision identifies the remote scheduling command variation threshold in the
case of active power adjustment to prevent frequent control command sending due to the sampling
deviation. Its value range is 1% to 100%.

e Power station total rated power (Pn) is the maximum power capacity of the PV plant agreed by
the PV plant and the power grid company. Confirm this parameter value with the power grid
company and set it correctly.

e If Reactive power control is set to Dry contact remote control, Al remote control is unavailable
for Active power control.

8.2.6 Remote Output Control

/\ rorce

Before setting the parameters for remote output control, synchronize the clock source of the
server. For details, see 7.10.1.1 Setting the Date and Time.

Figure 8-8 Synchronizing the clock source

Time Synchronization

Clock source | NTP E
Server
Port 123 (1~65535)
Synchronization time interval 1440 min (1~1440)

Latest synchronization status ~ Success

Latest synchronization time  2000-01-01 00:00:00

NTP synchronization test
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1. Clock source: Set NTP.
2. Server: Set the server IP address or domain name.
3. NTP synchronization test: Check the time synchronization status.

Set Active power control mode to Remote output control.

Figure 8-9 Remote Output Control

| Active power control

Active power control Enable

Active power control mode | Remote output control D
Qutput control duration |10 D mir
PV plant ID
Remote output control server
PV module capacity ~ 0.000 lW(0~200000)
Latest connection status ~ Success
Latest connection time  2000-01-01 00:00:00
Present control percentage 0.0 %
=
[ noTe
e Output control duration: Set the time required for the SUN2000 to change its output power from

0% to 100% or from 100% to 0%.
e PV plant ID: Set the ID assigned by the power company to the SmartLogger.
e Remote output control server: Set the server IP address or domain name.

e If the connection between the SmartLogger and the server is abnormal, obtain the output control file
in .data format from the website of the power company and import the file.

e After the SmartLogger connects to the server, you can export the relevant file.

8.3 Reactive Power Adjustment

/\ orce

Before setting Reactive power control mode, set Reactive power control to Enable.

Issue 10 (2017-08-30) Huawei Proprietary and Confidential 260
Copyright © Huawei Technologies Co., Ltd.



SmartLogger1000
User Manual 8 Power Grid Scheduling

8.3.1 Disabling Reactive Power Output

If the PV plant is not required to adjust the voltage at the grid-tied point or perform reactive
power compensation, the inverter can run with pure active power output. In this case, set
Reactive power control mode to Disable reactive power output.

Figure 8-10 Reactive power control

Reactive Power Control
Reactive power control Enable E

Reactive power control mode Disable reactive power output E

= -

8.3.2 Dry Contact Remote Control

A NOTICE

If ports of DI1-DI4 have been configured in 7.10.7 Dry contact remote shutdown, Dry
contact remote control is unavailable.

e Before setting dry contact remote control, ensure that the SmartLogger connects to a
correct ripple control receiver. For details, see 4.10 Connecting the SmartLogger to a
Ripple Control Receiver.

Set Reactive power control mode to Dry contact remote control.
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Figure 8-11 Dry contact remote control

Reactive Power Control =

Reactive power control Enable

Reactive power control mode | Dry contact remote control

No. DIL{(GND2) DI2(GND2) DI3(GND2) DI4(GND2) PF
o 1 ] B ] a (-1.000~-0.800]U[0.800~1.000]
[ Detee |
soomi | ;
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e A maximum of 16 levels are supported for power factors.

"\" indicates low level. When connecting to GND2, the four DI ports of the SmartLogger are
low-level ports. If not connected, the ports are high-level ports.

The status combination of DIL(GND2)-DI4(GND2) should differ from each other. Otherwise,
abnormal command parsing will occur.

If the actual input DI signal is inconsistent with that configured on the WebUI, the SmartLogger

does not allow the SUN2000 to generate reactive power and the Abnormal Reactive Schedule
alarm is generated.

If Active Power Control is set to Al remote control, Dry contact remote control is unavailable

for Reactive Power Control.

8.3.3 Reactive Power Fix Control

If the PV plant is required to generate at the grid-tied point specified constant reactive power
within the power factor range, set Reactive power control mode to Reactive power fix
control.
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Figure 8-12 Reactive power fix control

Reactive Power Control
Reactive power control | Enable []
Reactive power contral mode | Reactive power fix control []
Neo. Start time Reactive power(kVar)
B 1 00:00:00 00
2 12:00:00 | (HHMM:SS 100 (-1008.0~1008.0)
[ paa J Dot |

e [f the inverter needs to run with specified maximum power in certain periods of a day, add setting
records based on site requirements.

e The range specified for Reactive Power is relevant with the grid code and the model.

e When multiple time points are set, the inverter will run with the maximum power specified for the
time point that is earlier than and the closest to the system current time point. For example, if you
add 00:00:00 and 12:00:00 on the WebUI and the system current time point is 14:30:00, the inverter
will run with the maximum power specified for 12:00:00.

8.3.4 Power Factor Fix Control

If the PV plant is required to generate a constant power factor at the grid-tied point and the
inverter is required to adjust the real-time reactive power based on the preset power factor, set
Reactive power control mode to Power factor fix control.
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Figure 8-13 Power factor fix control

Reactive Power Control

Reactive power control | Enable ﬂ
Reactive power control mode | Power factor fix control ﬂ
No. Start time PF
O 1 00:00:00 1.000
O 2 12:00:00 | (HHMM:SS) 0.950 (-1.000~-0.800]U[0.800~1.000]
[~ |
== v

e If the inverter is required to run with a specified power factor in certain periods of a day, add setting
records based on site requirements.

e When multiple time points are set, the inverter will run with the maximum power specified for the
time point that is earlier than and the closest to the system current time point. For example, if you
add 00:00:00 and 12:00:00 on the WebUI and the system current time point is 14:30:00, the inverter
will run with the maximum power specified for 12:00:00.

8.3.5 Q-U Characteristic Curve

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve on the SmartLogger as a substitute. The SmartLogger
delivers the values configured for the characteristic curve to the inverter, which then operates
in compliance with the configuration. The SmartLogger no longer adjusts the values.

/\ orce

Configure the characteristic curve under instructions from professionals to ensure that the
SUN2000 works properly.

The Q-U characteristic curve control mode is to dynamically adjust the ratio Q/S of output
reactive power to apparent power in accordance with the ratio U/Un(%) of the actual grid

voltage to the rated grid voltage.

Set Reactive power control mode to Q-U characteristic curve.
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Figure 8-14 Q-U characteristic curve
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o  When configuring the curve, ensure that the U/Un(%o) value of a point is greater than the
U/Un(%o) value of the previous point. Otherwise, the Invalid input message will be

displayed.

®  The Q-U characteristic curve supports a maximum of 10 valid points.
®  Reactive power adjustment time allows you to control the change interval of the

reactive power for a grid-tied point.

®  Under a specific grid code, after you set Percents of trigger frequency, the
characteristic curve takes effect only when the actual output active power of the inverter

is greater than the preset value.

8.3.6 cos(Phi)-P/Pn Characteristic Curve

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve on the SmartLogger as a substitute. The SmartLogger
delivers the values configured for the characteristic curve to the inverter, which then operates
in compliance with the configuration. The SmartLogger no longer adjusts the values.

/\ rorce

Configure the characteristic curve under instructions from professionals to ensure that the

SUN2000 works properly.

The cos(Phi)-P/Pn characteristic curve control mode is to dynamically adjust the power factor
cos(Phi) in accordance with the P/Pn (%) based on the VDE-4105\BDEW German standard.

Set Reactive power control mode to cos(Phi)-P/Pn characteristic curve.
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Figure 8-15 cos(Phi)-P/Pn characteristic curve
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®  \When you set the curve, ensure that the P/Pn(%b) value of a point is greater than the
P/Pn(%0) value of the previous point. Otherwise, the Invalid input message will be
displayed.

®  The cos(Phi)-P/Pn characteristic curve can support a maximum of 10 valid points.

8.3.7 Q-U Hysteresis Curve (CEI0-16)

If you do not need the SmartLogger to send remote reactive power control commands, you
can configure the characteristic curve on the SmartLogger as a substitute. The SmartLogger
delivers the values configured for the characteristic curve to the inverter, which then operates
in compliance with the configuration. The SmartLogger no longer adjusts the values.

/\ rorce

Configure the characteristic curve under instructions from professionals to ensure that the
SUNZ2000 works properly.

The Q-U hysteresis curve (CEI0-16) control mode is the Italian standard CEIO-16 version of
the Q-U characteristic curve. It dynamically adjusts the output reactive power of the inverter
in accordance with the ratio of the actual voltage to the rated voltage. The final value should
be in the form of Q/S.

Set Reactive power control mode to Q-U hysteresis curve(CEI0-16).
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Figure 8-16 Q-U hysteresis curve (CEI0-16)

Reactive Power Control

ctive power control | Enable

control mode | Q-U hysteresis curve(CEI0-16)
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Point U/Un(%) Qs
A 90.0 (80.0~115.0) -0.485 (-0.600~0.600)
B 92.0 (80.0~115.0) -0.485 (-0.600~0.600)
C 108.0 (80.0~115.0) 0.485 (-0.600~0.600)
D 110.0 (80.0~115.0) 0.485 (-0.600~0.600)
(1] NnoTE
e When configuring the curve, ensure that the U/Un(%b) value of a point is greater than the U/Un(%b)

value of the previous point. Otherwise, the Invalid input message will be displayed.

e When configuring the curve, ensure that the values of A and B for Q/S are consistent and set in
sequence, and that the values of C and D are consistent and set in sequence. Otherwise, the Invalid
input message will be displayed.

e Under a specific grid code, after you set Percents of trigger frequency, the characteristic curve
takes effect only when the actual output active power of the inverter is greater than the preset value.

8.3.8 Remote Scheduling

The NMS or independent power adjustment device sends scheduling commands over the
communications port that works with Modbus-TCP or IEC104, without the need of user
configuration or operation. The SmartLogger can automatically switch between scheduling
modes and send scheduling commands.

When Reactive power control mode is set to Remote scheduling, the SmartLogger receives
the scheduling commands from the upstream NMS, converts them into valid command data
identifiable to the inverters, and then sends the data to all the connected inverters. Based on
the principle of preference of remote scheduling, the SmartLogger sets Reactive power
control mode to Remote scheduling after receiving a scheduling command from the
upstream NMS.
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Figure 8-17 Remote scheduling

Reactive Power Control

Reactive power control Disable E
Reactive power control mode
8.3.9 AI/DI Remote Control

The remote scheduling command sent by the SmartLogger controls the reactive power output
of the PV plant in analog input mode. Set Reactive power control mode to Al/DI remote
control.

/\ rorce

Before setting this parameter, ensure that the SmartLogger connects to the telecontrol system.
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Figure 8-18 Al/DI remote control

Reactive Power Control
Reactive power control  |Enable v
Reactive power control mode | Al/DI remote control v
Powrer station total rated power (Pr) 6000 [
Plant overload power (Pmax) 6300 Jw
Grid connection point voltage level (Ur)  |400.0 v
Reactive control parameters
® Cos(Phi) direct C Q/P curve O Q/U curve
Dispatching mode input port | No M
Dispatching mode feedback port | No v
Dispatching instruction input port | AIL v
Dispatching instruction feedback port | AOL v
port Start Current (mA) Start Power Factor End Current (mA) End Power Factor
Al [4.000 Jo-20 [0.950 - 0000 o 0.95
AOL [.000 Jo~20) [o950 - [oo0 o 095
L] noTE

e Power station total rated power (Pn) is the maximum power capacity of the PV plant agreed by
the PV plant and the power grid company. Confirm this parameter value with the power grid
company and set it correctly.

e Grid connection point voltage level is the voltage level at the connection point between the PV
plant and the power grid. Set this parameter based on the power grid status.

e If Active power control is set to Dry contact remote control, Al/DI remote control is unavailable
for Reactive power control.

8.3.10 Power Factor Closed-Loop Control

/\ rorce

Before setting the parameters for power factor closed-loop control, ensure that the power
meter is connected to the SmartLogger. For details, see 4.6 Connecting the SmartLogger to a
Power Meter.

Set Reactive power control mode to Pwr factor closed-loop control.
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Figure 8-19 Power factor closed-loop control

Reactive Power Control o

Reactive power control  [Enable

Reactive power control mode | Pwr factor closed-loop control

Target power factor 0900

Adjustment interval |2.n

Adjustment desdband  [0.005

== g

®  Target power factor: indicates the target value for the adjustment power factor of the
power meter.

®  Adjustment interval: indicates the interval for sending adjustment commands by the

SmartLogger.
®  Adjustment deadband: indicates the adjustment power factor precision.
[ NnoTE
The specified value of Adjustment deadband takes effect only if the power factor for the power meter
exceeds 0.9.
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9 Maintenance

This topic describes how to perform daily maintenance and troubleshooting to ensure
long-term proper operation of the SmartLogger.

9.1 Routine Maintenance

Check that the SmartLogger is free from strong electromagnetic interference.
Check that the SmartLogger is free from heat sources.

Check that the heat dissipation holes are not blocked.

Clean up the dirt and dust for the SmartLogger periodically.

Check that the cables are secured periodically.

9.2 Troubleshooting

This topic describes the common faults in the SmartLogger and the troubleshooting measures.

Table 9-1 describes the common faults and the troubleshooting measures.

Table 9-1 Common fault list

No. Symptom Possible Cause Measures
1 The 1. The DC output terminal of the power | 1. Connect the DC output of the power
SmartLogger adapter does not connect to the Power adapter to the Power port of the
cannot be port of the SmartLogger. SmartLogger.
powered on. | 2. The AC input terminal of the power 2. Connect the AC input of the power
adapter does not connect to the AC adapter to the AC power port.
power port. 3. Replace the power adapter.
3. Power adapter is faulty. 4. Contact the supplier or Huawei
4. The SmartLogger is faulty. Customer Service Dept.
2 TheLCDis |1 TheLCD is faulty. Contact the supplier or Huawei Customer
off. 2. The SmartLogger is faulty. Service Dept.
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No. Symptom Possible Cause Measures

3 The LCD 1. The button is faulty. Contact the supplier or Huawei Customer
does not 2. The SmartLogger is faulty. Service Dept.
respond
when a
button is
pressed.

4 Devices 1. The COM ports are not connected to | 1. Check the RS485 communications
cannot be devices, or the cables are loose, cable connection. If any cable is loose,
searched. disconnected, or reversely connected. drops off, or is reversely connected,

2. The communications parameters for rectify the connection.
the RS485 port are incorrect. 2. Correctly set the RS485
3. No EMI is manually added. communications parameters, and
4. The communications parameters for ensure that the baud rate and the
the EMI are incorrect. communications address are correctly
5. The address for the inverter is not set.
within the search address segment set | 3- Add the EMI manually.
for the SmartLogger. 4. Correctly set the EMI parameters
5. Set the address of the inverter to be
within the search address segment set
for the SmartLogger.

5 Devices 1. The cable between the device and the | 1. Verify that the cable between the
Status is SmartLogger is loose or disconnected. device and the SmartLogger is
Disconnectio | 2. The device is powered off. properly connected and tightened.
non the 3. The baud rate or RS485 address of the | 2. Power on the device.

SmartLogger. device is changed. 3. Verify the baud rate and RS485
4. The device is replaced. address of the device.
5. The device is no longer connected. 4. If adevice is replaced, search for or
manually add the device.
5. If the device is removed, remove the
device on the SmartLogger.

6 The EMI 1. The RS485 communications cable 1. Verify that the RS485
cannot be between the EMI and the communications cable is properly
added. SmartLogger is not properly connected and tightened.

connected, or the RS485 2. Power on the EML.
cc_)mmunications cable is loose or 3. Verify the baud rate of the EMI.
dlsconnec_ted. 4. Log in to the WebUI and verify the

2. The EML is powered off. parameter settings of the EMI.

3. The baud rate of the EMI is
inconsistent with that of the
SmartLogger.

4. Parameter settings of the EMI are
incorrect.
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No. Symptom Possible Cause Measures

7 The 1. The SmartLogger is not connected to | 1. Connect the Ethernet network port of
SmartLogger the PC, or the cable between the the SmartLogger to the PC or router.
cannot SmartLogger and the PC is loose or | 2. Check that the Ethernet parameters are
communicate disconnected. correctly set.
with the 2. Ethernet parameters are not properly | 3. Check that the NetEco parameters are

NetEco in the
PC.

set.

3. NetEco parameters are not properly
set.

correctly set.

Emails 1. The SmartLogger cannot
cannot be communicate with the email server.
received. 2. Ethernet parameters are not properly

set.

3. Email parameters are not properly set.

Connect the Ethernet network port of
the SmartLogger to the PC or router.

. Check that the Ethernet parameters are

correctly set.

Check that the Email parameters are
correctly set.

9.3 Alarms

This topic describes the common faults in the SmartLogger and the troubleshooting measures.

Table 9-2 describes the common faults and the troubleshooting measures.

Table 9-2 Alarms

port receives
currents beyond
the
configuration
range.

Alar | Alarm Alarm Alarm Causes Measure
m ID Severity | Sub-ID
1100 | Abnormal | Major 1 Under the active | 1. Check on the ADAMA4117 the cable
P-Control power Al connection of the port corresponding to
remote control the Al number. Reconnect and secure
mode, the Al the cable if it is loose, disconnected, or

reversely connected.

Enter the active power Al remote
control configuration page and check
that the start and end current ranges of
the Al comply with the requirements of
the power grid company.

Enter the Extended Port Settings page,
check that the current configuration of
the Al number is consistent with the
current specification of the
ADAMA4117.

Contact the power grid company to
check whether the command data sent is
correct.
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Alar | Alarm Alarm Alarm Causes Measure
m ID Severity | Sub-ID
2 Under the 1. Check whether the communications
reactive power cable connection between the
Al remote ADAMA4117 and the SmartLogger is
control mode, correct, whether the RS485 address
the command conflicts with the addresses of other
data of the Al devices, whether the baud rate is
port cannot be consistent with that set for the
read due to the corresponding SmartLogger port.
ADAM fault, . Check whether the auxiliary power
power supply for the ADAM4117 is normal.
disconnection,
or abnormal
link.
3 Under the active | 1. Check whether the communications
power Al cable connection between the
remote control ADAMA4024 and the SmartLogger is
mode, the correct, whether the RS485 address
feedback conflicts with the addresses of other
command data devices, whether the baud rate is
of the AO port consistent with that set for the
cannot be read corresponding SmartLogger port.
due to the . Check whether the auxiliary power
ADAM fault, supply for the ADAM4024 is normal.
power
disconnection,
or abnormal
link.
4 Under the active | 1. Check whether the cable connections to
power Dry the DI ports are correct.
contact remote . Enter the active power Dry contact
control mode, remote control configuration page and
the four DI check the mapping table of the current
ports read DI signal configuration. Contact the
commands power grid company to check the
beyond the completeness of the combination
configuration. configurations in the mapping table and
check whether the configurations
comply with the requirements of the
power grid company.
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Alar | Alarm Alarm Alarm Causes Measure
m ID Severity | Sub-ID
1101 | Abnormal | Major 1 Under reactive | 1. Check on the ADAM4117 the cable
Q-Control power Al connection of the port corresponding to
remote control the Al number. Reconnect and secure
mode, the Al the cable if it is loose, disconnected, or
port receives reversely connected.
currents beyond . Enter reactive power Al remote control
the configuration page and check that the
configuration start and end current ranges of the Al
range. comply with the requirements of the
power grid company.

. Enter the Extended Port Settings page,
check that the current configuration of
the Al number is consistent with the
current specification of the
ADAMA4117.

. Contact the power grid company to
check whether the command data sent is
correct.

2 Under the . Check whether the communications
reactive power cable connection between the
Al remote ADAMA4117 and the SmartLogger is
control mode, correct, whether the RS485 address
the command conflicts with the addresses of other
data of the Al devices, whether the baud rate is
port cannot be consistent with that set for the
read due to the corresponding SmartLogger port.
ADAM fault, . Check whether the auxiliary power
power supply for the ADAM4117 is normal.
disconnection,
or abnormal
link.

3 Under the . Check whether the communications
reactive power cable connection between the
Al/DI remote ADAMA4024 and the SmartLogger is
control mode, correct, whether the RS485 address
the command conflicts with the addresses of other
data of the AO devices, whether the baud rate is
port cannot be consistent with that set for the
read due to the corresponding SmartLogger port.
ADAM fault, . Check whether the auxiliary power
power supply for the ADAM4024 is normal.
disconnection,
or abnormal
link.
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Alar | Alarm Alarm Alarm Causes Measure
m ID Severity | Sub-ID
4 Under the 1. Check whether the cable connections to
reactive power the DI ports are correct.
Dry contact 2. Enter the reactive power Dry contact
remote control remote control configuration page and
mode, the four check the mapping table of the current
DI ports read DI signal configuration. Contact the
commands power grid company to check the
beyond the completeness of the combination
configuration. configurations in the mapping table and
check whether the configurations
comply with the requirements of the
power grid company.
1102 | Abnormal | Major 1 The power 1. Check whether the communications
Meter meter cannot cable connection between the
Data properly send ADAM4024 and the SmartLogger is
feedback signals correct, whether the RS485 address
to a third-party conflicts with the addresses of other
scheduling devices, whether the baud rate is
device due to consistent with that set for the
the ADAM corresponding SmartLogger port.
fault, power 2. Check whether the auxiliary power
disconnection, supply for the ADAM4024 is normal.
or abnormal
link.
1103 | Breaker Major 1 The general AC | Check whether the disconnection of the
Disconnect circuit breaker circuit breaker is a normal operation.
at the grid-tied Otherwise, contact the service engineer to
point is OFF. restore the connection.
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Disposing of the SmartLogger

This topic describes how to dispose the SmartLogger.

If the service life of the SmartLogger expires, dispose of the SmartLogger according to the
local disposal act for waste electric appliances.
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Technical Specifications

This topic describes the SmartLogger technical specifications.

Device management

Specifications

SmartLogger1000

Number of managed devices

80

Communications mode

Three RS485 ports

The maximum communication

RS485: 1000 m; Ethernet; 100 m

distance
Display
Specifications SmartLogger1000
LCD 3.5-inch LCD
LED Three LED indicators
WEB Embedded
Common parameters
Specifications SmartLogger1000

Power supply

100 V AC to 240 V AC, 50 Hz or 60 Hz

Power consumption

Normal: 3 W; maximum: 7 W

Storage capacity Stores historical inverter performance data of the last
month
Language English, Chinese, German, Italian, Japanese, French

Dimensions (W x H x D)

225 mm x 140 mm x 50 mm
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Specifications SmartLogger1000
Weight 500 ¢
Operating temperature -20C to +60C
Relative humidity 0/ 00
(non-condensing) 5%-95%
Protection level 1P20
Installation mode Installed on a wall, desk, or along a guide rail.

Port

Specifications SmartLogger1000
Ethernet 10/100M, Modbus-TCP
RS485 Modbus-RTU

uUSB Supported

Digital parameter input 4

Analog input 2

Relay output 3
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Monitoring User List

Table A-1 Monitoring User List

Login Mode User Name Initial Password
LCD Common User 000001
Advanced User 000001
Special User 000001
WEB Common User Changeme
Advanced User Changeme
Special User Changeme
SSH root Changeme
NetEco emscomm [EZFp+2%r6@IXSCv
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Acronyms and Abbreviations

AC
Al
AO
APP

CCO
COM

DI
DO

EMI
ETH

LED

PLC

Alternating Current
Analog Input
Analog Output
Application

Central Coordinator

Communication

Digital Input
Digital Output

Environmental Monitoring Instrument

Ethernet

Light-emitting Diode

Power Line Communication
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R

RSTP Rapid Spanning Tree Protocol

S

SFP Small Form-factor Pluggable

SPD Surge Protective Device

STA Station

STP Spanning Tree Protocol

w

WEEE Waste Electrical and Electronic Equipment
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